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Introduction
This guide provides instructions to import contents to HP Cloud Service Automation (HP CSA) to
create service offerings, which users can subscribe from the HP CSA Marketplace Portal.

The intended audience of this document are system administrators of HP CSA, who configure and
provision resources such as compute, storage, and network.

Steps to import content packs to HP CSA
Importing content packs to HP CSA involves the following steps:

Importing content packs

The following options are available to import HP CSA OOTB contents:

l While installing HP CSA 4.50 or upgrading to HP CSA 4.50, select the Install additional provider
integration service designs, components and content option. This option invokes the HP Cloud
Content Capsule Installer and installs the content automatically.

For information about how to install HP CSA 4.50, which includes installing content, seeHP Cloud
Service Automation Installation Guide on HP Software Support.

For information about how to upgrade to HP CSA 4.50, which includes installing content, seeHP
Cloud Service Automation UpgradeGuide on HP Software Support.

l If you skip the step to install contents while installing HP CSA 4.50, you canmanually install the
contents using HP Cloud Content Capsule Installer.

To run HP Cloud Content Capsule Installer, go to CSA_HOME/Tools/CSLContentInstaller/

For information about HP Cloud Content Capsule Installer and importing contents, seeHP CSA
Content Installation guide on HP Software Support.

Note: To search for documents, you need to log on to HP Software Support using your HP
Passport credentials.

On the Home page, go to Dashboard > Manuals. Select the product (for example, Cloud
Service Automation). In the Search for Answers field, enter the search criteria, and then click
the Search icon. Matching results will be displayed.

Configuring contents

When importing contents, HP CSA Installer and HP Cloud Content Capsule Installer automatically
install the required HP Operations Orchestration (HP OO) workflows and service designs. After
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importing the contents, you need to log on to Cloud ServiceManagement Console and configure
service offerings as required.

Subscribing service
After logging on to the HP CSA Marketplace Portal, you can subscribe service offerings. If you have
configuredmultiple organizations in HP CSA or published your service to a catalog other than the
Global Shared Catalog, log on to the appropriate Marketplace Portal for your organization.

Software requirements
The following table lists the software components and the required versions.

Component Supported version Recommended version

HP Cloud Service
Automation

4.50 4.50

CSA-INTEGRATIONS - 4.50.0000 is located at <CSA_
HOME>\CSAKit-4.5\OO Flow Content\10X

CSA-CONFIG - 4.10.0000 is located at <CSA_
HOME>\Tools\ComponentTool\contentpacks

HP Operations
Orchestration

10.21 OO 10.21.0001 with the following HP Operations
Orchestration 10 Standard content packs:

oo10-base-cp -1.4.4

oo10-cloud-cp -1.4.0

oo10-hp-solutions-cp -1.4.0

oo10-virtualization-cp -1.4.0

oo10-sa-cp -1.2.1

oo10-sm-cp -1.0.3

Note: Listed above are the current HP OO versions.
These will be installed automatically when the user
installs the contents.

The latest version of HP OO can be download from
HPLN.

HP Server
Automation

10.21 10.21

Content Pack User Guide
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Component Supported version Recommended version

HP Database and
Middleware
Automation

10.30 10.30

VMware vCenter 4.x, 5.x 5.x

JBoss 8.5, 8.7, 9.x 9.0.0

Note: Youmust purchase and download the JBoss
installation separately.

OpenStack Juno Juno

HP Matrix
Operating
Environment

7.x 7.41

HP Network
Automation

9.x, 10.x 10.0

HP Virtual
Services Router

VSR1000 VSR1000

An example for physical switch is HP Procurve

HP Service
Manager

9.34 9.34

Windows Server 2008 R2 2008 R2

HP SiteScope 10.30 10.30

HP Universal
CMDB

10.11 10.11

HP vPV 2.10.010 or later 2.20

HP Codar 1.50 1.50

HP OneView 1.10

1.20 required for
automated storage
provisioning

1.20

HP ICsp 7.4, 7.4.1 7.4.1

Note: HP CSA OOTB Sequenced service designs, offerings, and subscriptions are not supported
with HP Codar 1.50 only license. Add HP CSA license on HP Codar 1.50 to get these features.
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For information about topology and sequenced service designs, seeHP Cloud Service Automation
Concepts Guide on HP Software Support.

Update OO jar
To update any of the OO jar, the user needs to extract the OOTB capsule and select the intended jar.

User can import the OO jar to OO studio and start updating the OO jars.

Use case OO jar

Amazon AWS Integration com.hp.csl.base.util.jar

com.hp.csl.amazon.ec2.jar

Amazon EC2 Topology com.hp.csl.base.util.jar

com.hp.csl.amazon.ec2.topology

HP Matrix Operating Environment Integration com.hp.csl.base.util.jar

com.hp.csl.matrix.jar

ICSP Topology Integration com.hp.csl.oneview.jar

com.hp.csl.icsp.jar

Monitoring and ConfigurationManagement using vCenter
Compute

com.hp.csl.vmware.vcenter.jar

com.hp.csl.ucmdb.jar

com.hp.csl.sitescope.jar

com.hp.csl.base.util.jar

OneView Topology Integration com.hp.csl.oneview.jar

OpenStack Content com.hp.csl.base.util.jar

com.hp.csl.openstack.util.jar

com.hp.csl.openstack.jar

OpenStack Topology com.hp.csl.openstack.topology.jar

Providers Go Active com.hp.csl.goactive.jar
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Use case OO jar

Provision JBoss on vCenter Compute com.hp.csl.base.util.jar

com.hp.csl.middleware.util.jar

com.hp.csl.vmware.vcenter.jar

com.hp.csl.dma.jar

com.hp.csl.sa.agentinstallation.jar

Provision VLAN using Network Automation com.hp.csl.vmware.vcenter.jar

com.hp.csl.na.jar

com.hp.csl.base.util.jar

SA Software Policies Deployment on vCenter Compute com.hp.csl.vmware.vcenter.jar

com.hp.csl.sa.agentinstallation.jar

com.hp.csl.sa.softwarepolicies.jar

com.hp.csl.base.util.jar

ServiceManager Integration com.hp.csl.sm.jar

vCenterTopology com.hp.csl.base.util.jar

com.hp.csl.sitescope.topology.jar

com.hp.csl.vcenter.topology.jar

VMWare vCenter Compute com.hp.csl.vmware.vcenter.jar

com.hp.csl.base.util.jar

VPV Integration com.hp.csl.vmware.vcenter.jar

com.hp.csl.base.util.jar

com.hp.csl.vpv.integration.jar

User credentials
Make sure that you have all of your credentials handy before trying to integrate content packs with
HP CSA. The following table lists the default user names and passwords, which the user can change
or reset.

Portal Username Password

HP Cloud ServiceManagement Console admin cloud
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Portal Username Password

HP CSA Market place portal consumer cloud

HP Operations Orchestration console admin admin

Documentation
Formore information about HP CSA, refer to the following documents:

l HP CSA Installation Guide or HP Cloud Service Automation UpgradeGuide - Provides information
about installing HP CSA 4.50 or upgrading to HP CSA 4.50.

l HP Cloud Service Automation Concepts Guide - provides information about HP CSA key
terminology, significant functionality, and important processes.

l HP Cloud Service Automation System and Software Support Matrix - Provides information about
supported components and version.

l HP Cloud Service Automation Configuration Guide - provides information about how to set up the
Cloud ServiceManagement Console and HP CSA to enable users to login and use the Cloud
ServiceManagement Console andMarketplace Portal.

l HP Cloud Service Automation Content Installation Guide - provides information about how to run
HP Cloud Content Capsule Installer and import contents.

The above documents are available on HP Software Support.

For more information about software documentation, see "Additional resources" on page 275.

Deprecated: For information about the service designs and HP Operations Orchestration content
packs that have been deprecated, see "Appendix E: Deprecated contents" on page 272.
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Amazon AWS

Configuring Amazon Web Services
The following steps are required to configure AmazonWeb Services (AWS) to integrate Amazon
Elastic Compute Cloud (Amazon EC2) successfully with HP Cloud Service Automation.

Sign up as an AWS EC2 user

Youmust be a registered user to access AWS EC2Services.

To sign up, open http://aws.amazon.com/console/ and create an AWS account.

Configure a security group and keypair

Configure security group and keypair as per the requirement.

1. Go to http://aws.amazon.com/console/ and login.

2. Go toEC2 Services.

3. Click Keypairs.

4. Click Create New Keypair.

5. Enter the keypair details and note down the key pair (for later use).

Setup proxy on HP Operations Orchestration

This step is optional in case HP Operations Orchestration has direct internet access.

1. Log on to HP Operations Orchestration.

2. Go toContent Management > Configuration Items > System Properties.

3. Enter the details for properties CSA_Proxy_Host and CSA_Proxy_Port.

Use case: Amazon EC2 (Topology)
This section describes the steps to provision a classic Amazon EC2 instance with an option to add
network interface and volume.

Configuration requirements
The following configurations must be completed and tested before you proceed with the integration:
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l Configure Cloud ServiceManagement Console andMarketplace Portal.

l Configure Amazon EC2 account.

The values of the properties configured in the Amazon EC2 account will be added in HP CSA.

l Configure HP Operations Orchestration. This must be operational.

Configuring service offerings
Resource categories that are referenced in a service design will be automatically created when the
service design archive is imported.

Service design Provider

SERVICE DESIGN Amazon EC2 Amazon AWS

Creating resource providers

Resource providers must be created in HP CSA. The resource provider required for this implementation
and the service access point are listed in the following table.

Provider name Service access point

Amazon AWS https://ec2.us-west-1.amazonaws.com:443

To create a resource provider:

1. Log on to the Cloud ServiceManagement Console as an administrator.

2. Click Providers.

3. From the list of all providers, select a provider type, and then click Create.

4. In theCreate Resource Provider dialog box, enter the required details, and then click Create.

To view the created resource provider, click Providers on the Dashboard.

Publishing topology design

After importing the service design and components, you can publish the service design.

To publish a topology design:

1. Log on to the Cloud ServiceManagement Console as an administrator.

2. Click Designs > Topology > Designer.
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3. Select the service design.

4. Click theEditor tab.

5. Select the component in the design.

On the right side, properties of the selected component will be displayed. If desired, enter
appropriate values, which can be viewed by subscribers.

The following tables list the property names and definitions.

Amazon Server

Represents a server on the AWS provider.

Component name Description

Name Name of the Amazon Server.

amiId AmazonMachine Image(AMI) Id.

An AMI provides the information required to launch an instance, which is
a virtual server in the cloud. Amazon by default provides many 32-bit and
64-bit AMIs.

availabilityZone Amazon hosts onmultiple locations world-wide called as regions and
each region has multiple locations called as availability zone.

The AWS instances will be provisioned in the zones specified.

instanceNamePrefix The prefix name for the instance to be provisioned.

keyName Amazon EC2 uses public–key cryptography to encrypt and decrypt login
information.

To log on to your instance, youmust create a key pair, specify the name
of the key pair when you launch the instance. Launching public images
without a key pair Id leaves them inaccessible.

Username Login name used to deploy application on the newly created instance.

password Password used to log on to the instance. The privateKey must be left
blank if this property is used.

privateKey If the instance allows key-pair based authentication to login, then the
complete private key content has to be copied.
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Component name Description

SecurityGroupIds A security group acts as a virtual firewall for your instance to control
inbound and outbound traffic.

User can specify comma separated list of security group ids your
instances will be part of. If empty, the default group is used.

Caution: Specify this optional input only when deploying an EC2
instance into Amazon Virtual Private Cloud (VPC). Specifying this
input when deploying an instance into classic EC2 ( Default VPC)
will result in OO flow failure.

subnetId The ID of the subnet from which the eth0 network interface of the
instance will get an IP address allocated.

If not specified, AWS will allocate an IP address from the default subnet
in the specified zone.

Amazon Volume

Represents a volume on the AWS provider.

Component name Description

Name Name of the Amazon Volume component.

deviceName The name of the device (for example: /dev/sdh or xvdh).

availabilityZone The available zone in which to create the new volume.

instanceNamePrefix The prefix name for the instance to be provisioned.

volumeSize The size of the volume in GB.

Valid value range for volume size is 1-1024.

6. Click Save to save the design.

Now, you can test the design.

7. Click theOverview tab, and then click Test Run.

a. Click Finish to launch the test deployment.

b. Click theView button to watch the progress of the job.
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c. On the Test Run screen, click Events, and then select the event.

After successfully deploying a service with a test run, you can publish your design.

8. Click theOverview tab, and then click Publish.

Creating service offering

Service offerings are created from service designs and published to a catalog available on the
Marketplace Portal. Subscribers can order services based on this service design.

To create a service offering:

1. Log on to the Cloud ServiceManagement Console as an administrator.

2. Click Offerings.

3. Click Create.

TheCreate Offering dialog box will open.

4. Select the service design.

5. Enter a name for the new service offering.

This is the name of the offering that will be visible to the subscribers of this service.

6. Click Create.

After creating the offering, you canmodify the pricing information, associate documents, or modify the
subscriber options.

Publishing service offering to Global Shared Catalog

Global Shared Catalog is installed by default when HP CSA is installed. When you publish a service
offering to this catalog, that service offering will be visible in every organization’s Marketplace Portal.

To publish the service offering to Global Shared Catalog:

1. Log on to the Cloud ServiceManagement Console as an administrator.

2. Click Catalogs.

3. Select Global Shared Catalog.

4. Click theOfferings tab, and then click Add Offering.

5. Select the service offering you created.
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6. Click the In Category drop down, and then select the category from the list.

In theMarketplace Portal, the service offering will appear under this category.

7. Click Publish.

A service offering published to a catalog will be available to the user for subscription.

Subscribing service
After the service offering is published to a catalog, you can subscribe it from theMarketplace Portal. If
you have configuredmultiple organizations in HP CSA or published your service offering to a catalog
other than the Global Shared Catalog, log on to the appropriate Marketplace Portal of your organization.

To subscribe service:

1. Log on to Cloud ServiceManagement Console as an administrator.

2. Click Marketplace.

3. Log on to theMarketplace portal.

4. Click theSidebar Menu, and then click Browse Catalog.

5. Select a service offering, and enter the values of the offering as required.

6. Click Checkout.

7. Enter the details such as the subscription name and end date.

8. Click Submit Request.

Open the Subscriptions tab tomonitor the status of your subscription.

Canceling a subscription

To cancel a subscription:

1. On theSidebar Menu, click Subscriptions.

2. Identify the subscription that you want to cancel.

a. Click the subscription to view its details.

b. Click View Linked Service to view the details of the service offering you subscribed.

c. Click Cancel Subscription to cancel the subscription.

Content Pack User Guide
Amazon AWS

HP Cloud Service Automation (4.50) Page 24 of 277



3. Click Yes to confirm that you want to cancel the subscription.

4. Confirm that the status for the subscription is canceled.

When you cancel the subscription, the resource IDs that were assigned to the service (VLAN ID, IP
details, and ACL rule numbers) are automatically released.

Use case: Amazon AWS Integration (Sequenced)

Amazon EC2 Compute with Elastic Load Balancer and
Virtual Private Cloud
This section describes how to provision Amazon EC2Compute with Elastic Load Balancer (ELB) and
Virtual Private Cloud (VPC).

From this content pack, the integration provides two different service designs to provision a classic
Amazon EC2 instance with an option to add an Elastic Lad Balancer (ELB) and another design which
provisions an Amazon EC2 instance in a specified Virtual Private Cloud (VPC).

Configuration requirements
The following configurations must be completed and tested before you set up this implementation:

l Configure Cloud ServiceManagement Console andMarketplace Portal.

l Configure Amazon EC2 account.

The values of the properties configured in this EC2 account will then be added in HP CSA.

Configuring service offerings
Resource categories that are referenced in a service design will be automatically created when the
service design archive is imported.

Service design Provider

Amazon EC2Compute with ELB Amazon AWS

Amazon EC2Compute in VPC
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Creating resource providers

The following table lists the resource provider required for this implementation and the service access
point.

Provider name Service access point

Amazon AWS IP address and port number for EC2, such as https://ec2.amazonaws.com:443

Note: For the AWS provider, the user name is the user's AWS Access Key ID and the password
is the user's Secret Access Key.

To create a resource provider, complete the steps in "Creating resource providers" on page 20.

After creating the resource provider, click theProperties tab for the provider and add the following
properties.

Proxy property name Value

proxyHost IP address of proxy server

proxyPort Proxy port number

proxyUsername Proxy user name

proxyPassword Proxy password

Configuring subscriber options

Subscriber options that are shown to the subscriber in the service offering are loaded from an XML
file.The XML file that is included is a sample EC2.xml located at <CSA_HOME>\jboss-
as\standalone\deployments\csa.war\propertysources. To get the up-to-date information about
images available in AWS, the adminmust use the resource synchronization feature in HP CSA.

For information about adding resource pool and resource synchronization, see "Adding resource pool"
on the next page.

By default the CSA_CP_EC2_OPTION_XML_FILE is set to C:\Program Files\Hewlett-
Packard\CSA\jboss-as\standalone\deployments\csa.war\propertysources\EC2.xml.

Note: <CSA_HOME> and folder separator will be different forWindows and Linux. In this case,
OS specific values must be given.

If the HP Operation Orchestration is installed on a different system, set the path to <Temp-
folder>/EC2.xml.

After the file is created by Resource Synchronization action, copy it to the system where Cloud Service
Automation is installed as <CSA_HOME>/jboss-
as/standalone/deployments/csa.war/propertysources/EC2.xml.
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Adding resource pool

To add resource pool:

1. Log on to the Cloud ServiceManagement Console as an administrator.

2. Click Providers.

3. On the left side pane, select Amazon AWS provider type.

4. On the right side pane, click the Amazon AWS provider.

5. On the toolbar, click Resource Pools, and then click Create.

6. In theCreate Resource Pool dialog box, enter the following details:

a. Dispaly Name: EC2 Image Sync

b. Known By Provider As: EC2 Image Sync

c. Resource Synchronization Action: EC2 Image Sync

7. Enter the above details, and then click Create.

8. Click Synchronize to create the dynamic options file EC2.xml.

After adding a resource provider successfully, the Last Synchronized Date will be updated.

If a subscriber tries to subscribe a service before this EC2.xml file is created, the subscription page will
display an error because the properties page fails to load.

If you see a time out error in theMarketplace Portal while subscribing, increase the value of the
DynamicPropertyFetch.READ_TIMEOUT property from the default value of 3000 to 6000 in the
csa.properties file in the <CSA_HOME>\jboss-as\standalone\deployments\csa.war\WEB-
INF\classes folder in CSA_Home of the HP CSA system.

Associating resource offerings with providers

New resource offerings that were imported with the design archivemust be associated with providers.

Youmust associate the resource offerings and providers listed in the following table:

Resource offering Provider

Amazon EC2 - Compute with ELB Amazon AWS

Amazon EC2 – ELB Registration Amazon AWS

Amazon EC2- Flex Server Resources Amazon AWS

To associate a resource offering with provider:
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1. Log on to the Cloud ServiceManagement Console as an administrator.

2. Click Providers.

3. Select the provider that you want to associate with the offering.

4. Select theOfferings tab.

5. Click Select.

6. Select the resource offerings, and then click Add.

After you have created the resource provider, to view the proxy properties, click theProviders tab.

Creating credentials and system variables

Define the following system property under configuration in HP Operations Orchestration if it does not
already exist.

System property
name Description

OO_HTTP_WAIT By default this value is 0. This property can be set to the number of seconds
to wait if there is network latency.

CSA_CP_EC2_ API_
WAIT_TIME

Sleep time or time to wait beforemaking Enumerate Image List API call for
EC2. Default is 5 seconds.

CSA_CP_EC2_
OPTION_XML_ FILE

For example:

C:\Program Files\Hewlett Packard\CSA\jboss-
as\standalone\deployments\csa.war\propertysources\EC2.xml

Publishing service design

To publish a service design:

1. Log on to the Cloud ServiceManagement Console as an administrator.

2. Click Designs > Sequenced > Designer.

3. Click on the service design version.

4. On theOverview tab, click Publish.

The confirmationmessage displayed informs the user that after publishing the service design, no
modifications can bemade.

Click Yes to publish the design.
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Creating service offering

A service offeringmust be created in HP CSA before subscribers can request services based on this
service design.

To create a service offering, complete the steps in "Creating service offering" on page 23.

Publishing service offering to Global Shared Catalog

To publish a service offering , complete the steps in "Publishing service offering to Global Shared
Catalog" on page 23.

Subscribing service
To subscribe service, complete the steps in "Subscribing service" on page 24.

Canceling a subscription

To cancel a subscription, complete the steps in "Canceling a subscription" on page 24.

HP Operations Orchestration flows
Flows used in this integration, including its input, parameters, and description are described here.

Amazon EC2 - provision server

Provisions an Amazon EC2 instance.

Type
Parameter
name Description

Input username AWS username

Input password AWS password

Input providerSAP AWS access point

Input availabilityZone Availability zone for AWS

Input securityGroup Security group used for AWS

Input amid Image ID

Input volumeSize Size of the EBS volume

Input instanceType Type of the instance launched
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Type
Parameter
name Description

Input keypair Keypair used to connect to the instance

Input prefix Name of the instance

Input SVC_
INSTANCE_ID

This token will resolve to the service instance ID. The default value for this
token is [TOKEN: SVC_INSTANCE_ID].

Input proxyPort Port configured for proxy

Input proxyHost Proxy host name or IP address

After running the process definition tool and creating a new resource pool, a new EC2.xml file will be
created on every Synchronize Now action. This file will fetch themost current information from AWS
and create the JSP files for choosing the platform, image, and keypair based on the region and zone
selected. It is recommended that you synchronize this data at least once a week.

Note: You can get the Security Group ID from the Amazon Console or from the Administrator.

Limitations
Amazon web services supports only Signature version 4 for the newly added regions such as Frankfurt
(eu-central-1) and Beijing (cn-north-1). This causes AWS content to fail since the OO integrations used
currently support only Signature version 2. Until the OO integrations support Signature version 4, the
temporary workaround available is to use anOO system property called CSA_CP_EC2_REGION_
EXCLUDE_LIST. This property is a comma separated list of AWS regions to be excluded and is
currently populated with 'cn-north-1, eu-central-1' to exclude Beijing and Frankfurt regions.

In future, if there is a new region, which supports only Signature version 4, then the name of that region
must be added exactly as AWS reports it. After the OO integrations start supporting Signature version
4, this system property can be set to 'null' to not exclude any region.
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HP Database and Middleware Automation

Installing HP Database and Middleware Automation
For information about installing HP Database andMiddleware Automation (HP DMA), seeHP
Database andMiddleware Automation Installation Guide at on HP Software Support.

Configuring HP Database and Middleware Automation
DMA organization

Create the consumer organization on HP DMA. The organization name on HP DMA must match the
HP CSA consumer organization identifier, which is the identifier created for the consumer organization
name by HP CSA.

See the Roles and Permissions, Role-Based Database andMiddleware Automation Permissions
sections in theHP Server Automation User Guide: Database andMiddleware Automation on
HP Software Support.

User permissions

For information about the HP Server Automation user permissions required to deploy applications using
DMA, see the Roles and Permissions, Types of Permissions sections in theHP Server Automation
User Guide: Database andMiddleware Automation andHP Database andMiddleware Automation
Platform User Guide on HP Software Support.

Solution pack

Import the required solution pack to the HP DMA server. For JBoss, download the AS Provisioning
solution pack under Middleware Solution Packs.

For information about the steps required to import the solution packs, see the Solutions, Working with
Solution Packs sections of theHP Server Automation User Guide: Database andMiddleware
Automation on HP Software Support.

Workflow dependencies

The HP DMA workflows may require some dependent software packages to be imported into the HP
Server Automation core. After installing the solution pack, refer to the workflow documentation to find
the dependencies.

On the HP DMA console, click the Automation tab, and then click workflows. Select the required
workflow to run. To view the work flow documentation, double-click the workflow.

The JBoss - Provision Software workflow requires JDK 1.7 and supports JBoss EAP andWildFly
versions. Download the required packages to a temp directory on themachine containing the HP
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Server Automation client. The dependent software should be imported into the HP Server Automation
core.

To import the software:

1. Open the HP Server Automation client.

2. On the right side pane, click Library > Packages > Required OS Version.

3. On the left pane, right-click an empty area, and then select Import Software.

4. Select all files (downloaded dependencies), and then click Import.

Use case: Provision JBoss on vCenter Compute
(Sequenced)
This section describes how to deploy DMA JBoss using the HP DMA application provider for HP CSA.
It shows how you can simplify and accelerate the creation of the Jboss lifecycle service design and
implementation so that it can be consumedmore easily by multiple business users andmanagedmore
quickly and consistently by administrators.

This implementation supports the following JBoss use case:

l Provision JBoss on vCenter Compute

Configuration requirements
The following configurations must be completed and tested before you set up this implementation:

l Install VMware vCenter.

l Configure HP CSA Cloud ServiceManagement Console andMarketplace Portal.

Youmust be able to successfully deploy the simple vCenter that ship with HP CSA.

l Configure HP Server Automation account.

It must have privileges that enable you to import software packages into the HP Server Automation
library.

l Configure the providers for HP Database andMiddleware Automation, HP Server Automation, and
VMware vCenter in HP CSA.

l Install and configure HP DMA and its solution packs.
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HP DMA solution packs
HP DMA solution packs contain workflows that automate the lifecycle actions that are available
through this integration. To access the solution packs, youmust have a valid support contract and the
account must be linked to a Service Agreement ID (SAID).

Youmust install each of the following solution packs for this implementation:

l Database Provisioning Solution Pack

l Database Patching Solution Pack

l Database Compliance Solution Pack

l Discovery Solution Pack

Downloading solution packs

To download HP DMA solution packs:

1. Go to HPLN, and log on with your HP Passport credentials.

2. On the right side, click Associated Communities.

3. Click Database Solution Packs orMiddleware Solution Packs.

4. Click theDownloads tab.

Download the solution packs listed above.

Configuring HP DMA for provisioning JBoss
This section describes the additional configuration that must be done to HP DMA for using it to
provision JBoss.

Copying workflows

This integration uses the workflows listed in the following table:

Original workflow name Copied workflow name

JBoss - Provision Software CSL JBoss - Provision Software

To copy workflows:
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1. Log on to HP Database andMiddleware Automation at https://<DMA_Server>:<Port>/dma/ as an
administrator.

2. Click Automation >Workflows.

3. Select a workflow listed in the table above.

4. Click Copy at the bottom of the window.

5. Update the name of the copied workflow according to the table above.

6. Click Save.

Creating policies

To create a new policy:

1. Log on to HP Database andMiddleware Automation at https://<DMA_Server>:<Port>/dma/ as an
administrator.

2. Go toAutomation > Policies.

3. Click New Policy.

4. Enter the policy name.

5. Add the attributes for each policy as defined in the following tables.

Details of the policies used by this integration are listed in the tables below.

CSL - JBoss Provision Software Policy

The first policy must be named as CSL - JBoss Provision Software Policy. It requires the attributes
listed in the table below:

Value Binary

Java Binary Archive /root/jdk-7u71-linux-x64.gz or later

JBoss Binary Archive /root/wildfly-9.0.0.Alpha1.tar.gz or later

CSL Discovery policy

The second policy must be named as CSLDiscovery. It requires the attributes listed in the following
table:

Attribute Value

Trust SSLCertificates True

Web Service Password <password>

Content Pack User Guide
HP Database andMiddleware Automation

HP Cloud Service Automation (4.50) Page 34 of 277



Attribute Value

WebService URL https://<DMA HostName>:8443/dma

Web Service User <admin user name>

Note: Values forWeb Service URL, Web Service User, andWeb Service Passwordmust match
your HP DMA server and administrator credentials.

Creating deployments

This integration requires the deployments listed in the following table to provision the JBoss Server:

Deployment name Workflow name

CSL JBoss - Provision Software CSL JBoss - Provision Software

To create deployment:

1. Log on to HP Database andMiddleware Automation at https://<DMA_Server>:<Port>/dma/ as an
administrator.

2. Go toAutomation > Deployments.

3. Click New Deployment.

4. Enter a deployment name.

5. Select the corresponding workflow.

6. Click Add All in the Targets area for the organization.

7. Click Save.

8. On theParameters tab, specify the values for the parameters for the deployment.

See the table below for the deployment parameters for each deployment. Update all deployment
parameter values for the corresponding deployment.

9. Click Save.

Note: Youmust use the workflow and deployment names in the configuration exactly as shown in
the tables. If you change the names, you have to change the corresponding resource offering
properties as well.

CSL JBoss - Provision Software
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Parameter name Value Type

Java Binary Archive CSL JBoss - Provision Software Policy.Java Binary
Archive

Policy
Attribute

JBoss Binary Archive CSL JBoss - Provision Software Policy.Jboss Binary
Archive

Policy
Attribute

Web Service
Password

CSLDiscovery.Web Service Password Policy
Attribute

Web Service URL CSLDiscovery.Web Service URL Policy
Attribute

Web Service User CSLDiscovery.Web Service User Policy
Attribute

Importing binary archives into HP Server Automation library
This section explains how to import the JBoss binary archives into the HP Server Automation library
using the HP Server Automation Client.

The following binaries are required:

l jdk-7u71-linux-x64.gz or later

l wildfly-9.0.0.Alpha1.tar.gz or later

Note: Youmust also import OS Specific DMA client files and DMA Agent support files.

To import binary archive:

1. Launch the HP Server Automation Java Client from theWindows Start Menu.

The default location of the HP Server Automation Java Client is Start > All Programs > HP
Software > HP Server Automation Client.

If the HP Server Automation Client is not installed locally, follow the instructions in theDownload
and Install the SA Client Launcher section in the Server Automation Single-Host Installation Guide
on HP Software Support.

2. Select Library > By Folder.

3. Select the opsware/Tools/Database & Middleware Automation folder.

4. If this is your first import, then youmust create a repository:
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a. Right-click Database & Middleware Automation, and then select New Folder.

b. Name the new folder as Repository.

5. Select the Repository folder you just created, and then click Actions > Import Software.

The Import Software dialog will open.

6. Click Browse and locate the binary archive file (package) that you want to import.

7. Select the character encoding to be used. The default encoding is English ASCII.

Youmust specify the character encoding so that HP Server Automation can extract themetadata
contained in the packages and correctly display the information in non-ASCII characters in the HP
Server Automation Client (such as on the Package Properties pages). Packagemetadata includes
comments, READMEs, scripts, descriptions, and content lists.

8. Click Open. You will return to the Import Software dialog.

9. Select ZIP Archive for the Type.

10. Click Browse and locate the folder, where you want to save the binary archive in HP Server
Automation.

For example: Opsware/Tools/Database & Middleware Automation/Repository.

11. Click Select. You will return to the Import Software dialog.

12. Select the operating system family or operating system for the platform.

13. Click Import.

If a package that you import already exists in the specified folder, you will be prompted regarding
how to handle the duplicate file. Press F1 to view online help that explains the options.

14. Click Close after the import is complete.

Configuring service offerings
Resource categories that are referenced in a service design will be automatically created when the
service design archive is imported.

Service design Provider

Provision JBoss on vCenter Compute HP Database andMiddleware Automation
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Configuring resource offerings for HP DMA 10.30

For HP DMA 10.30, the user needs tomake some changes in Resource Offering property. The
following table lists the properties of the resource offering (HP DMA Jboss) used in this integration.

HP DMA Jboss

Property name Value

dmaDeploymentName CSL JBoss - Provision Software

dmaWorkflowName CSL JBoss - Provision Software

To change the resource offerings properties:

1. Log on to the Cloud ServiceManagement Console as an administrator.

2. Click Designs > Sequenced.

3. Click Resource Offerings.

4. Select the provider type as HP Database and Middleware Automation.

5. Select the resource offering.

6. Update the properties according to the table above.

Note: The values in the table above are based on HP DMA workflow steps used for provisioning
JBoss. Youmust use the workflow and deployment names in the configuration exactly as shown
in the tables. If you change the workflow names in HP DMA, change the corresponding resource
offering properties as well.

Configuring subscriber options

Subscriber options are shown to the subscriber in the service offering. Youmay need to change options
to values that are appropriate for your environment. Youmay also add or remove images as needed.

Creating resource providers

Resource providers must be created in HP CSA. The following table lists the resource providers
required for this integration and the service access points. Youmay need to change them to reflect your
environment.

Provider name Service access point

HP Server Automation https://<SA Core-Hostname>:443
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Provider name Service access point

VMware vCenter https://<vCenter-Hostname>:443

HP Database andMiddleware Automation https://<DMA-Hostname>:8443

To create resource provider, complete the steps in "Creating resource providers" on page 20.

Associating resource offerings with providers

New resource offerings that were imported with the design archivemust be associated with providers.
Youmust associate the resource offerings and providers listed in the following table:

Resource offering Provider

HP SA install Agent HP Server Automation

HP DMA Agent Policy Installs HP Server Automation

HP DMA JBoss HP Database andMiddleware Automation

vCenter Compute VMware vCenter

vCenter Compute Flex Server Resources VMware vCenter

vCenter Compute NOOP VMware vCenter

To associate resource offerings with providers, complete the steps in "Associating resource offerings
with providers" on page 27.

Changing component properties

You can change the following properties in the server group to provision JBoss on vCenter Compute
service design if required:

Property name Description

customSpec Customization specification

datacentreName vCenter data center name

templateReference Template reference

hostNamePrefix Host Name

memoryOp Memory in MB

nCPUOp Number of CPU cores

vmFolder Path for VM to be deployed

To change component properties:
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1. Log on to the Cloud ServiceManagement Console as an administrator.

2. Click Designs > Sequenced > Designer.

3. Select the service design.

4. Click theDesigner tab.

5. Select the component.

6. Change the values for the component properties listed in the table above.

Click the Help icon if you need help editing component properties.

Publish service design

To publish the service design, complete the steps in "Publishing service design" on page 28.

Creating service offering

A service offeringmust be created in HP CSA before subscribers can request services based on this
service design.

To create a service offering, complete the steps in"Creating service offering" on page 23 .

Configuring consumer organization

Youmust configure the consumer organization in HP DMA. To do this, youmust get the organization
identifier from HP CSA:

1. Log on to the Cloud ServiceManagement Console as an administrator.

2. Click Organizations.

3. Select CSA Consumer.

4. Select General Information in the central panel.

5. Record the value displayed forOrganization Identifier.

After getting the organization identifier, you can create the organization in HP DMA.

To create a new organization:

1. Log on to the HP DMA portal at https://<DMA Host>:<Port>/dma/ as an administrator.

The default port number is 8443.

2. Click Environment.
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3. Select New Organization.

4. Enter the organization identifier for the Name.

This is the value you recorded in the previous steps.

5. Click Save.

Publishing service offering to Global Shared Catalog

To publish service offering to the Global Shared Catalog, complete the steps in "Publishing service
offering to Global Shared Catalog" on page 23.

Subscribing service
To subscribe service, complete the steps in "Subscribing service" on page 24.

Accessing JBoss Console

To access JBoss console, log on http://localhost:8080/ .

Canceling a subscription

To cancel a subscription, complete the steps in "Canceling a subscription" on page 24.

Limitation
This offering has been tested for Linux deployments only.
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HP Matrix Operating Environment

Installing HP Matrix Operating Environment
Install HP Matrix Operating Environment (HP MOE) infrastructure orchestration according to the
manufacturer's recommendations. SeeHP Cloud Service Automation System and Software Support
Matrix for version requirements on HP Software Support.

Configuring HP Matrix Operating Environment
For information about how to configure HP Matrix Operating Environment infrastructure orchestration,
see %CSA_HOME%\CSAKit-4.5\Lib\matrix operating environment\README.txt.

Use case: HP Matrix Operating Environment
Integration (Sequenced)
This section describes how to use HP MOE to provision simple compute. This integration can be
leveraged to provision other software like Oracle, SQL, WebSphere, andWeblogic on VMs that are
created using HP MOE Compute Provisioning.

HP MOE flows use generic provider types and resource offering category types. Custom HP MOE
flows will push custom resource offerings to particular service component servers, server groups, or
both. The flow also populates the required resource offering parameters to service component servers,
server groups, or both, based on the resource offering configuration.

The following use cases can be considered:

l UseHP MOE to provision a VM.

l UseHP MOE service templates to provision the service infrastructure with resource allocation like
number of servers, number of CPUs, andmemory size.

About HP MOE
HP MOE is a cloudmanagement software for infrastructure as a service (IaaS) that increases agility.

HP MOE enables us to:
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l Design and provision infrastructure services in minutes via a self-service portal.

l Optimize infrastructure with capacity planning and showback or chargeback.

l Protect service continuity with automated cost-effective failover.

Configuration requirements
The following configurations must be completed and tested for this implementation:

l Install and configure VMware vCenter.

l Create a VM template in VMware vCenter, which has the HP Server Automation agent and all
related policies installed.

l Configure HP CSA Cloud ServiceManagement Console andMarketplace Portal.

l Configure a workingmatrix environment.

Configuring service offerings
Resource categories that are referenced in a service design will be automatically created when the
service design archive is imported.

Service design Provider

MOE Infrastructure Compute HP Matrix Operating Environment

Configuring subscriber options

Subscriber options are shown to the subscriber in the service offering. Youmay need to enter
subscriber options that are appropriate for your environment. Youmay also add or remove images as
needed.

Creating resource providers

The resource providers must be created in HP CSA. The following table lists the resource provider
required for this implementation and the service access points; youmay need to change them to reflect
your environment.

Provider name Service access point

HP Matrix Operating Environment https://<Matrix-Hostname>:51443/hpio/controller/soap/v4

To create a resource provider, complete the steps in "Creating resource providers" on page 20.
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Associating resource offerings with providers

New resource offerings that were imported with the design archivemust be associated with providers.
Youmust associate the resource offerings and providers listed in the following table:

Resource offering Provider

HP MOE Infrastructure Compute HP Matrix Operating Environment

To associate resource offerings with providers, see "Associating resource offerings with providers" on
page 27.

Publishing service design

To publish the service design, complete the steps in "Publishing service design" on page 28.

Creating service offering

A service offeringmust be created in HP CSA before subscribers can request services based on this
service design.

To create a service offering, complete the steps in "Creating service offering" on page 23.

Publishing service offering to Global Shared Catalog

To publish a service offering to the catalog, complete the steps in "Publishing service offering to Global
Shared Catalog" on page 23.

Subscribing service
To subscribe service, complete the steps in "Subscribing service" on page 24.

Canceling a subscription

To cancel a subscription,complete the steps in "Canceling a subscription" on page 24.

HP Operations Orchestration flows
Add custom type resource binding subflow

This flow adds the custom based resource offering and the properties attached to the infrastructure
service component to its child server and server group components.
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If the value for the resources offering property roServiceComponent is set to SERVER, SERVER_
GROUP, or BOTH, then this flow will add the custom type resource and populate the infrastructure
service component properties for the server, server group, or both.

Type Parameter name Description

Input srvList HP CSA component ID for one or more server (delimited by the pipe
| character) on which the custom resource binding is to be created.

input srvGrpList HP CSA component ID for one or more server group (delimited by
the pipe | character) on which the HP Universal CMDB resource
binding is to be created.

input userIdentifier HP CSA user ID

input customResProviderId HP CSA resource provider ID for the custom provider, to be used by
the custom resource binding on the server and server group
components.

input customOffrName Name of the custom offering to be attached to the server and server
group components.

input customBindingOrder Resource binding order for the custom offering to be attached to the
server and server group components.

input customOffrID Offering id of the custom resource offering.

input infraComponentID Infrastructure component ID.

Limitations
This solution assumes the same deployment of resource offering across all groups in the HP MOE
template.

For example, for a HP DMA deployment using HP MOE as compute provider, all the groups in the HP
MOE template will have the sameHP DMA workflow applied.

VMware Tools will not be installed on the VM created through HP MOE.
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HP Network Automation

Installing HP Network Automation
HP Network Automation (HP NA)must be installed and configured before you use it to provision a
VLAN from a networking switch. For installation instructions, see theHP Network Automation
Software Installation and UpgradeGuide on HP Software Support.

Configuring HP Network Automation
HP NA must be installed and configured before you use it to provision a VLAN from a networking
switch.

To configure HP Network Automation, perform the following steps:

1. Install HP Network Automation.

2. Network Automation supplies NA driver pack with the base installation by default.

HP recommends installing the latest HP NA driver pack after installing HP NA.

The HP NA May 2015 driver pack can be downloaded from HP Live Network.

To download the driver pack, you need to register with HP Passport.

3. Set up the HP Networking switch with themanagement IP address.

a. Enable SSH, TFTP, and SCP in the switch according to your requirements.

b. Ensure that the configured networking switch is accessible from the HP NA server.

4. Discover and take a snapshot of the configured networking switch in the HP NA portal. The user
guide helps you to set up this step.

For example, in NA v9.20 the user guide is available in NA server at <HP NA Install
Path>\docs\en\user_guide.pdf.

This pathmay vary based on the installed HP NA version. The networking switchmust be
discovered andmanaged by HP NA.

5. Import the command script to the HP NA portal.

See the README.txt file on the HP CSA instance in the <CSA Install Path>\CSAKit-
4.5\Lib\network automation folder for more details.
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The command script must be testedmanually and be able to execute successfully from the HP
NA console.

Use case: Provision VLAN using Network Automation
(Sequenced)
This section explains the steps to create a VLAN using HP Network automation. HP Network
Automation software automates the complete operational lifecycle of network devices from
provisioning to policy-based changemanagement, compliance, and security administration.

The key benefits of HP NA include:

l Reduces costs by automating time-consumingmanual compliance and configuration tasks.

l Passes audit and compliance requirements easily with proactive policy enforcement and audit and
compliance reports.

l Improves network security by recognizing and fixing security vulnerabilities before they impact your
network.

l Increases network stability and uptime by preventing inconsistencies andmisconfigurations.

l Uses process-powered automation to deliver application integrations, which deliver full IT lifecycle
workflow automation.

The HP VSR1000 Router Series is a virtualized application that provides functionality similar to a
physical router. The VSR1000 series enables significant operational savings as a result of its agility
and ease of deployment. Like other virtual applications, the routers run in a virtual machine on an
industry-standard x86-based server. Resources on the VSR1000 series can be dynamically allocated
and upgraded on demand as performance requirements grow.

This implementation involves the following step:

l The flow allocates a free tag and sets the network name custom attribute with a user-provided name
and then provisions the VLAN.

Configuration requirements
Configuration depends on the type of switch that the user is using. The following configurations must
be done if the content is used with a virtual switch such as VSR1000:

Note: This integration is demonstrated using a virtual switch VSR1000.

Content Pack User Guide
HP Network Automation

HP Cloud Service Automation (4.50) Page 47 of 277



l Download and configure HP Virtual Services Router (VSR1000) in vCenter Client.

l Configure vSphere Distributed Switch (VDS) in vCenter Client.

l Install the latest NA Driver Pack in HP Network Automation.

Download the NA driver pack at https://hpln.hp.com//node/19/contentfiles?dir=12108

l Configure HP Network Automation with resource identity pools.

l Configure the HP CSA administrator and consumer portals.

The following image depicts an overview of the networking layout:

Configuring vSphere Distributed Switch in vCenter
Create a vSphere Distributed Switch in a vCenter server data center to handle networking traffic for all
associated hosts on the data center. This implementation requires a Distributed Switch instead of a
standard switch because the HP VSR must be connected to a distributed port group to use VLAN
trunking.

To create the Distributed Switch, perform the following steps:

1. In the vSphere Client, select theNetworking inventory view and then select the data center.

2. Select Inventory > Datacenter > New vSphere Distributed Switch.
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3. Select the vSphere Distributed Switch Version: 5.0.0.

4. Click Next.

5. In theName text box, enter a name for the new vSphere Distributed Switch.

6. Use the arrows to select the number of uplink ports, and then click Next.

7. Select whether to add hosts and their physical adapters to the vSphere Distributed Switch. You
can add this later also.

8. Click Next.

9. Select whether to automatically create a default port group. This option creates a distributed port
group with default settings (Optional) .

10. Click Finish.

Adding hosts to a vSphere Distributed Switch
After the vSphere Distributed Switch is created, perform the following steps to add hosts at the
distributed switch level:

1. Log on to the vSphere Client, and then select theNetworking inventory view.

2. Right-click the vSphere Distributed Switch in the inventory pane, and then select Add Host.

3. Select the hosts to add, and then click Next.

Do not select any physical adapters to add under the selected hosts.

4. Migrate virtual machine networking to the Distributed Switch (optional).
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5. Review the settings for the Distributed Switch and then click OK.

Adding a distributed port group
To add a distributed port group to a vSphere Distributed Switch to create a distributed switch network
for your virtual machines, perform the following steps:

1. Log on to the vSphere Client, and then select the Networking inventory view.

2. Select Inventory > vSphere Distributed Switch > New Port Group.

3. Enter a name and the number of ports for the new distributed port group.

4. Select VLAN Trunking as the VLAN type.

5. Enter the VLAN trunk range.

For example, 100-300. The VLAN trunk range shouldmatch the VLAN IDs configured in the HP
Network Automation resource pools.

6. Click Next.

7. Click Finish.

8. Verify the HP Network Automation port group settings (Optional):
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Downloading and configuring a virtual service router
To download and configure the HP Virtual Services Router, perform the following steps:

1. Download the HP Virtual Service Router (VSR1000) from the following URL:

http://h17007.www1.hp.com/us/en/networking/products/routers/HP_VSR1000_Virtual_
Services_Router_Series/index.aspx#.U2zx9fmSzuw

2. Deploy the VSR1000_HP-CMW710-E0101P01-X64.ova template in your vCenter Client.

3. To install the VSR1000_HP-CMW710-E0101P01-X64.iso image, perform the following steps:
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a. Right-click the virtual machine from the navigation tree, and then click Edit.

b. Click theOptions tab.

c. Select the check box in the Force BIOS Setup area, and then click OK.

d. Select the newly created virtual machine from the navigation tree.

e. On theConsole tab, select theBoot tab to start the virtual machine.

f. Configure the virtual machine to preferentially boot from the CD-ROM drive.

g. Save the configuration, and then exit.
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h. Connect the CD drive of the VM to the ISO image of the HP VSR.

i. Right-click on the VM in the left navigation pane, and then click Edit Settings.

j. In the Virtual Machine Properties window, click CD/DVD Drive 1.

k. On the right pane, select theDevice Type section, and then click Client Device.

l. Click OK to save the changes.

m. Power on the VM beforemounting the ISO.

n. From the topmenu, click the CD-ROM icon and then select CD/DVD Drive 1 > Connect to
ISO image on local disk.
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Your disk is now mounted and available for use by the VM.

o. Boot the virtual machine from the ISO image and enter the installation interface.

p. In the installation interface, enter 1 to select Fresh Install. This upgrades the HP VSR to the
version in the ISO image.

q. After the installation is complete, disconnect the CD drive.

r. Enter yes to reboot the system and complete installing the HP VSR.

s. After the reboot is complete, type the display version command to verify that the system
software image is correct.

Configuring user access via SSH

To set the user name and password for the HP VSR, execute the following commands:

sys

ssh server enable

public-key local create rsa

user-interface class vty

authentication-mode scheme

protocol inbound ssh

quit

local-user <username>

password simple <password>

service-type ssh

authorization-attribute user-role network-admin

quit

Configuring IPs

To configure the interface to use DHCP for IP address acquisition, execute the following commands:

sys

int g1/0

ip address dhcp-alloc
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Configuring ACLs

The HP VSR permits all packets that do not match any ACL rules by default. Execute the following
commands to create an ACL that ensures access to the VSR device:

sys

acl number 2001 name acl2001

rule 0 permit

quit

int gi1/0

packet-filter name acl2001 inbound

packet-filter name acl2001 outbound

quit

After you create the ACL, you can optionally enter the packet-filter default deny command to
change the default action of the router. Ensure that you have console access to the router before
changing the default.

The HP Network Automation Command Scripts file includes the script to dynamically configure the HP
VSR. You can only use the script to configure user access and packet filtering after the HP VSR is
assigned an IP address manually.

Adding a distributed port group to a virtual service router

To add a distributed port group to an HP virtual services router, perform the following steps:

1. Log on to the vSphere client and select theVMs and Templates inventory view.

2. Select theHP Virtual Services Router.

3. Right-click and select Edit Settings.

4. Click theAdd button to select the distributed port group.

5. Select theEthernet Adapter, and then click Next.

6. Select the distributed port group from theNetwork Label drop-downmenu.

7. Click Next.

8. Click Finish.

9. Execute the following command from the console to determine the DHCP-allocated IP address of
the gi1/0 interface:
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display int gi1/0

You can now log in to the HP VSR through SSH.

Adding device groups

Creating a device group helps you categorize devices based on organizational needs.

To add new device groups:

1. On themenu bar, underDevices, select New, and then click DeviceGroup.

The New Group page opens.

2. Add the new device group, and then click theSave button.

Field Description

Group
Name

Enter a group name.

Description Enter a description of the group.

Site
<name>

The site name should be default.

Sharing Select public sharing.

Parent
Device
Group

The Inventory group appears in the drop-downmenu.

You can also select another group.Your selection is ignored if youmake the group
private. Private groups cannot be part of the group hierarchy.

Devices Enter the IP address of the HP Virtual Services Router.

Adding devices

To add a new device:

1. On themenu bar, underDevices, select New, and then click Device.

The New Device page opens.

2. Add the new device, and then click theSave button.

Field Description

IP Address
(or DNS
name)

Enter the IP Address of the HP Virtual Services Router or any other device that user
may wish to use
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Field Description

Hostname Enter the host name of the device

Site
<name>

The site name should be default

Belongs to
Groups

Select the name of the device group

Device
Driver

Choose the device specific to the device being used

Here, EXT_HP (Choose the Specify Driver Option and then select EXT_HP (formerly
H3C) Corporation switches, routers, U200 and SecPath firewalls, 3Com Corporation
switches 4500G, S4800G, S7900 series, Comware version 5.x, 7.10, VRP 8.50 from
the drop-downmenu.) is used as an example.

Password information

Use
device-
specific
password
information

Enter the Router user name and password

Additional information

Model Enter themanufacturer model number for the device.

For example: VSR1000

Vendor Enter the vendor of the device.

For example: HP

Importing command scripts

Click the Import/Export Commands Scripts link on the Command Scripts page to open the
Import/Export Scripts/Diagnostics page.

Field Description

Import Select the HPN Virtual Network.exp command script to import.

Note: To import a command script or diagnostic from a non-driver source, select
Import from file, and then enter the file name or click Browse.

Copy the HPN Virtual Network.exp command script from the C:\Program
Files\Hewlett-Packard\CSA \CSAKit-4.5\Lib\network automation folder to
your VM location.

Click Import, and then select the HP Network Automation scripts to import.
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Instillation notes:

The following steps explain how to import the command script HPN Virtual Network.exp to HP NA
portal:

Step 1: Import command script to the NA portal

To import the command script HPN Virtual Network.exp:

1. Log on to the HP NA portal as an administrator (the administrator user is created during
HP NA portal installation).

2. Click Devices > Device Tools > Command Scripts.

3. Click Import/Export Command Scripts.

4. From the Import/Export Scripts/Diagnostics page, click Choose File and browse to the location
of the HPN Virtual Network.exp command script.

5. Click Import.

The default location of the command script file is C:\Program Files\Hewlett-Packard\CSA
\CSAKit-4.5\Lib\network automation

6. Click Import.

7. From the Import Scripts page, verify that theHPN Create Vlan andHPN Delete Vlan
checkboxes are selected.

8. Click Continue.

Themessage Important: You have successfully imported one or more Command Scripts or
Diagnostics is displayed.

9. Verify the command scripts imported.

10. Click Devices > Device Tools > Command Scripts and verify that HPN Create Vlan and HPN
Delete Vlan are listed in the Command Scripts page.

Step 2: Validate Imported Command Scripts

1. Click Devices > Device Tools > Command Scripts.

2. From the Command Scripts page, for HPN Create Vlan, click Run.

3. From the New Task/Template - Run Command Script page, select switchmanagement IP
address ('Applies to' field) of your discovered switch and enter values for Vlan Id, Vlan SubnetIP,
and Vlan SubnetMask.

For example, set Vlan Id = 200, Vlan Subnet IP = 192.168.30.1 and Vlan Subnet Mask =
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255.255.255.0

4. Click Save.

If the networking switch is already discovered and a device snapshot is successfully taken in the
HP NA portal, themessage 'Succeeded' is displayed.

Step 3: Verify or update the command script mode

To verify/update the command script mode:

1. Click Devices > Device Tools > Command Scripts.

2. For HPN Create Vlan, click Edit.

3. From the Edit Command Script page:

n If you are using an HP networking switch, verify theMode is 'ProCurve configuration'.

n If you are using another networking switch, select an appropriate Mode from the drop-down
box.

4. Repeat steps 2 and 3 for the 'HPN Delete Vlan' command script.

l If you are using an HP networking switch, verify that the 'HPN Create Vlan' and 'HPN Delete
Vlan' command scripts use the Device specific Network Automation driver.

For Example, HP VSR1000 uses EXT_HP (formerly H3C) and HP ProCurve uses EXT_HP_
Procurve.

l If you want to use another networking switch, update themode of each command script, and
also update each script code for the corresponding network switch.

l Verify that HPCSA_NA_CreateVlanScript and HPCSA_NA_DeleteVlanScript script System
properties are present in HP OO central.

Enabling custom field option in HP NA

Custom resource identity fields enable storing of additional information with each resource identity.

For example, an IP address resource identity might have custom fields for subnet mask, gateway, and
DNS.

To enable the custom field option in HP NA, perform the following steps from the HP NA console:

1. OpenAdmin > Administrative Settings > User Interface page.

2. In theEnhanced Custom Fields area, select theEnable Enhanced Custom Fields check box.

3. Click Save.
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Downloading distribution files
The distribution file for the HP Network Automation distribution file can be found on HPLN. Extract the
distribution file to a temporary location on the HP CSA server.

The distribution file contains all the flows used by integrations in the content pack. You will import these
flows as part of the configuration for all integrations.

The extracted contents will include a zip file for each implementation in this content pack. The zip file
for this implementation includes the files listed in the following table.

Note: HP Cloud Content Capsule Installer deploys the distribution file automatically.

Contents of the distribution files are listed in the following table:

Folder File name Description

%CSA_HOME%\CSAKit-
4.5\Lib\network automation\

HPN Virtual
Network.exp

HP Network Automation scripts used for
this implementation

No other folders are currently used.

Configuring service offerings
Resource categories that are referenced in a service design will be automatically created when the
service design archive is imported.

Service design Provider

Provision VLAN using Network Automation HP Network Automation

Creating resource providers

Resource providers must be created in HP CSA. The following table lists the resource providers
required for this implementation and the service access points. Youmay need to change them to reflect
your environment.

Provider name Service access point

Network Automation https://<Network Automtion IP Addresss>

To create resource providers, complete the steps in "Creating resource providers" on page 20.
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Associating resource offerings with providers

New resource offerings that were imported with the design archivemust be associated with providers.
Youmust associate the resource offerings and providers listed in the following table:

Resource offering Provider

HP NA Provision VLAN HP Network Automation

To associate resource offerings with providers, complete the steps in "Associating resource offerings
with providers" on page 27.

Changing component properties

Youmust edit the service design and change the properties of Virtual Network Component listed in
following table.

Property name Description

switchIPAddress Management IP address of the switch which is already discovered by HP NA
portal

vlanId VLAN ID which is required to create a vlan in the switch.

The VLAN ID should be a number between 1 and 4094. For example: 222

vlanIPSubnet Subnet IP address to be configured for created VLAN ID.

For example: 192.168.30.1

vlanSubnetMask VLAN Subnet mask to be configured for created vlan.

For example: 255.255.255.0

vlanTag Resource identity ID of VLAN

To change component properties, complete the steps in "Changing component properties" on page 39.

Publishing service design

To publish the service design, complete the steps in "Publishing service design" on page 28.

Creating service offering

A service offeringmust be created in HP CSA before subscribers can request services based on this
service design.

To create a service offering, complete the steps in "Creating service offering" on page 23.
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Publishing service offering to Global Shared Catalog

To publish the service offering to Global Shared Catalog, complete the steps in "Publishing service
offering to Global Shared Catalog" on page 23.

Subscribing service
To subscribe a service, complete the steps in "Subscribing service" on page 24.

Canceling a subscription

To cancel a subscription, complete the steps in "Canceling a subscription" on page 24.

Content Pack User Guide
HP Network Automation

HP Cloud Service Automation (4.50) Page 62 of 277



HP OneView and HP Insight Control server
provisioning
This section explains the integration of HP Cloud Service Automation (HP CSA) with HP OneView and
HP Insight Control server provisioning (HP ICsp) to enable the deployment of physical servers with a
selected operating system. The integration uses the embrace UI capability with HP CSA and HP
Operations Orchestration (HP OO) to allow a user to create a service design using the Topology
Designer and import components from HP OneView and HP ICsp. Service designers can select
predefined server profiles from HP OneView and build plans from HP ICsp and import them into HP
CSA so that they can be used when creating new topology service designs.

This section provides the detailed instructions to install the solution, create simple IaaS and SaaS
designs, and finally deploy andmanage a service from the HP CSA Marketplace Portal.

Use case: OneView and ICsp Topology Integration
The integration of HP Cloud Service Automation (HP CSA) with OneView and Insight Control server
provisioning (ICsp) enable the deployment of physical servers with a selected operating system.

Prerequisites
The following table lists software and supported versions:

Software Version

HP Cloud Service Automation (HP CSA) 4.50

HP CSA Content Pack 4.50

Required components and supported versions are listed in the following table:

Component Version

HP OneView 1.10

1.20 required for automated storage provisioning

HP Insight Control server provisioning 7.4, 7.4.1

ProLiant servers Refer to OneView Support Matrix

OneView 1.10

OneView 1.20
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Component Version

Intelligent Provisioning Refer to OneView Support Matrix

HP Operations Orchestration 10.21

The following table lists the HP Operations Orchestration content required to enable the HP OneView
Managed Server Provisioning capsule. The HP OO content is installed during the HP CSA installation
process. If you have been notified by HP support that an update to the following content is necessary,
updates to the HP Operations Orchestration content can be downloaded from HP Live Network.

Component Version

OOBase Content 1.4.4

OOSolutions Content 1.4.0

HP Insight Control server provisioning setup
The HP CSA integration to HP Insight Control server provisioning (ICsp) is intended to leverage an
existing HP ICsp appliance or appliances that have been configured to deploy the desired operating
system versions in your environment.

Working operating system build plans must be available and tested before being imported as
components in HP CSA. Follow the Insight Control Server Provisioning 7.4 Installation Guide to import
requiredmedia and customize any scripts as required for your environment.

Limitations of HP ICsp

Limitations of HP ICsp are the following:

l If you are creating customized build plans in HP ICsp, the build plan names must be prefixed with
'ProLiant OS –'. Only the build plans that are prefixed with 'ProLiant OS –' are visible in the
Component Import wizard.

l All customization of build plans must be self-contained in HP ICsp with an exception that 'Custom
Attributes' may be specified in HP CSA as an input property to the HP ICspOS Build plan
component used in the service design. HP CSA does not provide server personality data such as
hostname or IP address.

For information about custom attributes, see "Creating service designs with HP ICsp custom
attributes" on page 90.

Note: To customize an out-of-the-box build plan, copy an existing build plan andmodify it to point
at a configuration file that you have customized. Click the Save As button tomake a copy of an
existing build plan and configuration file.
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HP OneView setup
The HP CSA integration to HP OneView is intended to leverage an existing HP OneView appliance or
appliances that aremanaging physical servers and other physical infrastructure such as network
switches and storage devices in your environment.

Create and validate unassigned server profiles (being used as templates) in HP OneView before being
imported as components in HP CSA. Local storage, externally managed SAN storage, and
HP OneView managed SAN storage are supported.

Create a server profile template

Creating one or more server profile(s) to use as a template will enable you to build HP CSA service
designs that deploy andmanage physical servers using HP OneView.

Consider the following key points when creating server profiles to use as templates:

l Use alphanumeric characters for server profile names. Special characters can cause errors when
profiles are copied.

l Leave the Server hardware as Unassigned.

l Define the Ethernet and Fibre Channel Connections.

l If HP ICsp will be used for OS deployment, include an Ethernet connection with network access to
HP ICsp.

l See the appropriate section below for more specfic guidance for creating profiles that utilize local
storage, externally managed SAN storage, and HP OneView managed SAN storage.

Later in the configuration process, you will import this unassigned Server Profile into HP CSA and use
it in your topology service design. If desired, createmultiple server profiles reflecting the options you
wish to use to deploy your servers. A sample server profile is shown in the following figure.
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Managing local storage with HP OneView

HP OneView supports deploying servers with local boot disk. Supported server types are listed in the
HP OneView support matrix at www.hp.com/go/oneview/docs.

A sample subset of server profile with local storage is shown in the following figure.

The local storage section sets the RAID level, allows you to set the disk as bootable, and can be set to
initialize the storage before provisioning.
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For information about how tomanage local storage, see HP OneView documentation.

HP OneView externally managed SAN storage configuration for
blade servers

If automatic storage provisioning is not available, it is possible to preallocate storage for each blade
server using theWorldWide Port Name ((WWPN) for the Fibre Channel ports. This solution requires
disabling Virtual WorldWide Names (WWN) in HP OneView.

For information about disabling virtual WWN, see "Appendix B: Disabling virtual WWNs in
HP OneView" on page 265.

Note: This solution requires additional steps tomove a server profile from one server to another as
the storage is presented to the first servers physical WWPNs. Moving to another server will
require unpresenting the storage from the first server's WWPN's and presenting it to the second
servers WWPN's in addition to reassigning the profile within HP OneView.

After disabling the virtual WWN allocation, perform the following steps for each server you wish to
deploy:

1. Determine theWWPNs for the Host-Bus Adapters (HBAs) in the server. See "Appendix
C: Creating temporary server profiles to discoverWWPN of HBAs" on page 266 for amethod that
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leverages temporary profiles in HP OneView tomake it easy to determineWWPNs without
installing anOS or needing to boot to the adapter BIOS.

2. Present one or more disks to your server.

3. Create server profile(s) as appropriate that define Fibre Channel connections that will allow the
servers to connect to the presented disks.

HP OneView local and externally managed SAN storage
configuration for rack mount servers

HP OneView does not manage network or storage connectivity for rack mount servers. Servers with
external storagemust be physically powered on to determine theWorldWide Port Names (WWPN)
required for preallocating storage. Onemethod to determine theWWPN is to open an iLO session to
the server and power it on. When the option appears during Power On Self Test (POST), press Ctrl+Q
to enter QLogic FastUTIL or Ctrl+E to enter Emulex OneConnect to obtain theWWPN needed to
present storage.

Once you have obtained theWWPN and provisioned the storage, create a server profile for your rack
mount server. Make sure to select the appropriate server hardware type and firmware baseline.
Networking and storage are not managed by HP OneView for rack mount servers. The servers must be
configured with a network that has access to HP ICsp to deploy OS build plans.

A sample profile for a DL server is shown in the following figure.

Note: Use alphanumeric characters for server profile names. Special characters can cause errors
when profiles are copied.
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HP OneView Managed SAN storage configuration

Automated storage provisioning is supported with HP OneView 1.20. For automated storage
provisioning, HP OneView must be configured as follows:

1. Add a storage system.

2. Define storage pools.

A sample storage system configuration with storage pools and storage system ports specified is
shown in the following figure.
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For information about defining storage pools and storage system ports, see the HP OneView User
Guide.

3. Create a server profile template that specifies Fibre Channel connections to your SAN storage.

4. Specify the primary and secondary boot paths, and then select Use Adapter BIOS.

5. Create the Ethernet connections.

A sample profile including Ethernet and Fibre Channel connections is shown in the following figure.
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6. Select theManage SAN Storage check box.

7. Choose theOS type in the drop down, and then click Add Volume.

8. Select the new volume.

9. Enter a name for your boot disk and select Auto LUN. The name of your boot disk must start with
'boot'.

Note that the volumewill be automatically created when you create the server profile. If the
volume name specified is not unique, the volume namewill be changed to ensure uniqueness.
Additional data disks can be defined in the server profile. The data disks namemust not start with
'boot'. You can specify Auto LUN ormanually set the LUN for data disks.
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Note: The prefix for the boot disk is specified in a system property in HP Operations
Orchestration. The default prefix is 'boot'.

If you wish tomodify the default prefix, log on to HP Operations Orchestration Central, go to
Content Management > Configuration Items > System Properties. Select Edit and add an
override value for ONEVIEW_SAN_BOOT_VOLUME_NAME_REGEXP.

A sample boot volume specification is shown in the following figure.
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10. Select your storage pool, capacity, and provisioning.

11. Youmust clear thePermanent check box to automatically remove volumes when the server
profile is deleted.

12. Storage paths should already be listed as they were created when you defined the Fibre Channel
connections.
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After adding the volume data, the server profile will include SAN Storage definition as shown in the
following figure.

Solution installation

Out-of-the-box-installation
The HP CSA OneView Managed Server Provisioning content is most easily installable by selecting the
Install additional provider integration service designs, components and content option when
installing or upgrading to HP CSA 4.50. If you are using the graphical HP CSA Installer by choosing to
install the additional content as shown in the following figure, the solution will be installed out-of-the-box
with HP CSA 4.50.
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Manual installation
If you do not install the sample content at the time of installing HP CSA 4.50 or upgrading to
HP CSA 4.50, the HP CSA OneView Managed Server Provisioning content can still be easily installed
on your server later. The solution is packaged in the csa-ootb-content-04.50.000.zip content
capsule pack file located in the Tools/CSLContentInstaller below the location where HP CSA was
installed. Additionally the csl-content-installer.jar tool located in the same directory can be
used to perform a graphical or silent installation of all of the sample content in the csa-ootb-content-
04.50.000.zip file or if you choose, just the HP OneView and HP ICsp subset of that content as
shown in the following figure.

For information about how to install content manually, seeContent Installation Guide at HP Software
Support.
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Solution configuration
The installer you ran in the "Solution installation" section automatically installs the required
HP Operations Orchestration workflows and copies the files to the appropriate locations to allow
configuration of HP OneView and HP Insight Control Server Provisioning as providers for HP CSA.
The installer also automatically imports the default service designs required for physical server
provisioning. Restarting the csa service is part of the installation instructions andmust be done before
continuing with the solution configuration steps in this section.

This section provides the instructions to:

l Make servers available for provisioning using HP OneView server labels

l Set server login information

l Create HP OneView and HP ICsp providers

l Import HP OneView server profiles and HP ICsp build plans as components
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l Create a service design

l Create an offering

Managing server availability
Deployment of physical servers from HP CSA requires the HP OneView administrator to identify
servers with a label. The HP OneView administrator must apply labels to each server they wish to
make available to HP CSA for service deployments.

HP OneView label usage

The physical server provisioning capability provided by this utility requires that available servers are
labeled to identify servers available for deployment. Only servers that have the label
hpcsaUNASSIGNED will be used for deployment.

Servers can also be labeled for restricted use by specific HP CSA organizations using organization
labels. Examples of organization labels are shown in the following table. A server can havemultiple
organization labels. If a user requesting a service is not in any of the organizations identified by the
labels provided, the server is unavailable to that user.

Note: This solution does not require the creation of organization labels. If no organization labels
are present, a server labeled with hpcsaUNASSIGNED is available to any user.

Label Effect

onlyForCSACONSUMEROrg Server is available for use only by users in the Consumer
organization

onlyForSALESOrg Server is available for use only by users in the CSA Sales
Organization.

onlyForFINANCEOrg Server is available for use only by users in the CSA Finance
Organization

Creating HP OneView labels

Label assignment can be set from the HP OneView web interface.

Manual label process

Caution: Do not modify the labels during provisioning.

All hpcsa labels other than hpcsaUNASSIGNED are for internal use only during deployment and
should not bemodified or removed.
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1. From the HP OneView console, select Server Hardware view.

2. Select a server on the left panel, and then select Labels view in the drop down list on the right
panel.

3. Click theEdit link next to the Labels name.

TheEdit Labels dialog box opens. You have to position your mouse over Labels to bring up the
Edit link.

4. Enter 'hpcsaUNASSIGNED', and then click theAdd button.

5. Add organization labels using the format in Table 4 if desired.

6. Repeat this process for each server you wish tomake available for automated deployment from
CSA.

Additional labels used by provisioning process

During the service provisioning process, the labels on HP OneView servers are changed to reflect the
current availability state of the server.

The following table lists the labels applied to servers during the provisioning process.

Label Meaning

hpcsaUNASSIGNED Server is available for use

hpcsaRESERVED Server is reserved for a deployment

hpcsaDEPLOYING Server is in the process of being deployed

hpcsaDEPLOYED Server is currently deployed

hpcsasubID<subscription
ID>

Server in use by the specified HP CSA subscription ID.

hpcsa testRun <CSA_
CONTEXT_ID>

Server is in use by a test run associated with the specified HP CSA
context ID.

hpcsaFAILEDDEPLOY Server failed to deploy successfully.

The failed deployment requires debugging to determine why it failed and
fix the issue causing the failure. A server in this state must bemanually
re-labeled to hpcsaUNASSIGNED before it can be used again by CSA
for deployment. See "Appendix A: Troubleshooting" on page 263 for
instructions onmanual label cleanup process.
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Setting properties in Operations Orchestration Central
HP ICspOS deployment requires creation of an HP Operations Orchestration Central system account
with server iLO login permission. If you do not use signed certificates, you will also need to change the
default trust setting.

l Log on to Operations Orchestration Central.

l Select Content Management > Configuration Items > System Accounts tab.

l Select ILO_ADMIN, and then click theEdit icon.

l Set the Username and Password fields to specify a user that has been configured to allow access
to iLO on all the servers you wish to use for deployment and then click theSave button.

l Close the Operations Orchestration Central.

Creating providers

1. Select HP OneView from the Provider List, and then click Create.

2. Enter the Display Name as HP OneView as shown in the following figure.

3. Enter a valid User ID and Password for HP OneView.

This user must have the Infrastructure administrator role in HP OneView.

4. Enter the URL used to access HP OneView in the Service Access Point field, and then click
Create.
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5. a. Select HP Insight Control Server Provisioning from the Provider List, and then click
Create.

b. Enter the Display Name as 'HP Insight Control server provisioning' as shown in the following
figure.

c. Enter a valid User ID and Password for HP Insight Control server provisioning.

This user must have the Infrastructure administrator role in HP ICsp. This role grants full
administrative privileges to all items and actions including the ability to configure the ICsp
appliance.

d. Enter the URL used to access HP ICsp in the Service Access Point field , and then click
Create.
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Note: Unless you have imported the HP ICsp appliance's certificate into the default HP
Operations Orchestration central truststore, either the 'trustAllRoots' or the
'trustKeystore' property may need to bemodified.

For information about the certificate, see "Managing Appliance Certificates" below.

Managing Appliance Certificates
By default, the certificate generated by HP OneView and HP ICsp appliances are self-signed; they are
not issued by a trusted certificate authority.

Note: HP Operations Orchestration operations that communicate with the HP OneView and HP
ICsp appliances will fail until one of the following procedures is performed.

To familiarize yourself with the options related tomanaging the appliance certificates, see the
Managing certificates from a browser section in theHP OneView User Guide at
http://www.hp.com/go/oneview/docs orHP Insight Control Server Provisioning 7.4 Administrator
Guide at http://www.hp.com/go/insightcontrol/docs. These guides contain instructions for 'Using a
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certificate authority' to replace the default self-signed certificate with one that has been generated by a
trusted certificate authority.

For information about the options for certificate management in HP Operations Orchestration, seeHP
OOCentral Guide and theHP OOHardening Guide on HP Live Network.

The three primary methods to enable HP Operations Orchestration to trust the certificates of your HP
OneView and HP ICsp appliances are as follows:

1. Import a new certificate generated using a certificate authority that is trusted by HP Operations
Orchestration Central (recommended).

2. Export the appliance self-signed certificate (using the same process documented when
'Downloading and importing a self-signed certificate' for a browser section in theHP OneView
User Guide at http://www.hp.com/go/oneview/docs) and import it into the default HP Operations
Orchestration Central cacerts using the following steps:

a. Transfer the appliance certificate you downloaded to somewhere on the server where HP OO
central is installed.

b. Import the appliance self-signed certificate using the keytool utility located at <OO install
dir>/java/bin/keytoolwith a command similar to the following, where the entries in bold
text have been replaced by your values:

keytool -importcert -alias <applianceX> -keystore <OO install
dir>/java/lib/security/cacerts –file <appliance certificate path> -storepass
<changeit>

c. Restart the HP Operations Orchestration Central service.

For more information about updating client certificates and other related configuration tasks in
HP OO, see theConfiguring Client Certificate Authentication in Central section in theHP OO
Hardening Guide at HP Live Network.

3. Disable strict SSL certificate checking for https communication between HP Opererations
Orchestration and the appliances by setting the 'trustAllRoots' provider property to True.

This should only be considered in development environments where other means have been
employed tomitigate the security risk disabling strict SSL certificate checks.

Caution: HP does not recommend the practice of disabling strict SSL certificate checks or using
self-signed certificates (even if you trust the originator) in production environments.

Creating service designs and offerings
After completing the initial configuration tasks, services designers can begin the process of creating,
testing, and publishing new service designs that users will be able to order from the
HP CSA Marketplace portal.
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Service design Provider

Deploy Server with HP OneView Profile HP OneView

Deploy Server with HP OneView Profile and ICSP
BuildPlan

HP Insight Control server provisioning

Importing components
For HP OneView and HP ICsp provider types, new components will need to be imported if new server
profiles or OS build plans have respectively been created on the provider.

Topology components are not automatically imported from a provider when a new provider is defined in
HP CSA. The below process can be used to import HP OneView and HP ICsp components after
defining the providers or to bring in new or updated components from those providers later.

1. From the CSA Management Console, click Designs.

2. Click Topology, and then click Components.

3. Click the Import button.

4. From the Import Source drop down list, select HP OneView.

HP CSA will query your HP OneView provider and display a list of 'unassigned' server profiles that
can be imported as topology design components.

5. Select HP OneView server profiles as shown in the following figure, and then click Next.
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6. Click theGeneral tab, select a specific image or tags if desired, and then click Next.

7. Click theSummary tab, review your selections, and then click Import.

8. Click the Import button again to import the build plans from HP ICsp.

9. From the Import Source drop down list, select HP Insight Control server provisioning.

10. Select the build plans you wish tomake available in a topology service design and click Next as
shown in the following figure.
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11. Click the General tab, select a specific image or tags if desired and click Next.

Note: If you do not select an image after importing, ICsp build plans will automatically select
an OS specific icon. If you are importingmore than one type of OS (as shown in the above
figure), it is recommended to leave the default image choice to allow the automatic selection
to take place.

12. Click theSummary tab to review your selections, and then click Import.

Creating simple IaaS service design
After the desired build plans and server profiles have been imported as components, it is possible to
create infrastructure as a service (IaaS) service designs. The following section describes how to create
a basic topology service design.

Complete the following steps to create a new service design:
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1. From the CSA Management Console Dashboard, click Designs.

2. Click Topology, and then click Designer.

3. Click Create, and enter a Display Name and Description (if desired).

4. If desired, click Change Image and select a new Image. Select tags if you want to use a tag to
make the design easier to locate.

5. Click Create.

6. Select theDesigner tab.

The HP OneView and HP ICsp components you imported in the previous sections are available
for you to use in your new service design.

7. Drag or double-click your imported server profile to the canvas.

8. Drag or double-click your imported build plan to the canvas.

9. Drag a connector between the Build Plan and the Server Profile. Once the connector is made it will
have a label 'Installed On'.

10. Select the Build Plan component on the canvas and in the component properties pane (on the right
side), set the OS Password, OS Private Key (if needed), andOS Username properties as shown
in the following figure.
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Note: These settings do not control what the Build Plan will use during deployment (they are
not inputs that influence the build plan), but instead should reflect the username and password
that will be configured by the Build Plan as specified in the build plan itself or Custom
Attributes settings. These properties exist so that follow-on HP CSA components are able to
access the deployedOS.

11. If desired, specify a value for theCleanup Build Plan Name property, or leave it blank if no
cleanup is needed during undeploy. When specifying a cleanup build plan, ensure that you specify
the entire build plan name (for example: ProLiant HW - Erase Server)

Note: By default, no OS build plan is run during undeploy. For dynamically created SAN
storage, the LUN is automatically deleted when the server profile is deleted on a service
cancellation.

Caution: If you choose to add anOS Build Plan to run on undeploy, be aware that some build
plans will wipe all attached storage including shared storage. Ensure that you do not
accidentally delete shared storage by verifying the actions of any undeploy build plans
assigned in your service design.

12. Click Save to save the property value settings.

Testing designs

Now that the design has been created and properties have been specified, it can be tested.

To test the new service design:
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1. Click the Test tab, and then click the Test Run button.

2. If desired, specify a value for the Display Name of the test run (for example, Simple Design try 1).

Note: Setting a unique Display Name field will make it easier to identify workflows in
HP Operations Orchestration.

3. If you have configured Environments for your HP OneView and HP ICsp providers, select the
appropriate environment for deployment.

4. Click Finish to launch the test deployment.

5. Click theView button to view the progress of the job.

6. Click theEvents tab from the Test Run screen.
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7. Click the event for the 'Deploy' action from the top of the list.

8. Click the link under the Process ID to view the progress of the job from HP Operations
Orchestration Central.
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For information about debugging issues with service deployments, see "Appendix A: Troubleshooting"
on page 263.

9. After successfully deploying a service with a test run, you can publish your design.

10. Click theOverview tab for your Topology design, and then click thePublish button.

Confirm that you wish to publish your design when reminded that after publishing it cannot be
modified. If you need to edit the service design, create a new version, test it, and then publish the
new version.

Creating service designs with HP ICsp custom attributes
In the simple IaaS design described above, no guidance was given regarding the Custom Attributes
property of the Build Plan component. For most OS Build Plans that ship out-of-the-box with HP ICsp,
there are no required custom attributes, but if you have a build plan that requires custom attributes or
you wish to set one or more optional custom attributes, this can be specified using the Custom
Attributes property as shown in the following figure.

The value specified for this property should be a JSON formatted string that defines custom attributes
in the format expected by the HP ICsp REST API as the value specified for the component property
above will be passed through to a PUT call of the /rest/os-deployment-servers/{id} API.
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As each build plan accepts different attributes, the below JSON sample simply focuses on showing the
proper format for hypothetical key1 and key2 custom attributes. Review the attributes documented in
your build plan for which specific key/value pairs are supported. As per the JSON specification, you
can specify values with or without spacing as to your preference; however the compressed format
shown in figure X will typically be easier to read on HP CSA and HP Operations Orchestration web
pages.

The examples below only specify 'server' scoped attributes. This is the only scope supported by HP
CSA Custom Attributes property for HP ICspOS build plans components.

An example for Custom Attributes property value with spacing/indentation is given below.

Note: This property will overwrite the existing custom attributes values and will accept a subset of
key/value custom attributes so that you do not need to provide the full existing set of (default)
custom attributes along with your additions/overrides. Any existing values of the same key(s) will
be overwritten, but other existing keys that were previously configured in HP ICsp will not be
otherwise impacted.

For more specific guidance on the format of this JSON string, click the Help icon on your appliance and
see the HP ICsp REST API documentation.
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In particular, the PUT operation for the /rest/os-deployment-servers/{id} operation should be reviewed
by selecting Servers from the Deployment section of the API reference.

Due to the potential for error or wide influence on the build plan deployment the Custom Attributes
property should be approached with care:

l HP recommends you always perform a test run of your design each time the Custom Attributes
property has beenmodified to validate it has the desired effect.

l It is not recommended for this property to be exposed to consumer users to control (in an option set)
or to view and is therefore defaulted to not being consumer visible.

Creating service design including Chef component
The design created in the "Creating service designs with HP ICsp custom attributes" can bemodified
to include deployment of any component type that utilizes the Server Capability relationship to perform
additional configuration of the server. Examples of such components are Chef cookbook and Puppet
class components.

The following steps explain how to add a Chef cookbook component to HP OneView Managed
Provisioning designs. These instructions assume familiarity with configuring a Chef provider in HP
CSA. For more information, see theContent Provided by Chef section in theHP Cloud Service
Automation Topology Components Guide (software version: 4.50) on HP Software Support.
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1. Confirm that your Chef provider is configured and you have imported the desired Chef cookbook
component(s):

a. Click Providers from the Dashboard of the HP CSA Management Console.

b. Select your Chef provider (if a Chef provider does not exist, you can add it by following the
instructions in theHP Cloud Service Automation Topology Components Guide).

c. From the Chef provider page, select the Components tab and review components listed. If the
desired cookbooks are listed skip to step 2 below.

d. To addmore Chef cookbook components, youmust import them from your Chef server. Click
theManage button, which will open the components page in a new tab in your browser.

e. Click the Import button at the bottom of the page.

f. Select Chef as the Import Source and then select which cookbooks to import using a similar
process to the one documented in the "Importing components" on page 83.

2. Confirm that you have the desired “Chef enabled” OS Build plan component(s):

a. Create, or confirm you have already created, a customized ICspOS build plan for the OS
version you wish to deploy. For details, see "Appendix D: Prepare ICspOS Build Plan to work
with Chef" on page 270.

b. Clcik Providers from the Dashboard of the HP CSA Management Console.

c. Select your HP Insight Control server provisioning provider.

d. From the HP ICsp provider page, click theComponents tab and review the components
listed. If the desired OS Build Plans are listed, skip to step 3 below.

e. To addmore ICspOS build plan components, youmust import them from your ICsp
appliance. Click theManage button, which will open the components page in a new tab in
your browser.

f. Click the Import button at the bottom of the page.

g. Select Insight Control server provisioning as the Import Source and then select which OS
build plans to import as per step 8 in the "Importing components" on page 83.

3. Navigate to the Topology Designs page by clickingDesigns > Topology > Designer.

4. Create a new simple IaaS service design, that uses the desired “Chef enabled” OS build plan as
per the "Creating simple IaaS service design" section.

5. You can now add the desired Chef component to deploy after the OS.
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Drag or double-click on a Chef component and draw the connector between the Chef component
and the ICspOS Build Plan component. The link will appear with a hostedOn label. In the following
figure, an Apache2.0.0 component has been added.

6. Confirm theOS Password andOS Username properties have been set as discussed in the
"Creating simple IaaS service design" section(step 10).

Since OS Password andOS Username are confidential properties, youmight find it difficult to
confirm. In such case, reset the user name and password.. These properties must be set for the
Chef cookbook to deploy successfully.

7. Click the Test tab to test your design. After verifying that your service design works as expected,
publish the service design.
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Creating service offerings
Service offerings are created from service designs and published to a catalog available from the CSA
Marketplace Portal.

1. From the CSA Management Console, click Offerings.

2. Click theCreate button.

3. Click under Service Design to display a list of available service designs.

4. Select the service design you published, and then click theSelect button.

5. Enter a Display Name and Version Name. The Display Name followed by Version Name is the
Service Offering name that the end user will see from the CSA Marketplace Portal.

6. Enter a description and change the image if desired. Click Create.

7. If desired, click thePricing tab and set the price for your service.

8. Click thePublishing tab, and then click Publish.

9. Select a Catalog, Category and set Approval policy.

Note: HP recommends that you set an approval policy for your organization to ensure proper use
of expensive physical server usage. Approval policies cannot be set when services are published
to the Global Shared Catalog.

An example for publishing the service to the FinanceOrganization catalog is shown in the following
figure.

Content Pack User Guide
HP OneView and HP Insight Control server provisioning

HP Cloud Service Automation (4.50) Page 95 of 277



10. Click thePublish button.

11. After publishing the service to a catalog, it will be available to the end user for subscription.

Deploying a service

Ordering and managing the service from the CSA
Marketplace Portal
After the service is published to a catalog, an end user can order it from theMarketplace Portal. If you
have configuredmultiple organizations in HP CSA or published your service to a catalog other than the
Global Shared Catalog, log on to the appropriate Marketplace Portal for your organization.

1. Log on to theMarketplace Portal as amember of the organization you specified when the service
offering was published.

An example for Finance organization portal is shown in the following figure and finance1 user is a
member of the organization.
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2. Click All Services to display the catalog of services available to the finance1 user.

3. Select the service you created to a Gen 8 Physical Linux Web Server.
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4. Click Checkout to proceed with the subscription.

5. Provide a subscription name and description.

6. Specify the Start and End Date.

7. Click Submit Request to deploy the service.
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The following figures show a successfully deployed service.

After the service is successfully deployed, it can bemanaged from theMy Services menu. The service
can be stopped and restarted or deleted.
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Known issues
Defect Reason Workaround

When using HP OneView
topology components in
scalable groups, server
reservation errors will occur if
the scalable group is set to
use an instance count greater
than 1.

Scalable group instances deploy in parallel
creating a race condition in the HP Operations
Orchestration content that is utilized by the
OneView topology components. This results in
all instances of the scalable group reserving the
same server and a deployment failure.

This issue will
be fixed in the
upcoming
HPLN content
release in July
2015.

Importing HP CSA topology
components from HP
OneView may sometimes fail
prior to listing available server
profiles.

Unhandled timeouts or communication errors
with the HP OneView appliance.

Retry the
operation. In
most cases, a
second attempt
to import the
components
will succeed.

Application deployment when
using a HP Server Automation
policy component with an HP
ICspOS Build Plan
component fails.

HP Server Automation agent is not installed or
configured automatically as part of the HP SA
policy component deployment.

None
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OpenStack

Use case: OpenStack content (Sequenced)
This section explains the steps to provision compute with storage.

OpenStack - a commercial distribution built on OpenStack technology- provides an open, scalable,
highly available enterprise grade cloud platform with the agility, innovation, and economics to help to
build, manage, and consume hybrid clouds.

OpenStack helps to flexibly deploy and host workloads, applications, and services across Traditional
IT and into whichever cloud delivery model - public, private, or managed/hosted - that best enables your
business.

HP CSA is architected to provide an open, heterogeneous, extensible single pane IT service control
point with OpenStack tomanagemultiple cloud resource pools from HP and other providers, to design-
orchestrate full stack services and IT service broker capabilities.

This integration includes HP CSA service designs and HP Operations Orchestrations workflows,
which can be used to create a service offering for consumers to request andmanage server instance
and block storage volume from OpenStack environment.

Specific service design (OpenStack - Multitenant support) has been provided to demonstrate multi-
tenancy using HP CSA Identity Management (IdM), OpenStack Identity (Keystone) API v3 and API v3
OS-TRUST extension.

Configuration requirements
The following configurations must be completed and tested before you set up this implementation:

l Configure Cloud ServiceManagement Console andMarketplace Portal.

l Configure providers for OpenStack Juno software in HP CSA.

l Configure OpenStack environment. This must be operational.

l Configure HP Operations Orchestration. It must be operational.

Configuring service offerings
Resource categories that are referenced in a service design will be automatically created when the
service design archive is imported.
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Service design Provider

OpenStack-Compute with Storage v4.0 OpenStack

OpenStack-Multi-Tenant Support v2.0

Creating resource providers

Resource providers must be created in HP CSA. The following table lists the resource providers
required for this integration and typical service access points. Youmay need to change them to reflect
your environment.

Provider
name Service access point

OpenStack Provide OpenStack identity service API access endpoint: http://<openstack-identity-
service-ip or host>:<port>/version

Example:

http://<openstack-host>:5000/v3

http://<openstack-host>:5000/v2.0

OpenStack - Multi-tenant Support v2.0 service design requires Keystone API version
3.

OpenStack - Compute with Storage v4.0 service design can be used with both
Keystone v2.0 and v3. Therefore, it is recommended to configure v3 endpoint as both
designs supports that.

User name and password: OpenStack Admin User and password.

Note: Formulti-tenancy, provider user needs to be the same as integration
account user or transport user configured in the IdM.

To create a resource provider, complete the steps in "Creating resource providers" on page 20.

Configuring property file

HP CSA 4.50

Deploy the provider.properties file from the <CSA-Installation-Path>\<csa jboss
path>\standalone\deployments\csa.war\propertysources folder to the HP CSA server under the
path <CSA-Installation-Path>\<csa jboss
path>\modules\system\layers\base\sun\jdk\main\service-loader-resources

Note: The display name entered while configuring the provider must be the same as
provider.properties file.
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If you enter provider display name as OpenStack, then the provider.properties file must have
the following:

bind.os.provider.name= OpenStack

Service designs

OpenStack – Compute with Storage v4.0

HP CSA admin can use this design to create service offering for the consumers. To subscribe service,
the user first need to select the tenant, which resources need to be utilized, and then select the
appropriate server configuration.

Note: ThoughOpenStack supports Keystone API v2.0, it also supports v3. Therefore, it is
recommended to use v3 endpoint as provider service access point (SAP).

If the service design is manually imported, make sure that all the JSPs in the service design and
os-common.jsp are placed in the following location:

HP CSA 4.50: C:\Program Files\Hewlett-Packard\CSA\jboss-
as\standalone\deployments\csa.war\propertysources

OpenStack - Multi-Tenant support v2.0

This design supports multi-tenancy or user context enable or disable switch in the form of subscriber
option 'User Context & Tenant Name'. HP CSA administrator must update this option with appropriate
value while creating service offering andmake it invisible to consumers.

Note: TheOpenstack multi-tenant service design, when used on a CSA 4.5 instance with IdM
secondary authentication enabled, is supported with only oneOpenStack provider defined. If there
are 2 or more OpenStack providers defined and IdM secondary authentication is enabled, then the
service offering in Marketplace Portal might have issues in loading.

Example:

l Value: “true#<tenant name>”

In this case, multi-tenant or user context is set to true. It takes HP CSA user and the logged in
organization into account to work with the provider to process request.

l Value: “false#<specific tenant name in openstack>”

In this case, multi-tenant or user context is disabled. So, it takes the provider configured user
and <specific tenant name in openstack> into account while processing user request.

This requires provider service access point to be configured with Keystone API v3 endpoint.
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Note: If the service design is manually imported, make sure that all the JSPs in the service design
and os-common-v3.jsp are placed in the following location:

HP CSA 4.50: C:\Program Files\Hewlett-Packard\CSA\jboss-
as\standalone\deployments\csa.war\propertysources

Formore information about muti-tenancy support, see "Multi-tenancy support" on page 113.

Associating resource offerings with providers

New resource offerings that were imported with the service design archivemust be associated with
providers. Youmust associate the resource offerings and providers listed in the following table:

Resource offering Provider

OpenStack – Flex Server Count v2.0 OpenStack

OpenStack – Compute v2.0 OpenStack

OpenStack – Compute Actions v3.0 OpenStack

OpenStack – Storage v1.0 OpenStack

OpenStack – Storage Actions v2.0 OpenStack

OpenStack Keypair v1.0 OpenStack

To associate resource offerings with providers, complete the steps in "Associating resource offerings
with providers" on page 27.

Configuring instance details email for subscription

Before subscribing, the user can edit the default properties, which are included in the instance details
email.

To configure the email with subscription details:

1. Click OpenStack – Compute v2.0 resource offering.

2. Click theProperties tab.

Default properties of the created instance will be displayed.

3. Modify the properties if required, and then click OK.

Upon successful subscription, the user receives the email with the details specified.

Publishing service design

Before publishing the OpenStack - Multi-tenant support v2.0 service design, youmust complete
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the following steps:

1. Log on to the Cloud ServiceManagement Console as an administrator.

2. Click Designs >Sequenced > Designer.

3. Click theOpenStack – Multi-tenant v2.0 service design.

4. Click theSubscriber Options tab.

5. Click theExpand all the option sets and theShow all the properties icons to
view all the properties.

6. Click theEdit icon of the property '7b.Name of the key pair to be created (if applicable)'.

7. In theKeyPair Propertieswindow, clear theRequired check box.
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8. Click Save in the KeyPair Properties window. Youmust click the Save button in the
Subscriber Options tab.

To publish the service design, complete the steps in "Publishing service design" on page 28.

Creating service offering

A service offeringmust be created in HP CSA before subscribers can request services based on this
service design.

To create a service offering, complete the steps in "Creating service offering" on page 23.

Publishing service offering to Global Shared Catalog

To publish service offering to the Global Shared Catalog, complete the steps in "Publishing service
offering to Global Shared Catalog" on page 23.

Subscribing service
To subscribe service, complete the steps in "Subscribing service" on page 24.

Tomonitor the status of subscription, click theSubscriptions tab.

Based on network latency, loading dynamic values from theOpenStack portal will vary. If Marketplace
Portal shows an internal error, increase the "Dynamic Property Fetch Retrieve Data Timeout" and
"Dynamic Property Fetch Response Data size limitation" values in the csa.war property file, which
is under the path <CSA-Installation-Path>\<csa
jbosspath>\standalone\deployments\csa.war\WEB-INF\classes\csa.war.

The following table lists the required subscriber options:

Subscriber
option Value

Tenant
Name

Tenant/project name in OpenStack

Availability
Zone

The name of the availability zone

Flavor The flavor reference for the desired flavor for your server instance

Image The image reference for the desired image for your server instance

Private
Network
Name

The name of the Private network.

Subscribers can select more than one network
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Subscriber
option Value

Public
Network
Name

The name of the Public network

Keypair
Details

The name of the security key used with the new server.

The user can select from the existing keypair or create a new keypair. If the user
creates a new keypair and if LDAP is configured, the private key is sent through an
email.

If the user wants to create a new Keypair, then the user needs to select the Create a
new Keypair option from the Select from existing Keypair drop down list.

Security
Group
Name

The name of the security group used with the new server

Server
Name
Prefix

The prefix name for the new server

The following table lists the required subscriber options if OpenStack Block StorageOptions is
selected.

Subscriber option Value

VolumeName The display name for the new volume

VolumeDescription A description for the new volume

Volume Size in GB The size, in gigabytes for the new volume

Canceling a subscription

To cancel a subscription, complete the steps in "Canceling a subscription" on page 24.

HP Operations Orchestration flows
Flows used in this integration, including its input, parameter name, and description are described here.

Openstack Compute - Deploy

Creates a new server instance.

Type Parameter name Description

Input imageName Image which has to be deployed.

Content Pack User Guide
OpenStack

HP Cloud Service Automation (4.50) Page 108 of 277



Type Parameter name Description

Input flavorName Flavor name using which instance has to be created.

Input keypairname Name of the Keypair to use.

Input serverName Specifies the name for the VM.

Input tenantName A name for the tenant/project that is unique within OpenStack.

Input privateNetwork Name of the private network.

Input floatingIPPool Name of the public network.

Openstack Compute - UnDeploy

Deletes a server instance.

Type Parameter name Description

Input serverId Specifies the server ID for the VM

Input tenantId Tenant ID

Openstack Compute – Hard Reboot

Performs a hard reboot of a server. A hard reboot (HARD) is equivalent to power cycling the server.

Type Parameter name Description

Input serverId Specifies the server ID for the VM

Input tenantId Tenant ID

Openstack Compute – Soft Reboot

Performs a soft reboot of a server. In a soft reboot (SOFT), the operating system is signaled to restart,
which allows for a graceful shutdown of all processes.

Type Parameter name Description

Input serverId Specifies the server ID for the VM

Input tenantId Tenant ID

Openstack Compute – Start Server

Returns a STOPPED server to ACTIVE status.

Type Parameter name Description

Input serverId Specifies the server ID for the VM

Input tenantId Tenant ID
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Openstack Compute – Stop Server

Description: Halts a running server and changes status to STOPPED.

Type Parameter name Description

Input serverId Specifies the server ID for the VM

Input tenantId Tenant ID

Openstack Compute - Suspend

Suspends a server and changes its status to SUSPENDED.

Type Parameter name Description

Input serverId Specifies the server ID for the VM

Input tenantId Tenant ID

OpenStack Compute – Resume Server

Resumes a SUSPENDED server and changes its status to ACTIVE.

Type Parameter name Description

Input serverId Specifies the server ID for the VM

Input tenantId Tenant ID

OpenStack Compute – Associate Floating IP

Associates floating IP to a server.

Type Parameter name Description

Input serverId Specifies the server ID for the VM

Input tenantId Tenant ID

OpenStack Compute – Disassociate Floating IP

Disassociates floating IP from the server.

Type Parameter name Description

Input serverId Specifies the server ID for the VM

Input tenantId Tenant ID

OpenStack Compute – Refresh

Refreshes the state of the server.
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Type Parameter name Description

Input serverId Specifies the server ID for the VM

Input tenantId Tenant ID

OpenStack Storage– Add Storage Volume

Creates a new volume.

Type Parameter name Description

Input volumeSize The size, in gigabytes, for the new volume.

Input volumeDisplayName The display name for the new volume.

Input volumeDisplayDescription A description for the new volume.

OpenStack Storage– Remove Storage Volume

Type Parameter name Description

Input volumeID The ID of the volume to delete.

OpenStack Storage– Extend Volume

Type Parameter name Description

Input volumeSize The size, in gigabytes

OpenStack Storage– Create Snapshot

Creates a new snapshot.

Type Parameter name Description

Input displayName The name of the snapshot to be created.

Input displayDescription The description of the snapshot to be created..

Input volumeId The ID of the volume from which to create the snapshot

OpenStack Storage – Delete Snapshot

Deletes the specified snapshot.

Type Parameter name Description

Input snapshotId The ID of the snapshot to delete

OpenStack Storage – Add Storage Volume from Snapshot

Creates a new Volume from a snapshot.
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Type Parameter name Description

Input volumeSize The size, in gigabytes, for the new volume.

Input volumeDisplayName The display name for the new volume.

Input volumeDisplayDescription A description for the new volume.

Input snapshotId The ID of the snapshot from which to create the new volume

Set up an attached volume
After you create a Block Storage Volume and attach it to an instance, you need to perform the following
tasks within the instance to prepare the attached volume for use.

Use SSH to connect to your server

To use SSH to log on to your instance, type the following command:

$ ssh –i <keypair><myinstance>@<ipaddress>

For example:

$ chmod 0600 keypair1.pem

$ exec ssh-agent bash

$ ssh-add keypair1.pem

$ ssh -i keypair1.pem cirros@10.11.12.5

Format the volume

1. To ensure that the device for new volume is present, type the following command:

$ ls /dev/vdb

/dev/vdb

2. To format the volume, type the following command:

$ mkfs /dev/vdb

Mount the volume

1. Tomount the newly formatted disk, type the following commands:

$ mkdir /Test

$ mount /dev/vdb /Test
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2. To verify that the newly mounted volume has the correct size, type the following command:

$ df –h

Output similar to the following is displayed:

Filesystem Size USed Available Used% Mounted on

/dev 998.2M 0 998.2M 0% /dev

/dev/vda 387.4M 10.4M 357.0M 3% /

tmpfs 1001.8M 0 1001.8M 0% /dev/shm

tmpfs 200.0K 96.0K 104.0K 48% /run

/dev/vdb 1007.9M 1.3M 955.4M 0% /Test

You can see from the output that the Cinder-created volume has the correct size. This indicates
that the process has worked end-to-end.

Multi-tenancy support
In HP CSA, an organization is an entity defined by the HP CSA administrator and can be a company,
business unit, department, or group. Membership in an organization is determined by the organization's
identity management configuration, which HP CSA accesses to authenticate the user's login
credentials with OpenLDAP orMicrosoft Active Directory. The administrator determines amember's
entry point into the cloud and associates eachmember with services and resources.

HP CSA identity management (IdM), apart from the primary authentication with OpenLDAP or
Microsoft Active Directory it supports configuration of secondary authentication with OpenStack
Identity (keystone) service to enable an integration account or transport user to perform OpenStack
actions on behalf of another user. On successful secondary authentication against keystone, generate
a Keystone Trust ID using the authenticated user as the Trustor and the configured integration account
as the Trustee.

In OpenStack, a project is a logical grouping of users, and is used to define quotas and access to virtual
machine images.

In OpenStack, an administrator implements multi-tenancy by manually mapping HP CSA organizations
to OpenStack projects. This mapping is established through the use of a directory service: OpenLDAP
orMicrosoft Active Directory.

Note: Mapping can be establishedmanually without Keystone being configured to useOpenLDAP
orMicrosoft Active Directory.

The following table shows the examples for supportedmapping:
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CSA OpenStack

CSA Organization (Marketing)

l mkt_user1

l mkt_user2

Project (MARKETING)

l mkt_user1

l mkt_user2

CSA Organization (Engineering)

l eng_user1

l eng_user2

Project (ENGINEERING)

l eng_user1

l eng_user2

Mapping organizations to projects and identity management secondary authentication with Keystone
ensures that all subscription requests from organization users are fulfilled in the context of user and the
corresponding project.

l Resources from only the user’s project are consumed.

l Integration account to perform OpenStack actions on behalf of requested user.

HP CSA organization user can then use theMarketplace Portal to check out an offering and create a
subscription in HP CSA market place portal. HP CSA logs in to OpenStack using the relevant project
user credentials and orchestrates the provisioning of instances.

Multi-tenancy can be implemented by following the three steps below:

1. Enabling Keystone authentication in IdM.

Set idm.keystone.enabled = true in the file C:\Program Files\Hewlett-
Packard\CSA\jboss-as\standalone\deployments\idm-service.war\WEB-
INF\spring\applicationContext.properties.

2. Creating anOpenStack Resource Provider in CSA Management console.

Provide the Service Access Point for Keystone service and the IdM Keystone Integration account
credentials.

Specify following properties for the OpenStack provider:

n Project - Enter the project in OpenStack in which provisioning should occur when provisioning
topology designs in which enableUserContext is set to False for every OpenStack component
in the design. If all OpenStack designs set enableUserContext to True, the Project may be left
empty, and the subscriber will be able to select the project at provisioning time from the set of
projects to which the subscriber is authorized.

n Domain - Enter the domain in OpenStack that should be used. This domainmust be configured
for authentication in the same fashion as the consumer organizations for which this provider
will be used.
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n Transport Token -When checked, a domain-scoped transport token will be used for
communication with OpenStack. When unchecked, a project-scoped transport token will be
used. The provider user must have administrative rights on the domain in order to use domain-
scoped transport tokens.

3. Setup organization in HP CSA with a directory service endpoint: OpenLDAP orMicrosoft Active
Directory that is also configured in the OpenStack Keystone instance.

Mapping CSA organizations LDAP to LDAP of OpenSTack Keystone instance and identity
management secondary authentication with Keystone ensure that all subscription requests from
organization users are fulfilled in the context of user and the selected project.

The sequence of operations performed inmulti-tenancy is shown in the figure below.

In general, this feature works as follows:

l Following a successful authentication against one of the primary mechanisms (LDAP, Active
Directory), attempt to authenticate against a secondary mechanism (Keystone) using the same
credentials and organization.

l On successful authentication against Keystone, generate a Keystone trust ID using the
authenticated user as the trustor and the configured integration account as the trustee.

l As needed, use the Keystone trust ID to generate a Keystone impersonation token so that provider
account configured can perform OpenStack actions on behalf of the truster.
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Note: Integration account configured in IdM for secondary authentication andOpenStack provider
configured in HP CSA should be the same.

Verify secondary authentication

Log on to HP CSA Organization consumer portal (example: ENGINEERING/engg_user1) and verify
the IdM logs at <CSA install path>\<Jboss…>\standalone\log\hpcloud-idm-service.log

2014-11-13 16:02:29,731 [http-/0.0.0.0:8444-7] INFO
com.hp.ccue.identity.authn.MultiTenantAuthenticationProvider - Authentication
succeeded for user engg_user1

2014-11-13 16:02:30,786 [AsyncAppender-Dispatcher-Thread-80] INFO
com.hp.ccue.identity.audit.CSAAuditor - Audited event:
{1415923350685:AUTHENTICATION:LOGIN:IDM:engg_user1:ENGINEERING:CSA42-
OO1020:null:Authentication success}

Limitations
Limitations of this implementation are:

l Does not support instance customization like hostname and DNS.

l Supports configuration of CSA IdM to work with single Keystone. Hence, themulti-tenancy feature
is also supported with single Keystone.

l Supports configuration of JSPs to work with only one provider from a given provider type.

Troubleshooting
If the public network selected by subscriber does not have a router interface with the selected private
network, it will fail to associate a Floating IP.

If you already have any subscription using Keystone v2.0, then configuring provider to v3might fail.

If the user wants to create a new Keypair, then, the user needs to select “--Create a new Keypair--”
option from theSelect from existing Keypair dropdown list.

Use case: OpenStack Topology
This section explains how to integrate HP CSA with OpenStack based private cloud environments
such as HP Helion OpenStack and any other OpenStack Cloud.

This implementation includes HP CSA service designs and HP Operations Orchestrations workflows
that can be used to create a service offering for consumers to request andmanage server instance,
block storage volume and network from anOpenStack environment.
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Key features supported by this implementation are:

l Multiple OpenStack Keystone Providers.

l Ability to impersonate a user using IdM Keystone Secondary Authentication.

l Ability to add Scalable Stack of Components in the topology design.

l Following OpenStack topology components:

n OpenStack Server

n OpenStack Volume

n OpenStack Network Interface

n OpenStack Security Group

n OpenStack Floating IP

n OpenStack Private Network

n OpenStack External Network

n OpenStack Router

n OpenStack Load Balancer

n OpenStack Swift Container

The following table lists the contents included in CSA OpenStack Topology Capsule:

Component Name

Service Design OpenStack Basic Compute, Storage and Network

Service Design OpenStack Swift Container

OOContent Pack CSA-OPENSTACK
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Component Name

JSPs csa-openstack-common-v3.jsp

csa-openstack-ext-networks-v3.jsp

csa-openstack-priv-networks-v3.jsp

csa-openstack-subnets-v3.jsp

csa-openstack-routers-v3.jsp

csa-openstack-flavors-v3.jsp

csa-openstack-images-v3.jsp

csa-openstack-keypairs-v3.jsp

csa-openstack-securitygroups-v3.jsp

csa-openstack-zones-v3.jsp

csa-openstack-volume-types-v3.jsp

csa-openstack-swift-storage-policies.jsp

csa-openstack-swift-quota-bytes.jsp

Supported OpenStack API versions
The following table lists the supported Openstack API versions for using this content:

Service Version

Nova (Compute) v2

Keystone (Identity) v3

Neutron (Network) v2.0

Cinder (Block Storage) v1

Glance (Image) v2.0

Swift Object Store v1

Configuration requirements

Complete and test the following configurations before you set up this implementation:
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l Configure HP CSA Cloud ServiceManagement Console andMarketplace Portal.

l Configure providers in HP CSA for OpenStack environment.

l Configure OpenStack environment. It must be operational.

l Configure HP Operations Orchestration. It must be operational.

Configuring service offerings

Configuring organization and catalog

Note: HP recommends setting up separate organizations for eachOpenStack instance and
configure the same LDAP that your Keystone service points to. This is to make sure that the CSA
users in the particular organization are in sync with Keystone users.

To configure organization and catalog:

1. Create Organization

a. Go to Cloud Service AutomationManagement Console > Organization.

b. Click Create Organization and enter the a name of the organization.

2. Configure LDAP

a. Provide LDAP Server Information.

b. Provide LDAP Attributes.

c. Provide User Login Information.

3. Configure Access Control

a. Assign access control to LDAP groups forService Consumer andConsumer Organization
Administrator roles.

4. Configure Catalog Access Control

a. Click Catalog, and then go to the default catalog created for the Organization.

b. Assign Access Control to LDAP groups for accessing the offerings published in this catalog.

5. Configure Environments for Catalog
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a. Associate Environments to the Catalog.

The offerings published in the catalog will be able to only access the providers associated with
the same environment.

Creating resource providers

HP Cloud Service Automation supports Multiple OpenStack Keystone providers. For eachOpenStack
Keystone instance, youmust create a separate resource provider in HP CSA under the OpenStack
provider type.

OpenStack provider type needs the following input fields:

Provider
input field Description

Service
Access
Point

Provide OpenStack identity service API access endpoint:

http://<OS-identity-service-ip or host>:<port>/version

For example:

http://<OS-host>:5000/v3

IdM Secondary Authentication needs Keystone v3.

User ID OpenStack Keystone user, who can be part of multiple tenant or single tenant.

Password Password for Keystone user.

Project Specify the project, which is required for a user who has administrative privileges on
theOpenStack system and can establish trusts for any authorized users during user
login. This field is available for OpenStack providers only.

This is a required field if you want to run the offering in Adminmode (that is, when user
impersonation is not required).

Domain Specify the associated Keystone domain where operations will be performed.

This field is available for OpenStack providers only.

Use domain
scoped
transport
token

Domain scoped transport token will be used if set to true.

To create resource providers, complete the steps in "Creating resource providers" on page 20.

You can see the new providers on theProviders tab.
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Note: If Keystone secondary authentication is enabled in IdM, then creating a provider of type
OpenStack would also save Keystone configuration details in IdM database.

To associate the provider to an environment, click theEnvironments tab, and then select Resource
Environments for the provider.
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Service designs

OpenStack Basic Compute, Storage, and Network

This service design consists of following OpenStack components:

l OpenStack Server

l OpenStack Volume

l OpenStack Network Interface

l OpenStack SecurityGroup

l OpenStack FloatingIP

l OpenStack Private Network

l OpenStack Router

l OpenStack External Network

The following figure depicts the relationship between these components.
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A service offering associated with this design can be used to provision one or more compute instances
attached to the same number of block storage volumes. The compute instances get a private IP
address from a private network and also get a Floating IP address from a public IP pool that is
associated with an external network through a router. Access Control to the Server can be provided by
assigning security groups.

For information about OpenStack topology components, see "OpenStack topology components" on
page 137.

Option model for OpenStack topology designs

Service designer can create an optionmodel to dynamically fetch the values for various component
properties.

It is recommend to create separate option sets for modifiable and non-modifiable properties in the
design.

Modifiable Option Set

Note that none of the OpenStack components in this sample design aremodifiable. However, if a
managed group is present in the design then one can scale-out themembers of the group by modifying
the subscription. This is accomplished by including amodifiable option set (“Modifiable during service
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modification” attribute of option set should be checked) in the design with the only modifiable property
being the instanceCount property of themanaged group.

Note: OpenStack Load Balancer component is also amodifiable component with themodifiable
property being ipAddressList. However, this property gets its value directly from OpenStack
Server components and does not actually need a user input, so do not expose this property in the
Optionmodel. When scale-out operation is performed during subscriptionmodification, the Load
Balancer component will also be scaled-out.

Non-modifiable Option Set

This option set should have 'Modifiable during servicemodification' attribute unchecked.

Content Pack User Guide
OpenStack

HP Cloud Service Automation (4.50) Page 124 of 277



The following table specifies how option properties should be created for a typical design that contains
OpenStack Server, Volume, Network Interface, Security Group, Floating IP, Private Network, Router,
and External Network components. It also suggests the JSPs to be used when the user needs to
select values from a dynamic list:

Property Type
Defaul
t value

JSP (for
Dynamic
LIST) HTTP Parameters Bindings

enableUserC
ontext
(Enable User
Impersonatio
nMode)

Boole
an

True N/A N/A Server.enableUserContex
t,

NetworkInterface.enableU
serContext,

SecurityGroup.enableUser
Context,

PrivateNetwork.enableUse
rContext,

ExternalNetwork.enableUs
erContext
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Property Type
Defaul
t value

JSP (for
Dynamic
LIST) HTTP Parameters Bindings

serverName
Prefix
(Server
Name Prefix)

String Any N/A N/A Server.serverNamePrefix

flavorName LIST
(Dyna
mic)

csa-
openstac
k-flavors-
v3.jsp

providerId=
[PROVIDER:OPENS
TACK:ID]

enableUserContext=
[CLIENT:enableUser
Context]

userId=
[TOKEN:REQ_
USER_ID]

Server.flavorName

imageName LIST
(Dyna
mic)

csa-
openstac
k-images-
v3.jsp

providerId=
[PROVIDER:OPENS
TACK:ID]

enableUserContext=
[CLIENT:enableUser
Context]

userId=
[TOKEN:REQ_
USER_ID]

Server.imageName

Keypair LIST
(Dyna
mic)

csa-
openstac
k-
keypairs-
v3.jsp

providerId=
[PROVIDER:OPENS
TACK:ID]

enableUserContext=
[CLIENT:enableUser
Context]

userId=
[TOKEN:REQ_
USER_ID]

Server.keypair
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Property Type
Defaul
t value

JSP (for
Dynamic
LIST) HTTP Parameters Bindings

securityGrou
p

LIST
(Dyna
mic,
Multi-
Select

csa-
openstac
k-
securitygr
oups-
v3.jsp

providerId=
[PROVIDER:OPENS
TACK:ID]

enableUserContext=
[CLIENT:enableUser
Context]

userId=
[TOKEN:REQ_
USER_ID]

SecurityGroup.securityGro
upNames

availabilityZo
ne

LIST
(Dyna
mic)

csa-
openstac
k-zones-
v3.jsp

providerId=
[PROVIDER:OPENS
TACK:ID]

enableUserContext=
[CLIENT:enableUser
Context]

userId=
[TOKEN:REQ_
USER_ID]

Server.availabilityZone

volumeName
Prefix

String Any N/A N/A Volume.volumeNamePrefi
x

volumeDescr
iption

String Any N/A N/A Volume.volumeDescription

volumeSize
(Volume Size
in GB)

Integer I N/A N/A Volume.volumeSize

volumeType LIST
(Dyna
mic

csa-
openst
ack-
volum
e-
types-
v3.jsp

providerId=
[PROVIDER:OPENS
TACK:ID]

enableUserContext=
[CLIENT:enableUser
Context]

userId=
[TOKEN:REQ_
USER_ID]

Volume.volumeType

volumeDevic
e

String N/A N/A Volume.volumeDevice
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Property Type
Defaul
t value

JSP (for
Dynamic
LIST) HTTP Parameters Bindings

privateNetwo
rk

LIST
(Dyna
mic)

csa-
openst
ack-
priv-
networ
ks-
v3.jsp

providerId=
[PROVIDER:OPENS
TACK:ID]

enableUserContext=
[CLIENT:enableUser
Context]

userId=
[TOKEN:REQ_
USER_ID]

PrivateNetwork.networkN
ame

Subnet LIST
(Dyna
mic)

csa-
openst
ack-
subnet
s-
v3.jsp

providerId=
[PROVIDER:OPENS
TACK:ID]

enableUserContext=
[CLIENT:enableUser
Context]
privateNetwork=
[CLIENT:privateNetw
ork]

userId=
[TOKEN:REQ_
USER_ID]

PrivateNetwork.subnetNa
me

externalNetw
ork

LIST
(Dyna
mic)

csa-
openst
ack-
ext-
networ
ks-
v3.jsp

providerId=
[PROVIDER:OPENS
TACK:ID]

enableUserContext=
[CLIENT:enableUser
Context]

userId=
[TOKEN:REQ_
USER_ID]

providerId=
[PROVIDER:OPENSTAC
K:ID] enableUserContext=
[CLIENT:enableUserCont
ext]
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Property Type
Defaul
t value

JSP (for
Dynamic
LIST) HTTP Parameters Bindings

Router LIST
(Dyna
mic)

csa-
openst
ack-
router
s-
v3.jsp

providerId=
[PROVIDER:OPENS
TACK:ID]

enableUserContext=
[CLIENT:enableUser
Context]
externalNetwork=
[CLIENT:externalNet
work]

userId=
[TOKEN:REQ_
USER_ID]

Router.routerName

OpenStack Swift Container

This service design consists of 'OpenStack Swift Container' component. Container is a logical
component representing an object store.

A service offering associated with this design can be used to provision OpenStack Swift Container
instance. After creating a container in the OpenStack environment, user should be able to see container
details along with Container URL in theMarketplace Portal.

The following table lists the properties that should be created for a typical design that contains
OpenStack Swift Container component and the details required to associate the properties with the
component.
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Property
Typ
e

Defa
ult
value

JSP (for
Dynami
c list) HTTP parameters Bindings

enableUserConte
xt (Enable User
Impersonation
Mode)

Stri
ng

True N/A N/A Container.enableUserCon
text

containerNamePr
efix (Container
Name Prefix)

Stri
ng

Any N/A N/A Container.containerName
Prefix

containerReadAc
cess (Access
Control)

LIS
T

Priva
te

Container.containerRead
Access

storagePolicy
(Storage Policy)

LIS
T

Polic
y-0

csa-
opensta
ck-swift-
storage-
policies.
jsp

providerId=
[PROVIDER:OPENSTA
CK:ID]

Container.storagePolicy

containerQuotaB
ytes (Container
Size)

LIS
T

csa-
opensta
ck-swift-
quota-
bytes.js
p

providerId=
[PROVIDER:OPENSTA
CK:ID]

Container.containerQuota
Bytes

containerQuotaC
ount (Object
Count/Limit)

Stri
ng

NON
E

Container.containerQuota
Count

Publishing service design

To publish the service design, complete the steps in "Publishing topology design" on page 20.

Creating service offering

A service offeringmust be created in HP CSA before subscribers can request services based on this
service design.

To create service offering, complete the steps in "Creating service offering" on page 23.

Publishing service offering to Global Shared Catalog

To publish service offering to Global Shared Catalog, complete the steps in "Publishing service offering
to Global Shared Catalog" on page 23.
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You can also publish the service offering to a specific Catalog defined for a CSA Organization.

Note: HP recommends creating a separate CSA organization for eachOpenStack instance and
configure it to the same LDAP that your Keystone service points to.

Subscribing service
Configuration requirements: Prerequisites

l Create OpenStack providers in HP CSA

l Associate each provider to environments

l Associate all the catalogs that includeOpenStack offerings

The service offerings associated with OpenStack topology components can be executed in two
modes:

1. User Impersonationmode

In this mode, all the subscriptions are fulfilled in the context of the subscriber.

Note: Youmust enable KeyStone in IdM.

For enabling Keystone, set idm.keystone.enabled = true in the file C:\Program
Files\Hewlett-Packard\CSA\jboss-as\standalone\deployments\idm-
service.war\WEBINF\spring\applicationContext.properties.

Steps for subscribing service:

n Log on to theMarketplace Portal as a Keystone user of the desired Organization.

n Select the OpenStack Offering from the specific catalog.

n For the OpenStack Offerings that meet all the requirements specified before, the user will see a
list of providers andOpenStack projects that the user has access to, in the OpenStack
Environment and Provider Selection CSA seededOption Set.

Note: If you select Any Environment or Any Provider in this Environment option, then any
provider and its associated project will be randomly selected. There is no guarantee that all
the JSPs select the same provider or project. Therefore, it is not a recommended choice
for OpenStack dynamic options.
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n After selecting the specific provider:project, where the service needs to be provisioned,set the
enableUserContext to True.

n All the Dynamic Lists will be populated at this point with the values based on the context
selected (Provider, Project and User). Choose the value from each list.

n Specify values for other non-list properties such as Server Name Prefix and VolumeName
Prefix.

n On the right pane, click Checkout.

n Provide a name for the subscription and specify an end date.

n Submit the request.

2. AdminMode (when user impersonation is not desired)

In this mode, all the subscriptions are fulfilled by the user configured in the OpenStack Resource
Provider.

Note: Keystonemay or may not be enabled in IdM for this mode.

Steps for subscribing service:

n Log on to theMarketplace Portal as a Keystone user of the desired Organization.

n Select an OpenStack Offering from the specific Catalog.

n If IdM Keystone is enabled, the user will see a list of provider andOpenStack projects that the
user has access to in the in the OpenStack Environment and Provider Selection CSA seeded
Option Set.
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n If IdM Keystone is not enabled, the user will see a list of OpenStack providers only in the
OpenStack Environment and Provider Selection CSA seededOption Set.

Note: If you select Any Environment or Any Provider in this Environment option, then any
provider and its associated project will be randomly selected. There is no guarantee that all
the JSPs select the same provider. Therefore, it is not a recommended choice for
OpenStack dynamic options.

n After selecting the specific provider where the service needs to be provisioned, set the
enableUserContext to False.

Note: In Adminmode, the project used will be always the one configured in the OpenStack
Resource Provider even if the IdM Keystone is enabled.
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n All the Dynamic Lists will be populated at this point with the values based on the context
selected (Provider, Provider Project, and Provider User). Choose the value from each list.

n Specify values for other non-list properties such as Server Name Prefix and VolumeName
Prefix.

n On the right pane, click Checkout.

n Provide a name for the subscription and specify an end date.

n Submit the request.

Modifying subscription

Service can be scaled in and out by modifying an existing active subscription. Currently CSA 4.50 only
supports scale-out of the service.

1. Click theSubscriptions tab.

2. Identify the OpenStack subscription that you want to modify.

3. Increase the instanceCount property to the desired value. The display namemight be different for
the instanceCount property.

4. Click Modify Subscription.

5. Provide a name for the subscription and specify an end date.

6. Click Submit Subscription.

All themembers of the scaling group will be deployed based on the incremented value of instance
Count. If an OpenStack Load Balancer component exists in the design, then the Load Balancer Pool
will bemodified to add the newly addedmembers.

Canceling subscription

To cancel a subscription, follow the instruction in "Canceling a subscription" on page 24.
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Multi-tenancy support
In HP Cloud Service Automation (HP CSA), an organization is an entity defined by the HP CSA
administrator and can be a company, business unit, department, or group. Membership in an
organization is determined by the organization's identity management configuration, which HP CSA
accesses to authenticate the user's login credentials with OpenLDAP orMicrosoft Active Directory.
The administrator determines amember's entry point into the cloud and associates eachmember with
services and resources.

HP CSA identity management (IdM), apart from the primary authentication with OpenLDAP or
Microsoft Active Directory, supports configuration of secondary authentication with OpenStack Identity
(keystone) service to enable an integration account or transport user to perform OpenStack actions on
behalf of another user. On successful secondary authentication against keystone, IdM generates a
Keystone Trust ID using the authenticated user as the Trustor and the configured integration account
as the Trustee.

OpenStack implements projects as defined by OpenStack technology. A project is a logical grouping of
users, and is used to define quotas and access to virtual machine images.

Multi-tenancy can be implemented by following the three steps below:

1. Enabling Keystone authentication in IDM.

Set idm.keystone.enabled = true in the file C:\Program Files\Hewlett-Packard\CSA\jboss-
as\standalone\deployments\idm-service.war\WEB-
INF\spring\applicationContext.properties.

2. Creating anOpenStack Resource Provider in CSA Management console.

Provide the Service Access Point for Keystone service and the IdM Keystone Integration account
credentials.

Specify following properties for the OpenStack provider:

n Project - Enter the project in OpenStack in which provisioning should occur when provisioning
topology designs in which enableUserContext is set to False for every OpenStack component
in the design. If all OpenStack designs set enableUserContext to True, the Project may be left
empty, and the subscriber will be able to select the project at provisioning time from the set of
projects to which the subscriber is authorized.

n Domain - Enter the domain in OpenStack that should be used. This domainmust be configured
for authentication in the same fashion as the consumer organizations for which this provider
will be used.

n Transport Token -When checked, a domain-scoped transport token will be used for
communication with OpenStack. When unchecked, a project-scoped transport token will be
used. The provider user must have administrative rights on the domain in order to use domain-
scoped transport tokens.
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3. Setup organization in HP CSA with a directory service endpoint: OpenLDAP orMicrosoft Active
Directory that is also configured in the OpenStack Keystone instance.

Mapping CSA organizations LDAP to LDAP of OpenSTack Keystone instance and identity
management secondary authentication with Keystone ensure that all subscription requests from
organization users are fulfilled in the context of user and the selected project.

In general, this feature works as follows:

1. Following a successful authentication against one of the primary mechanisms (LDAP, Active
Directory), IdM attempts to authenticate against a secondary mechanism (Keystone) using the
same credentials to Keystone service.

2. On successful authentication against Keystone, generates a Keystone trust IDs using the
authenticated user as the trustor and the configured integration account (provider user) as the
trustee, for all the OpenStack project that the user has access to.

3. As needed, choose one of the project and associated Keystone trust ID and use it to generate a
Keystone impersonation token so that provider account configured can perform OpenStack
actions on behalf of the trustor.

Content Pack User Guide
OpenStack

HP Cloud Service Automation (4.50) Page 136 of 277



Verifying secondary authentication

For information about Verifying secondary authentication, see "Verify secondary authentication" on
page 116.

Setting up attached volume
For information about setting up attached volume, see "Set up an attached volume" on page 112.

OpenStack topology components
The following table lists the common Input parameters for all Operations for all OpenStack Topology
components

Parameter name Description Mapping type

identityServiceendpoint trustId Provider property
URI

identityServicePassword Password for transportUser or Admin user in
keystone

Provider property
URI

identityServiceUsername transportUser or Admin user in keystone Provider property
USERNAME

tenantName Keystone project for transport User or Admin
user

Provider property
project

enableUserContext Flag to enable user context mode. Default –
false

Component property

domainName Keystone domain for transport User or Admin
user. Default value – default

Provider property
domain

trustId Keystone trustId for project selected,
admin/transport user as trustee and subscriber
as trustor

Context token –
KEYSTONE_
TRUST_ID

OpenStack External Network

A network already defined in OpenStack, defined as an external network. This is usually where the
servers access the public internet. Public IP pools are allocated through this network.
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Properties

Parameter name Description

externalNetworkName External Network Name

Operations

Validate External Network – This is the deploy operation for the component.

It validates the existence of the external network and gets back as output the internal id of the network.

OpenStack Private Network

AnOpenStack network that is not defined as external network. It is responsible for providing IP
addresses to Servers/Ports from a Subnet. Servers within the same private network are directly
accessible to each other.
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Properties

Parameter name Description

networkName Private Network Name

createNetwork Flag to specify whether to create a new network or use an existing one

subnetName Subnet Name

subnetDescription Subnet Description

createSubnet Flag to specify whether to create a new subnet or use an existing one.

ipVersion The IP version. Valid values:IPV4 or IPV6. Must be specified if
createSubnet=true

enableDHCP Set to true if DHCP is enabled for the subnet and false if DHCP is disabled.
Must be specified if createSubnet=true

disableGateway When set to true, the subnet will be created without a gateway IP address.
Otherwise the default IP Address will be used. Can be specified if
createSubnet=true

dnsServers Comma separated list of DNS server host names or IP address. Example:
16.17.18.19,15.16.17.18. Can be specified if createSubnet=true.

Content Pack User Guide
OpenStack

HP Cloud Service Automation (4.50) Page 139 of 277



Parameter name Description

cidrNetworkAddress Network Address in CIDR format <startingIpAddress:maskSize>.
Examples: 10.0.0.1/24, 192.168.0.1/24, 2001:DB8::/48. Must be specified if
createSubnet=true

Operations

l Create Network and Subnet – This is the deploy operation for the component.

n It allows to choose an existing private network and one of its associated subnets.

n A private network and subnet can also be created by setting the flag createNetwork and
createSubnet to true.

n For creating a new subnet, a cidrNetworkAddress must be provided to select the IPs from. A
subnet may optionally have a gateway and a list of DNS name servers.

l Deploy Private Network Failure Handler – This is the deploy failure handler for the component.

It will rollback the operations performed during the deploying phase of the component. If a new private
network or subnet was created during the deploy operation, they will be deleted when this operation is
executed.

l Delete Network and Subnet – This is the undeploy operation for the component.

It will de-provision any new network or subnet created.

OpenStack Router

A virtual router, which can either be referenced or created for the design service instance. Router is
used to NAT internal traffic to external networks. It has an interface for each subnet it is associated
with and the IP address of such interface is the subnets gateway IP.

Relationships
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Properties

Parameter name Description

createRouter Flag to specify whether to create a new router or user an existing one

routerName routerName

externalNetworkId External Network Id of the external network to which router is connected

Operations

l Create Router – This is the deploy operation for the component.

n It allows to use an existing router.

n A router can also be created if createRouter flag is set to true.

n It also creates an internal interface for the attached private network subnet if it does not exist. If
the default gateway IP is used the interface creation errors out.

l Deploy Router Failure Handler – This is the deploy failure handler for the component.

It will rollback the operations performed during the deploying phase of the component. If a new
router or an interface is created for the subnet, they will be deleted when this operation is executed.
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l Delete Router - This is the undeploy operation for the component.

It will de-provision any new router and its associated interface. The interface cannot be deleted if
there are associated floating IPs.

OpenStack Floating IP

A Floating IP is an IP address on an external network, which is associated with a specific port, and
optionally a specific IP address, on a private network. A Floating IP allows access to an instance on a
private network from an external network.

Relationships

Properties

Parameter name Description

externalNetworkId External Network pool from which the Floating IP needs to be fetched or
created.

Operations
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l Deploy Floating IP

n It will either fetch a floating IP from a public pool or create a new floating IP on that pool, if none
exists. This depends on the existing network connectivities to allow this. For example: an
external network exists and is accessible to the user and the private network/subnet for the
server is routable to external network.

n If the externalNetworkId is invalid, then the operation will fail. If a null value is provided the
operation will use any existing external network in OpenStack

l Deploy Floating IP Failure Handler

It will delete any floating IP that got created during deploy operation.

l Undeploy Floating IP

It will delete any floating IP that got created during deploy operation.

OpenStack Security Group

Security groups and security group rules allows administrators and tenants the ability to specify the
type of traffic and direction (ingress/egress) that is allowed to pass through a port. A security group is a
container for security group rules.

Relationships

Properties
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Parameter name Description

createSecurityGroup Flag to specify whether to create a new security group or user existing ones.

securityGroups Names of Security Groups to be added to the server.

securityGroupPortList Comma separated port list to be opened on server for incoming traffic (for
example, 22,80,8000-9000). Must be provided if createSecurityGroup is
true.

Operations

l Deploy Security Group

n It allows to use one or more existing security groups.

n A new security group can be also be created by setting createSecurityGroup to true. Onemust
specify the securityGroupPortList in case of creating a new security group. An Ingres rule will be
created with protocol type as TCP

l Deploy Security Group Failure Handler

Any new security group created during deploy operation will be deleted

l Undeploy Security Group

Any new security group created during deploy operation will be deleted

OpenStack Network Interface

AnOpenStack Network Interface component represents a virtual switch port on a logical network
switch. Virtual instances attach their interfaces into ports. The logical port also defines theMAC
address and the IP address(es) to be assigned to the interfaces plugged into them. When IP addresses
are associated to a port, this implies the port is associated with a subnet, as the IP address was taken
from the allocation pool for a specific subnet.
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Relationship

Properties

Parameter name Description

networkId Private network ID

subnetId Subnet ID

floatingIpId Floating IP ID

securityGroupIds Security Groups ID

Operations

l Deploy Network Interface

n A network port will be created on the subnet with a fixedIP

n Floating IPs are assigned to the port

n Security Groups are assigned to the port

l Deploy Network Interface Failure Handler

Network port will be deprovisioned

l Network port will be deprovisioned

Network port will be deprovisioned.
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OpenStack Server

Server is a logical topology component that represents a virtual machine in OpenStack cloud. Virtual
machines are cloned from pre-configured images.

Relationships

Capabilities

OpenStack Server component supports Server capability with following parameter mappings:

Capability property Component property

Hostname serverName

instanceId serverId

ipAddress sshEnabledIpAddress

Password Password

privateKey privateKey

Username Username

Input properties
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Parameter name Description

availabilityZone Availability Zone in which server will be provisioned

flavorName Identifies the sizing of the server

imageName Name of the image to be used to create the servers

keypairName Keypair Name to associate with server for accessing it

serverNamePrefix Beginning characters of host name

portIds Port IDs to be associated with the Server

Username Username for logging into the server

Password Password for logging into the server

privateKey privateKey associated with the keypair

Output properties

Parameter name Description

Disk Disk size

floatingIPAddress Floating IP Address List with the network name

IPAddressList Private IP Address List with network name

Memory Memory

securityGroups Security Group List

serverId Server ID

serverName Server Name

serverStatus Server Status

sshEnabledIpAddress Server Status

Operations

l Deploy Server

n Provisions virtual machines using OpenStack Nova APIs.

n Virtual Machines are launched using specified image, flavor (CPU/RAM/DISK) and Keypair.

n Virtual Machines will be associated with one or more network interface (ports) which in turnmay
also have floating IPs and security groups.

l Deploy Server Failure Handler
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Rolls-back the operations performed during deployment. It will de-provision OpenStack virtual
machine.

l Undeploy Server

De-provisions OpenStack virtual machine.

Public actions

l Add Security group

Adds a new security group to the fixed IP (private IP) associated with a specific port. The security
group should already exist in OpenStack project.

Input parameters:

Parameter Name Description

securityGroupInput Name of the security group to be added

fixedIpInput Fixed IP (private IP) Address. (Can be found in ipAddressList)

l Remove Security Group

Removes security group from the fixed IP.

Input parameters:

Parameter Name Description

securityGroupInput Name of the security group to be removed

fixedIpInput Fixed IP (private IP) Address. (Can be found in ipAddressList

l Associate Floating IP

n Associates a floating IP to a fixed IP. The floating IP is fetched from a public pool.

n If no floating IP is available in the pool, a new floating IP is allocated to the pool and associated
with the fixed IP.

n If a floating IP already exists for the fixed IP then floating IP not assigned again, since only one
floating IP can be associated for a fixed IP.

Input parameters:
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Parameter Name Description

externalNetworkInput External Network Name

fixedIpAddressInput Fixed IP (private IP) Address. (Can be found in ipAddressList)

l Disassociate Floating IP

Dis-associates a floating IP from the server

Input parameters:

Parameter Name Description

floatingIpInput floatingIpInput (can be found in floatingIpAddress)

l Start Server

Starts a stopped Server

l Stop Server

Stops a running active server

l Suspend Server

Suspends (stores state of the VM on disk) a server and changes its status to SUSPENDED

l Resume Server

Resumes (restores state of VM from disk) a SUSPENDED server and changes its status to
ACTIVE

l Pause Server

Pauses a server and changes its status to PAUSED

l Unpause Server

Unpauses a PAUSED Server

l Refresh Server Info

Refreshes Server Status, Floating IP Addresses, Security Groups onMPP

l Soft Reboot Server

The operating system is signaled to restart, which allows for a graceful shutdown of all processes

l Hard Reboot Server
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Equivalent to power cycling the server

OpenStack Load Balancer

Load balances pools are virtual machines with haproxy installed on them. They are used to balance
application running on specified port on various server connected to the same subnet as the load
balancer pool.

Note: This component is not supported if the version of HP Helion OpenStack is less than or equal
to 1.1

Note: OpenStack Load Balancer is amodifiable component with themodifiable property being
ipAddressList which gets adjusted after a scale-in/scale-out operation.

Relationships

Properties

Parameter name Description

poolName Load Balancer pool name

poolDescription Load Balancer pool description
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Parameter name Description

subnetId Subnet connected to the pool

lbMethod Load BalancingMethod. Valid Values: ROUND_ROBIN, LEAST_
CONNECTIONS, SOURCE_IP. Default: ROUND_ROBIN

lbProtocol Protocol used for load balancing an application. Valid Values: HTTP,
HTTPS, TCP. Default: HTTP

lbPort Port on which the application to be load balanced in running. Default: 80

vipName Virtual IP Name

vipDesc Virtual IP description

addHealthMonitor Flag to specify if you want to add a health monitor to the load balancer
pool. Default: false

hmType Specify the type of health monitoring. Valid Values: PING, HTTP,
HTTPS, TCP. Default: PING

hmDelay Theminimum time in seconds between regular checks of amember.
Default: 20

hmTimeout Themaximum time in seconds for amonitor to wait for a reply. Default: 10

hmRetries Number of permissible failures before changing the status of amember to
inactive. Value range: 1-10. Default: 3

hmHttpUrlPath URL path for monitoring. Default: /

hmHttpExpectedCodes Comma separated list of expected HTTP codes upon successful
monitoring. Default: 200,201,202

ipAddressList IP Address List of the servers that need to be load balanced

Operations

l Deploy Load Balancer

n Creates a load balancer pool using OpenStack LBaaS. The pool will be created on the specified
subnet.

n Creates and associates a Virtual IP to the pool.

n Adds a health Monitor if addHealthMonitor flag is true.

n Adds all the servers IPs as members to the pool that are in the same subnet as the pool.

l Deploy Load Balancer Failure Handler
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n Removes all themembers from the pool, if already added in deploy operation.

n Deletes the VIP from the pool.

n Deletes any health monitor if added.

n Deletes the pool.

l Undeploy Load Balancer

n Removes all themembers from the pool.

n Deletes the VIP from the pool.

n Deletes any health monitor if added.

n Deletes the pool.

l Modify Load Balancer

n If a scalable group containing OpenStack Server is scaled-out via subscriptionmodification, the
new added server will be added to the Load Balancer pool.

n If a scalable group containing OpenStack Server is scaled-in via subscriptionmodification, the
un-provisioned servers will be removed from the Load Balancer pool.

Note: Currently CSA 4.5 only supports scale-out operation.

l Modify Load Balancer Failure Handler

This will roll-back the scale-in or scale-out operations performed on Load Balancer pool during
modification.

l Unmodify Load Balancer

This will roll-back the scale-in or scale-out operations performed on Load Balancer pool during
modification.

OpenStack Volume

Represents a persistent store and not the boot or ephemeral volumes. A Server can havemultiple
Volumes attached to it.
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Relationships

Properties

Parameter name Description

availabilityZone Availability Zone in which volumewill be provisioned.

serverId ID of Server to which Volumewill be attached

volumeNamePrefix Beginning characters of volume name.

volumeDescription Volume description.

volumeType Volume Type.

volumeSize The size, in gigabytes, for the new volume.

volumeDevice The device file on the server which the volume is presented as. Example:
/dev/sdf

Operations

l Deploy Volume

n Creates a storage volume of specified volumeType in the same availability zone as server.

n Attaches the volume to the related server.

l Deploy Volume Failure Handler
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n Detaches the volume from the server

n Deletes the volume

l Undeploy Volume

n Deletes any snapshots for the volume

n Detaches the volume from the server

n Deletes the volume

Public actions

l Create Snapshot

Creates Snapshot for Volume

Creates a list of snapshot names and ids as output of this operation.

Parameter name Description

snapshotNameInput Snapshot Name

snapshotDescInput Snapshot Description

l Delete Snapshot

Deletes Snapshot for Volume

Parameter
name Description

snapshotIdInput Snapshot Id which needs to be deleted. Youmay get the snapshot id from the
snapshotIds list property of the component

OpenStack Swift container

TheOpenStack Object Store known as swift, offers cloud storage software to store and retrieve lots of
data with a simple API. Swift is a highly available, distributed, eventually consistent object/blob store.
Organizations can use swift to store lots of data efficiently, safely, and cheaply.

Swift Object Storage is ideal for cost effective, scale-out storage, and storing unstructured data that
can grow without bound. It provides a fully distributed, API-accessible storage platform that can be
integrated directly into applications used for backup, archive, and data retention.

This section describes how to integrate HP CSA with OpenStack Swift Object Storage. From this
content pack, the solution provides a topology service design to provision a Swift Container with
needed options and public actions tomanage the container’s lifecycle.

Properties
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Parameter name Description

containerName Name of the OpenStack Swift Container.

containerNamePrefix Prefix for the container names. If specified, this overrides the container
name and is used to generate container names along with UUID. This is
also the input to be used with scaled services.

containerQuotaBytes Container Quota Size in Bytes.

containerQuotaCount Container Object Quota Count.

containerReadAccess Container Read Access Control, which could be either Private or Public.

storagePolicy Storage Policy for the Container, as defined in Swift.

enableUserContext EnableMulti-Tenant Support, is of type Boolean defaulting to false. If set to
true, then CSA andOpenStack must be using the same identity store.

Public actions

l Disable Versioning

Disables Object versioning on the container

l EnableVersioning

Enables Object versioning on the container. This operation needs another container with appropriate
access where the older version objects can be stored.

l Make Private

Sets read access for the container to Private

l Make Public

Sets read access for the container to Public

l Refresh Container info

Gets the latest container information

Limitations
This implementation does not support instance customization like hostname and DNS.
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Known issues

l If the public network selected by subscriber does not have a router interface with the selected
private network, it will fail to associate a Floating IP.

l The public action (Detach Volume) that is triggered immediately after an 'Attach Volume' might fail.
It takes few minutes to update in OpenStack portal.

Troubleshooting
If the public network selected by subscriber does not have a router interface with the selected private
network, it will fail to associate a Floating IP.
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Provider Go Active
This section provides an overview about Provider Go Active solution and how to use it to verify
providers configured in HP CSA.

Use case: Verify provider communication (CSA
Provider Go Active)
Provider Go Active solution helps HP CSA administrators to select a particular provider configured in
the environment and run a test to verify its communication by using provider configuration. Provider
configuration includes provider username, password, service access point and any provider properties
as per the provider requirements.

Administrator can navigate to the provider specific subscription and run the test again. Administrator
can also create new subscription as and when new providers are added to the environment to verify the
same.

Solution is extensible because all the provider list is dynamically fetched. Administrator can select any
of the provider from the list. If the specific provider verification is not supported, subscription goes
online with the status NOT SUPPORTED. When the support gets added at the backend, use public
actions to rerun the test.

Log on toMarketplace Portal and follow the steps to subscribe service.

To run the test, select the resource provider:
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If the provider communication test run is successful, the subscription details will be shown as in the
following figure:

In case the provider communication test run fails, the subscription details will be shown as in the
following figure:

If the specific provider verification is not supported, the subscription details will be shown as in the
following figure:
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High level solution diagram of Provider Go Active is depicted below:
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Service design
To verify the resource provider communication, use the following service design:

Service design Description

Provider Communication Test Provider Communication Test

Creating service offering
To create a service offering, complete the steps in "Creating service offering" on page 23.

Publishing service offering to Admin only catalog
This solution helps administrators to verify providers. So, this service offering needs to be published to
the appropriate Admin only catalog.

To publish a service offering to the Admin only catalog:

1. Log on to the Cloud ServiceManagement Console as an administrator.

2. Click Catalogs.

3. Click CSA Admin Catalog.

4. Click theOfferings tab.

5. Click Add Offering.

6. Select the service offering you created in the previous steps, and then click Select.

7. Select the category under which this service offering should appear in theMarketplace portal.

8. Click Publish.

Subscribing service
To subscribe service, complete the steps in "Subscribing service" on page 24.

Canceling a subscription

To cancel a subscription, complete the steps in "Canceling a subscription" on page 24.
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HP Server Automation
HP Server Automation automates operations and processes across IT teams and systems.

For information about how HP SA deploys software policies to the provisioned server, see "Use case:
HP Server Automation software policies deployment on vCenter Compute " on page 229.

Installing HP Server
HP Server Automationmust be installed and configured before you can use it to deploy applications.
For installation instructions, see theHP Server Automation Simple/Advanced Installation Guide on
HP Software Support.

Configuring HP Server Automation Software Policies
HP Server Automationmust be installed and configured before you can use it to deploy applications.
See theHP Server Automation Simple/Advanced Installation Guide on HP Software Support for
information about setting permissions.

You can find the steps required to prepare a clone template in vCenter in theHP Cloud Service
Automation Configuration Guide on HP Software Support.

Prerequisites

l Prepare a VM template. For instructions, see theHP Cloud Service Automation Configuration
Guide on HP Software Support.

l OO-SA content pack 1.2.0.001must be installed in Operations Orchestration 10.21.
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HP Service Manager

Use case: HP Service Manager as an external approval
system (Sequenced)
This section explains how to use HP ServiceManager as an external approval system.

Installing HP Service Manager
Install HP ServiceManager according to themanufacturer's recommendations. For version
requirements, seeHP Cloud Service Automation System and Software Support Matrix at HP Software
Support.

Installation notes:

l Do not install HP ServiceManager on the same system where HP Operations Orchestration is
installed. HP ServiceManager and HP Operations Orchestrationmust run on separate systems.

l Calculate the resources needed for the HP ServiceManager server using the information provided
in theHP ServiceManager Interactive Installation Guide on HP Software Support.

HP Service Manager account prerequisites

l HP ServiceManager integration account must have enough privilege for creating change tickets in
HP SM changemodule (example account: falcon or System.Admin).

l An operator in HP ServiceManager must have the privilege to approve or deny the created change
request ticket (example account:Change.Approver).

l After the operator makes decision about the SM change tickets, the HP CSA workload will be
approved or denied.

l HP ServiceManager has to be configured with LDAP (Active Directory).

Configuring HP Service Manager
The following steps must be completed to configure HP ServiceManager:

Step 1: Import the HP CSA integration file into HP Service Manager
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Importing the HP CSA integration file into HP ServiceManager creates the OO_CSA and
WSCentralServiceService script libraries andOnChangeApproval andOnChangeDeniedmacros.

1. Log on to the HP ServiceManagerWindows client using the Falcon account or another account
with administrator privileges.

2. From the System Navigator, click Connection > Tailoring > Database Manager or enter db in
the commandwindow and click RUN.

3. Click Import/Load.

4. Locate the HPSM_CSA_Integration_file.unl file installed with HP CSA.

The default location of the file is %CSA_HOME%\Tools\CSLContentInstallerwhere %CSA_HOME%
is the directory, where HP Cloud Service Automation is installed (for example, C:\Program
Files\Hewlett-Packard\CSA).

If HP CSA and HP ServiceManager are installed on different systems, copy this file to the
system running HP ServiceManager.

5. Click Load FG.

Step 2: Verify the installation of the script library and macros

1. Log on to the HP ServiceManagerWindows client using the Falcon account or another account
with administrator privileges.

2. Enter unload in the commandwindow and click RUN. Verify that the HPSMCSA Integration file
is listed.

3. From the System Navigator, click Connection > Tailoring > Script Library.

4. Verify that theOO_CSA script library exists. In theName field, typeOO_CSA, and click Find.

5. Verify that theWSCentralServiceService script exists. In theName field, type
WSCentralServiceService, and click Find.

6. Validate the credentials for the HP Operations Orchestration Central server. View theOO_CSA
script and validate the values for centralUser and centralPassword. Edit the script and update
these values if they are not set to the correct credentials. After updating a value, click Save.

7. Update the URL for the HP Operations Orchestration Central server. View theOO_CSA script
and update the value for centralURL. Replace localhost with the hostname of the HP Operations
Orchestration Central server. Click Save.

8. From the System Navigator, click Connection > Tailoring > Tailoring Tools >Macros.

9. Verify the OnChangeApproval andOnChangeDeniedmacros exist.

Step 3: Modify the approval definition
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Update the sample Approval Definition provided with HP ServiceManager to create a new subscription
approval.

1. Use the HP ServiceManager unload tools to back up the sample Approval Definition.

2. Log on to the HP ServiceManagerWindows client using the Falcon account or another account
with administrator privileges.

3. From the System Navigator, click Connection > Change Management >Maintenance >
Approvals.

4. Search for the Subscription Approval. In theName field, typeSubscription Approval, and then
click Find.

5. Verify or set the following fields and values:

Field name Value

Name Subscription approval

Approval Condition true

Approval Type All must approve

Group/Oper Change.Approver

Sequence 1

Condition true

6. Click Save.

Step 4: Enable SSL between HP Service Manager and HP Operations Orchestration

1. Create a self-signed certificate using the fully-qualified domain name of the system onwhich HP
Operations Orchestration is installed to replace the existing HP Operations Orchestration Central
server certificate.

Note: If the existing HP Operations Orchestration Central server certificate uses a CN with
the fully-qualified domain name of the system onwhich HP Operations Orchestration is
installed, you do not need to create a self-signed certificate. You can use the existing HP
Operations Orchestration Central server certificate.

Refer to Replacing the Central SSL/TLS Server Certificate with a Self-Signed Certificate section
in theSystem Configuration and Hardening Guide (a copy of this guide can be found in
%ICONCLUDE_HOME%\docs\Configuration and Hardening Guide.pdf or $ICONCLUDE_
HOME/docs/ConfigurationandHardeningGuide.pdf).

2. Export HP Operations Orchestration's SSL certificate. On the system onwhich HP Operations
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Orchestration is installed, open a command prompt and type the following:

Windows

cd "%ICONCLUDE_HOME%"

.\java\bin\keytool -export -alias tomcat -file pas.crt -keystore

.\Central\var\security\key.store -storepass changeit

Linux

cd $ICONCLUDE_HOME

./java/bin/keytool -export- -alias tomcat -file pas.crt -keystore

./Central/var/security/key.store -storepass changeit

3. Copy pas.crt to the system onwhich HP ServiceManager is installed, to the <HPSM_install_
directory>\Server\RUN\jre\lib\security (Windows) or <HPSM_install_
directory>/Server/RUN/jre/lib/security (Linux) directory.

4. On the system onwhich HP ServiceManager is installed, import the HP Operations Orchestration
certificate. Open a command prompt and type the following:

Windows

cd "<HPSM_install_directory>\Server\RUN\jre\lib\security"

"<HPSM_install_directory>\Server\RUN\jre\bin\keytool.exe" -importcert -alias
tomcat -file pas.crt -keystore cacerts -storepass changeitgeit

Linux

cd <HPSM_install_directory>/Server/RUN/jre/lib/security

<HPSM_install_directory>/Server/RUN/jre/bin/keytool.exe -importcert -alias
tomcat -file pas.crt -keystore cacerts -storepass changeit

Step 5: Map the fully-qualified domain to the IP of the system on which HP Operations
Orchestration is installed

WhenHP ServiceManager accesses HP Operations Orchestration as a client, the HP Operations
Orchestration certificate uses a hardcoded key for the CN. On the system running HP Service
Manager, this CN (the fully-qualified domain name (FQDN) of the system onwhich HP Operations
Orchestration is installed) must bemapped to the IP address of the system onwhich HP Operations
Orchestration Central server is installed. The following is an example of how tomap the CN to the IP
address:

1. On the system running HP ServiceManager, open C:\Windows\system32\drivers\etc\hosts
(Windows) or /etc/hosts (Linux) in a text editor.

2. Add the following to the file:
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<IP_address_of_HPOO_central_server> <FQDN>

where <IP_address_of_HPOO_central_server> is the IP address of the system onwhich HP
Operations Orchestration Central server is installed and <FQDN> is the fully-qualified domain
name of the system onwhich HP Operations Orchestration Central server is installed.

3. Save and close the file.

Configuring SM OO system properties
Configure the following system accounts and properties:

OO System Account

HPCSA_SERVICEMANAGER_CREDENTIALS - configure it with ServiceManager system
credentials

OO System Properties

HPCSA_ServiceManager_Host - ServiceManager Host/IP Address

HPCSA_ServiceManager_Port - ServiceManager service port

HPCSA_ServiceManager_Protocol - ServiceManager service access protocol

HPCSA_ServiceManager_Version - Target ServiceManager version "9.30" or "9.3x"

Configuring external approval
To configure external approval, complete the following steps:

1. Log on to the HP CSA Management Console as an administrator.

2. Click theService Catalogs tab.

3. Select the catalog that you want to use or create new one.

4. Click Approval Policies.

5. Click Add Approval Policy at the bottom of the screen. TheAdd Approval Policy dialog will
open.

6. Enter a name for the policy and select Delegated template for the approval template. The
Process Definition field will be displayed.

7. Select SM Initiate Request Approval for the process definition.

8. Click Save Changes.
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9. Return to the Service Catalog, and click Published Offerings.

10. Add a new offering or edit an exist offering.

11. Set the approval process toActive, and select SM Initiate Request Approval for the approval
policy again.

12. Save the offering.

Configuring HP SM LDAP (Active Directory) integration
To configure LDAP for HP SM, complete the following steps:

1. Create a new HP CSA Consumer user in the Active Directory server to request a change ticket
(for example: consumer).

2. Log on to the HP SM client as an administrative user such as falcon or System.Admin.

3. In HP SM, create a new power user with the same name created for the HP CSA Consumer user
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in Active Directory (consumer) by cloning an administrator account such as falcon.

4. Click Connection > System Administration > Ongoing Maintenance > System > LDAP
mapping.

5. Enter values for the following:

a. LDAP Server: IP Address of LDAP server

b. LDAP Port: 389

c. LDAP Base Directory: CN=Users,DC=CSA,DC=COM (This is sample data)

6. Click Save.

7. Click Set File/Field Level Mapping and in the Name field, enter 'operator'.

8. Click Search.

9. Check the fields mentioned in step 5 tomake sure that the entries are correct on the <HP Service
Manager LDAP Mapping - File/Field Level Specifications > page.

10. In the Field Name/LDAP Attribute Name table, make sure that you have value CN for the NAME
field in the Field Name column.

11. Edit sm.ini, which is located in <HPSM install directory>\Server\RUN\ and include the following
properties:

a. ldapauthenticateonly:1 ldapnostrictlogin:1

b. ldapbinddn:CN=Administrator,CN=Users,DC=CSA,DC=COM ldapbindpass:password

c. ldapdisable:0 ldapstats:1

12. Restart the HP SM server.

Now you should be able to log on to HP ServiceManager using an LDAP user and password.

HP SM execution order
To approve or deny the HP SM change request ticket:

1. Log on to the HP CSA Consumer Portal as the user, who has privileges to create a service
request.

2. Request the service offering that youmodified in the "Configuring external approval" section.
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3. Log on to HP ServiceManager using an account which has privilege to approve or deny the
created change request ticket (example account: Change. Approver)

4. Click Approval inbox from themenu navigator, check the request related change tickets that
have been created and are waiting for approval.

5. Click Approve orDeny to make a decision on this request.

The subscription will not be created until the approval has beenmade. HP CSA deploys the
approved subscription requests.

Limitation
To request the HP CSA subscription, HP CSA Consumer user should be created both in HP Service
Manager and HP CSA. That is, the user type 'consumer' should be present both in HP CSA and HP
Servicemanager.
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HP SiteScope and HP Universal CMDB
HP SiteScope is an agentless monitoring software focused onmonitoring the availability and
performance of distributed IT infrastructures, including Servers, Network devices and services,
Applications and application components, operating systems and various IT enterprise components.

For information about how the VMware vCenter server is monitored using Sitescope and configured
using UCMDB, see "Use case: Monitoring and configurationmanagement using vCenter Compute" on
page 223.

Installing HP SiteScope
Install HP SiteScope to the correct version and patch level. SeeHP Cloud Service Automation System
and Software Support Matrix for version requirements.

Installation notes:

l Do not install HP SiteScope on the HP Operations Orchestration server. It must be on its own
server.

l Calculate the resources needed for the HP SiteScope server using the information in the HP
SiteScope documentation. This calculation should include the number of target servers that you
expect HP CSA tomonitor.

l During installation, you can change the port for the HP SiteScope service to avoid potential
conflicts with other web servers that use the default port value of 8080. Select any available port on
the system and keep track of the port number that you select.

HP software product documentation is available on HP Software Support.

Configuring HP SiteScope
The following tasks are required to configure HP SiteScope to integrate successfully with HP CSA:

l Enable HP CSA to configure HP SiteScopemonitors

l Auto-Deploy the HP CSA templates and credential profiles

l Manually import additional HP CSA templates

l Configure HP CSA credential profiles

l Configure HP SiteScope administrator credentials

Step 1: Enable HP CSA to configure HP SiteScope monitors
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HP SiteScope is installed with a default secured API calls required for configuringmonitors. HP Cloud
Service Automation does not support secured API calls; therefore, youmust change this setting. To re-
configure HP SiteScope so that it does not use secure APIs, youmust make the following changes to
the configuration:

1. Stop the HP SiteScope service by executing the following command in a console window:

net stop SiteScope

2. Open the HP SiteScope <sitescopeInstallDir>\groups\master.config file in a text editor.

3. Change the _accessControlled=true property value to _accessControlled=false.

4. Restart the HP SiteScope service by executing the following command in a console window:

net start SiteScope

Step 2: Auto-deploy the HP CSA templates and credential profiles

1. Log on to the HP SiteScope server as an administrator.

2. Log on to the HP CSA server.

3. From the HP CSA server, copy the %CSA_HOME%\CSAKit-4.5\Lib\sitescope\CSA templates
autoimport.tmpl file to the <sitescopeInstallDir>\persistency\import directory on the HP
SiteScope server (where %CSA_HOME% is the directory in which HP CSA is installed).

4. Log on to the HP SiteScope Dashboard.

5. Select the Templates context. In the template tree, look for the CSA templates container. You
must wait for the HP SiteScope server to finish processing the CSA templates
autoimport.tmpl file before the CSA templates template container is displayed.

6. Select Preferences context > Credential Preferences and look for theWINDOWS-CSA-
TARGETS and LINUX-CSA-TARGETS credential profiles, which you will configure in step 4:
Configure HP CSA Credential Profiles.

Step 3: Manually import additional HP CSA templates

Two additional HP CSA templates, CSA templates Silver and CSA templates Gold, must bemanually
imported.

1. Log on to the HP SiteScope Dashboard.

Note: Youmust be able to access files in the%CSA_HOME%\CSAKit-4.5\Lib\sitescope
directory from the HP SiteScope Dashboard. If necessary, copy this directory to the system
from which you are launching the HP SiteScope Dashboard.

2. Select Templates.
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3. In the template tree, right-click SiteScope and select Import.

4. Browse to %CSA_HOME%\CSAKit-4.5\Lib\sitescope (or the directory to which this directory was
copied) and import CSA templates Silver.tmpl.

5. Repeat steps 3 and 4, but import CSA templates Gold.tmpl.

Step 4: Configure HP CSA credential profiles

Configure the credentials used to log on to every Windows system and every Linux systemmonitored
by HP SiteScope. The credentials for all Windows systems must be the same. Likewise, the
credentials for all Linux systems must be the same.

1. Log on to the HP SiteScope Dashboard.

2. Select Preferences > Credential Preferences.

3. Edit the LINUX-CSA-TARGETS credential profile and supply login credentials for your Linux
environment.

4. Edit theWINDOWS-CSA-TARGETS credential profile and supply login credentials for your
Windows environment.

Step 5: Configure HP SiteScope administrator credentials

Configure the credentials used to log in as the administrator of HP SiteScope. These credentials are
used by HP CSA when configuring HP SiteScope resource providers from the Cloud Service
Management Console.

1. Log on to the HP SiteScope Dashboard.

2. Select Preferences > User Management Preferences.

3. Right-click SiteScope Administrator and select Edit User.

4. If not already specified, enter a login name and password for the SiteScope administrator

Installing HP Universal CMDB
Install HP Universal CMDB (HP UCMDB) to the correct version and patch level. If you are using an
existing installation of HP UCMDB, then you should verify that the necessary patches and updates
have been applied. See HP Cloud Service Automation System and Software Support Matrix for version
requirements.

If you are installing HP UCMDB, then you should follow the installation instructions in the HP UCMDB
documentation on HP Software Support and then follow the instructions presented here to configure
your installation.

To start the HP UCMDB Server service:
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1. Click Start > All Programs > HP UCMDB > Start HP Universal CMDB Server.

2. Monitor the service status by browsing to http://localhost:8080/status.

You will need to wait until the Default Client status is up on the status page. This takes
approximately fiveminutes. Until then, the HP UCMDB console cannot be used.

HP software product documentation is available on HP Software Support.

Configuring HP Universal CMDB
To configure HP UCMDB, deploy a file to your HP UCMDB server:

1. Log on to the HP CSA server.

2. From theHP CSA server, navigate to the %CSA_HOME%\CSAKit-4.5\Lib\ucmdb folder where
%CSA_HOME% is the directory in which HP CSA is installed.

3. Copy the %CSA_HOME%\CSAKit-4.5\Lib\ucmdb\CSAIntegration.zip file to the HP UCMDB
server.

4. Refer to the %CSA_HOME%\CSAKit-4.5\Lib\ucmdb\README.txt file for more information on how
to deploy the zipped file.
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HP Virtualization Performance Viewer
HP Virtualization Performance Viewer (HP vPV) provides visibility into performance and capacity
information across elements in the cloud and virtualized environments. It also provides placement and
optimization suggestions that can assist in right sizing the environment. Additional features of HP vPV
include a useful mechanism to drill down and troubleshoot Guest OS level problems in real time, using
forecast reports and what-if scenario modeling. HP vPV allows tomanage the virtual capacity of any
given infrastructure environment.

For information about the use case, see "Use case: HP vPV Integration" on page 235.

Configuring HP vPV
The user must have a HP vPV version 2.20 Linux server set up and ready to use. An additional patch is
required to extend the functionality for placement suggestion.

You can download the hot fix HF_04022015_179395_VPV from the patch hub site at https://patch-
hub.corp.hp.com/crypt-web/protected/viewContent.do?patchId=HF_04022015_179395_
VPV&product=crypt%3Avirtualization_performance_viewer%3A&hasProdBreadcrumb=true.

Additional configurations must be done to HP vPV for managing andmonitoring providers in your
environment. This content provides placement suggestion only for vCenter type providers. Hence, all
vCenter providers must be added to the HP vPV server.

Complete the following steps to add vCenter type provider to the HP vPV environment:

1. Go to https://<vPV IPAddress>:8444/PV/ and access HP vPV using secure access.

2. On themenu bar, click Admin > General > Data Sources.

3. Specify the details of your vCenter Host and its access information to add providers to the HP
vPV environment.

4. Click Test Connection to test network connectivity in the environment.

5. If the connection is successful, click Add to add the vCenter to HP vPV.

6. Ensure that the vCenters have Configuration set to Statistics Level = 2. This enables HP vPV to
readOS level performance information.

To set up the statistic levels on the vCenter, follow the steps in theEnabling Statistics Level 2
configurations in vCenter section below.

7. After configuring the vCenters as providers in the HP vPV environment, click Restart Colection
to start data collection process.
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8. The initial data collection process depends on the number of hosts and clusters configured in the
environment, andmay take a few minutes to complete.

Note: The initial data collection process depends on the number of hosts and clusters configured
in the environment, andmay take a few minutes to complete.

Enabling Statistics Level 2 configurations in VMware
vCenter
To set the statistics level on the VMware vCenter server, complete the following steps:

1. In the vSphere Client, click Administration > vCenter Server Settings.

2. In the vCenter Server Settings dialog window, click Statistics.

The Statistics Interval page displays the time interval to save the vCenter Server statistics and
the duration to save the information.

3. Click Edit.

4. In the Edit Statistics Interval window, set the values.
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VMware vCenter

Installing and configuring VMware vCenter
Install VMware vCenter according to themanufacturer's recommendations. For example, follow the
VMware best practices for managing individual ESX servers from a vCenter instance. You can find the
VMware documentation at http://www.vmware.com/support/pubs/.

Youmust have a vCenter instance that can support the flows that actuate vSphere VMs. SeeHP
Cloud Service Automation System and Software Support Matrix for version requirements.

Both theHP Cloud ServiceManagement Console Help, which is available in a printable PDF format,
and theHP Cloud Service Automation System and Software Support Matrix are available on HP
Software Support.

Configuring VMware vCenter
Configure VMware vCenter by installing prepared templates. In the vSphere environment, a template is
amaster copy of a virtual machine that can be used to createmany clones. A clone is a copy of a
virtual machine.

Virtual machines created by the HP CSA solution are created based on virtual machine templates.

For more information about creating templates and working with clones in vSphere, see the vSphere
Virtual Machine Administration Guide for vCenter Server (EN-000312-02) at
http://www.vmware.com/support/pubs/.

To install a prepared template, do the following:

1. Locate a prepared template.

2. Copy the template folder to the system containing the vSphere client software.

3. On the vSphere client softwaremenu, select View > Inventory > Datastores to see a list of
available datastores on your vCenter server.

4. Right-click one of the available datastores, and select Browse Datastore to see the directory
structure of that datastore.

5. Copy the template folder to the datastore by clicking on theUpload files to this datastore
button.

The following image shows the Datastore Browser window with Upload files to this datastore
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highlighted. It also shows a rhel53x64-clone folder that was uploaded to this datastore:

For more information, see the vSphere documentation at http://www.vmware.com/support/pubs/.

Use case: VMware vCenter Compute (Sequenced)
This solution demonstrates how to integrate HP CSA with VMware vCenter Server, by creating
VMware vCenter provider and providing an offering to deploy Virtual Machines(VMs) from a given
template.

VMware vCenter Server (previously known as VMware VirtualCenter) is a data center management
server application developed by VMware Inc. to monitor virtualized environments. VMware vCenter
Server provides centralizedmanagement and operation, resource provisioning and performance
evaluation of virtual machines residing on a distributed virtual data center. VMware vCentre Server is
designed primarily for vSphere, VMware’s platform for building virtualized cloud infrastructures.

HP CSA is architected to provide an open, heterogeneous, extensible single pane IT service control
point with VMware vCenter to managemultiple cloud resource pools from HP and other providers, to
design-orchestrate full stack services and IT service broker capabilities.

This implementation includes HP CSA service designs and HP Operations Orchestrations workflows,
which can be used to create a service offering for consumers to request andmanage server instance
from VMware vCenter Server environment.

Configuration requirements
The following configurations must be completed and tested before you set up this implementation:

l Configure VMware vCenter

l Configure VMware vCenter provider in HP CSA
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Configuring service offerings
Resource categories that are referenced in a service design will be automatically created when the
service design archive is imported.

Service design Provider

vCenter Compute VMware vCenter

vCenter Compute with Basic Options

Configuring subscriber options

Subscriber options are shown to the subscriber in the service offering. Youmay need to change options
to values that are appropriate for your environment. Youmay also add or remove images as needed.

Creating resource providers

Resource providers must be created in HP CSA.The following table lists resource providers required
for this implementation and the service access points. Youmay need to change them to reflect your
environment.

Provider name Service access point

VMware vCenter https://<vCenter-Server>:443

To create resource providers, complete the steps in "Creating resource providers" on page 20.

Associating resource offerings with providers

New resource offerings that were imported with the service design archivemust be associated with
providers. Youmust associate the resource offerings and providers listed in the following table.

Resource offering Provider

vCenter Compute VMware vCenter

vCenter Compute Flex Server Resources VMware vCenter

vCenter Compute NoOperation VMware vCenter

To associate a resource offering with a provider, complete the steps in "Associating resource offerings
with providers" on page 27.

Changing component properties

Youmust change the following properties for the vCenter Compute service design components.
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Component Property name Description

Server customSpec VM Template Customization Specification

Server datacenterName Datacenter name in the vCenter

Server memory Memory in MB

Server nCPU Total number of CPUs

Server templateReference VM template as in the vCenter

Server
Group

serverCount Total number of servers

Server hostNamePrefix Host Name Prefix

Server vmFolder Folder name as in VMware vCenter. If not specified, then VMs
will be deployed at the root “/” (optional).

The vCenter Compute with Basic Options service design demonstrates basic subscriber options for
vCenter Compute.

To change component properties, follow the steps in "Changing component properties" on page 39.

Note: The values for nCPU, memory, ipAddress may change during the subscription lifecycle. If
subscriber options directly bind to them, themodified valuemay not be reflected in the
Marketplace Portal. To overcome this limitation, new properties that end with Op have been
introduced (CPUOp andmemoryOp). Subscriber options will be bound to these properties and the
flow will copy the value from the options to the actual properties.

Publishing the service design

To publish the service design, complete the steps in "Publishing service design" on page 28.

Creating service offering

service offeringmust be created in HP CSA before subscribers can request services based on this
service design.

To create service offering, complete the steps in "Creating service offering" on page 23.

Publishing service offering to Global Shared Catalog

To publish service offering to the Global Shared Catalog, complete the steps in "Publishing service
offering to Global Shared Catalog" on page 23.
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Subscribing service
To subscribe service, complete the steps in "Subscribing service" on page 24.

Canceling a subscription

To cancel a subscription, complete the steps in "Canceling a subscription" on page 24.

HP Operations Orchestration flows
The following sections describe the flows used in this integration and the descriptions.

Flow
name Description

vCenter
Restart
Server

Restart the Virtual Machine

vCenter
Simple
Compute
- Deploy

Provision a Simple Vcenter Linux VM from a VM template

vCenter
Simple
Compute
-
Undeploy

Undeploy the cloned server from vCenter

vCenter
Start
Server

Start the Virtual Machine

vCenter
Stop
Server

Stop the Virtual Machine

vCenter
Suspend
Server

Suspend the Virtual Machine
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Flow
name Description

vCenter
Simple
Compute
- Validate
Input
Properties

Validates virtual machine deployment input properties. This can be attached pre
deployment state to check all the required information available to deploy.

vCenter
Simple
Compute
- Server
Group
Flexin
Server

Remove a Server from the Server Group. Random Server will be selected from the
Server Group.

vCenter
Simple
Compute
- Server
Group
Flexout
Server

Provision a Server and add to the Server Group

vCenter
Simple
Compute
- Server
Flex CPU

This flow will flex up or flex down the CPU configuration of a server. The user is
expected to enter the CPU in number that the servers should have. The flow will then
apply this input as the final state of the CPU for the server. If the CPU of the server is
less than the user input, then the server CPU will be flexed up to the input. If the CPU is
lesser, then the server CPU will be flexed down to the input. No changes will bemade if
the input and the current configuration are the same.

The flex up and flex down operations will execute whether the server is running,
suspended or in switched off state.

Themaximum number that can be given as input for a flex up operation depends on the
underlying configured vCenter.

vCenter
Simple
Compute
- Server
Flex
Memory

This flow will flex up or flex down thememory configuration of a server. The user is
expected to enter thememory in MB that the servers should have. The flow will then
apply this input as the final state of thememory for the server. If thememory of the
server is less than the user input, then the server memory will be flexed up to the input.
If thememory is lesser, then the server memory will be flexed down to the input. No
changes will bemade if the input and the current configuration are the same.

The flex up and flex down operations will execute whether the server is running,
suspended or in switched off state.

Themaximum number that can be given as input for a flex up operation depends on the
underlying configured vCenter.
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Limitation
If the specified vmFolder does not exist in VMware vCenter, the subscription will fail.

Use case: VMware vCenter Topology
This section describes how to use VMware vCenter Server, formerly VMware Virtual Center, as a
provider for HP CSA to deploy VMs using templates. This implementation also demonstrates how to
configure static IP address to the network interface for the VM.

VMware vCenter Server provides centralizedmanagement of virtualized hosts and virtual machines
from a single console. VMware vCenter Server gives administrators deep visibility into the
configuration of all the critical components of a virtual infrastructure from a single point. With VMware
vCenter Server, virtual environments are easier to manage: a single administrator canmanage
hundreds of workloads, more than doubling typical productivity in managing physical infrastructure.

Configuration requirements
The following configurations must be completed and tested before you set up this implementation:

l Configure HP CSA Cloud ServiceManagement Console andMarketplace Portal.

l Configure providers for VWware vCenter in HP CSA.

l Configure VMware vCenter.

l Configure HP Operations Orchestration. It must be operational.

Configuring service offerings
Resource categories that are referenced in a service design will be automatically created when the
service design archive is imported.

Service design Provider

vCenter Simple Compute VMware vCenter

Creating resource providers

Resource providers must be created in HP CSA. The following table lists the resource providers
required for this integration and the service access point. You should change them to reflect your
environment.
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Provider name Service access point

VMware vCenter https://<vCenter-Server>:443

For the VMware provider properties, the DATACENTERNAME is the user's VMware Data center
name.

To create resource providers, complete the steps in "Creating resource providers" on page 20.

Creating credentials and system variables

After you import the flows, youmust create system variables and credentials to subscribe service
successfully.

Define the following system property under configuration in HP Operations Orchestration if it does not
already exist.

Name Description

vCenterDelay Time in seconds to wait for collecting the power state status of the deployed VM. By
default, this value is 30 seconds.User can set the time frame.

Changing component properties

To change component properties, complete the steps in "Changing component properties" on page 39.

Publishing a topology design

After importing the design and components, you can publish the Topology design.

Service design Provider

vCenter Simple Compute VMware vCenter

vCenter Server

This component represents a server on the VMware vCenter provider

Property name Description

Name Name of the vCenter Server.

vmTemplateReference The template used for cloning the VM in the vCenter server from HP CSA

customizationSpec Select the specific customization specification applicable for the vm
instance

vmNamePrefix The prefix name for the instance to be provisioned.

username Login name used to deploy application.
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Property name Description

password Password used to login to the instance and ‘privateKey’ should be left
blank if this property is used.

privateKey If the instance allows key-pair based authentication to login then the
complete private key content has to be copied.

cpuCount Number of CPUs for the instance to be provisioned.

memorySize Size of theMemory for the instance to be provisioned.

vmFolder Folder path for the instance to be provisioned.

To publish topology design, complete the steps in "Publishing topology design" on page 20.

Publishing service design

To publish the service design, complete the steps in "Publishing topology design" on page 20.

Creating service offering

To create a service offering, complete the steps in "Creating service offering" on page 23.

Publishing service offering to Global Shared Catalog

To publish service offering to the Global Shared Catalog, complete the steps in "Publishing service
offering to Global Shared Catalog" on page 23.

Subscribing service
To subscribe service, complete the steps in "Subscribing service" on page 24.

Canceling a subscription

To cancel a subscription, complete the steps in "Canceling a subscription" on page 24.

Use case: Configuring intelligent resource
management
Intelligent ResourceManagement provides amodel to represent resource demand across different
categories of providers. It also provides capacity and utilization awareness of these resources in HP
CSA. HP CSA does not control management of actual resources on providers, but the goal is to
manage the capacities made available to HP CSA from providers and track their utilization. HP CSA
accounts for the utilization of these resource capacities for each subscription in HP CSA.
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Prerequisites
Process definitions for out-of-the-box (OOTB) HP Operations Orchestration (HP OO) content must be
uploaded into HP CSA successfully. For more information, see theHP Cloud Service Automation
Configuration Guide at http://h20230.www2.hp.com/selfsolve/manuals/.

Concept of resource pools
A resource pool models the capacity and utilization of resources, which are represented as elements in
the servicemodel. Resource pools are optionally configured to represent those resources that a
resource provider makes available to HP CSA.

HP CSA canmodel resource supply in resource pools associated with each resource provider. For
example, you can create resource pools on a VMware vCenter resource provider to represent
collections of virtual resources for a single hypervisor, a cluster, or the entire datacenter. You can also
model HP Matrix Operating Environment infrastructure orchestration resource pools (pools of CPU,
memory, and storage) as HP CSA resource pools.

HP CSA models resource demand using properties on service design components. HP CSA links the
property demand to a specific resource pool’s supply via resource binding actions during service
instantiation.

The property on a service design that links to a specific resource pool via resource binding is known as
measurable property. A measurable property has a resource type and a unit of measurement.

HP CSA allows you to define the following resource types for each pool:

l CPU

l IPv4 address

l IPv6 address

l License

l Memory

l Physical server

l Power

l Storage

l Subnet

l Virtual Server

l VLAN
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Provider and pool selection internal actions

HP CSA provides the following internal actions to help with provider and pool selection:

Build Resource Provider and Pool List

This internal action builds a candidate list of resource providers and associated resource pools that
meet the following requirements:

l The resource pool has the 'Availability' option set to Enabled.

l One ormore resource types (CPU, Memory, and Storage) are added to the pool with the Resource
Availability optionmarked as 'Available' or 'Unlimited'.

l The resource pool should have enough capacity to support all the resource types defined in the pool.
If resource type is marked 'Available', then the difference between Total Available to CSA and
Current CSA Utilizationmust be greater than the value required by themeasurable property.

l If the service offering that references the service design with this action is in a service catalog with
resource environments selected, the candidate pool list is further restricted to only include resource
providers in one or more of the selected resource environments.

Select Resource Provider and Pool

This internal action selects a resource pool and provider from the candidate list that was built by the
Build resource provider and pool list action. The selected resource provider and pool will then be
available to resource offering actions in the token RSC_PROVIDER_ID and RSC_POOL_ID,
respectively. The selected pool will, optionally, be written to a property on the associated service
component if the Pool Property Name input to the action is provided.

Select resource provider and pool from parent

This internal action selects the resource pool and provider already chosen by a service component’s
parent service component, as identified by the Parent Component ID and Pool Property Name
properties. The selected resource provider and pool will then be available to resource offering actions in
the token RSC_PROVIDER_ID and RSC_POOL_ID, respectively. The selected pool will also be
written to a Pool Property Name property on the associated service component.

Resource accounting internal actions

HP CSA provides the following internal actions to consume or release the resource types defined on
the pool:

Increase resource utilization

l Configures this action during the Reserve state transition.

l It increases the Available to CSA resource type in a resource pool by the values of themeasurable
properties configured on a resource binding.

Decrease resource utilization
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l Configures this action during Un-Reserve state transition.

l It decreases the Available to CSA resource type in a resource pool by the values of themeasurable
properties configured on a resource binding.

Resource management
HP CSA provides the capability to model, manage, and track resources of providers. Resource pools
are used tomodel the capacity and utilization of resources. Tomodel a pool, you need to identify the
resource types to bemanaged like CPU andMemory, and capacity of each resource type. Also, to
consume these resources during service subscription, measurable properties are configured on service
components to capture the demand for each resource type.

Resource supply management

HP CSA resource administrators take care of supply management.

The following steps summarize the supply management in HP CSA:

l Administrator identifies the capacity of each resource that can be allocated for a provider and pool to
configure a resource supply.

l Configures multiple pools per provider.

l Supports multiple resources per pool.

For example, a pool can have CPU, Memory, and Storage resources configured.

l HP CSA supports Environment association with the pool or provider.

Resource demandmanagement

The following steps summarize resource demandmanagement in HP CSA:

l Resource demand is expressed using themeasurable properties, which are described as properties
on a Service Component. Measurable properties have a resource type and a unit of measurement.

l A resource or multiple resources (CPU and Storage) in demand will be presented to provider and
resource pools. The provider and the pool which satisfy the resource demand will be selected for
utilization.

l If the resource demand cannot be determined during provider selection, then you can externalize the
provider and pool selection. Additionally, an HP OOworkflow has to be developed which will
determine the resource demand and select the appropriate provider and pool.

l Once the demand criteria is satisfied, then accounting actions will utilize the resources and
decrease the allocated capacity of the resource from the resource pool. These actions are defined in
Reserve/Un-Reserve transitions phases.
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Use case: Resource pool use case
HP CSA administrators configure resource pools on HP CSA to utilize the resources of the provider.
The following use cases can be derived while configuring providers and pools on HP CSA:

l Administrators have to know the available resource capacity for each resource that needs to be
configured on the HP CSA resource pool. During provider and pool selection, these resources will
be consumed accordingly.

l Administrators cannot determine the available resource capacity to configure on the resource pool.
In such cases, they can still configure the pool but externalize the provider and pool selection by
determining the resources available on the actual provider.

This use case explains the first case. For information about the second use case, see "Use
case: Custom Resource Provider and Pool selection" on page 201.

For example, consider the following scenario:

You need to design a service to provision a simple compute server using the provider VMware vCenter.
The service should consume resources from the pool while provisioning, and release the resources
back to the pool during tear down of the service.

The purpose of this example is to help the reader understand how to configure resource pools, resource
types for each pool, configuremeasurable properties, and configure internal actions on resource
bindings.

The steps will not illustrate basic HP CSA operations (for example, adding a resource provider and
publishing a service offering).

Since HP CSA ships with the out-of-the-box content vCenter ComputeModify, use this content to
illustrate the steps. To import the content, use the Designs tab in the Cloud ServiceManagement
Console.

Service design Provider

vCenter ComputeModify VMware vCenter

Configuring resource pool

1. Add a vCenter provider.

Because this example is based on vCenter, create a provider and resource pool based on the
vCenter provider. Create a vCenter provider in theProviders area of theManagement console.
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2. Add a resource pool.

Click the created resource provider. Create a resource pool from theResource Pools tab. While
creating the provider in the Known By Provider As field, add either the datacenter name or the
cluster name of the provider.
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3. Add a resource type to the pool.

ConsumeCPU andMemory resources from the pool. Add these two resource types from the
Resources tab on the pool. Add the Total Available to CSA values for the respective resource
types. The Total Available to CSA value is the total capacity allocated for the resource that will be
utilized by HP CSA.
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Now, the two types of resources added to the pool are CPU andMemory.

4. Associate resource offering to the provider.

Add the vCenter Compute, vCenter NOOP, and vCenter Modify Server Group Resource offerings
to the vCenter provider.

5. Create a service design.

Create a service design with the following hierarchy of service components: Service Composite >
Infrastructure Service > Server Group > Server. The Server component is marked as a pattern
component.
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6. Configure the resource offerings on the components.

The following table lists the resource offerings to be added on the components:

Component Resource Offering

Server Group vCenter Compute NOOP

Server vCenter Compute

The following figure depicts the resource offerings added on to components:
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7. Configure the provider and pool internal actions on the components.

Add the internal actions listed in the following table. These internal actions are added in the
Provider Selection tab on Resource binding. Also, add the provider property name on the internal
actions as defined in the table:

Component
Internal
Action Provider Property Name

Server Group Build
Resource
Provider
and Pool
List

Select
Resource
Provider
and Pool

VCENTER_POOL

Server Select
Resource
Provider
and Pool
from
Parent

VCENTER_POOL

The following figure depicts the internal actions on the Server Group Resource Binding: 
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Setting provider properties internal actions on the server group resource binding is depicted in the
following figure:

Provider property name on the select resource provider and pool from parent internal action is
depicted in the following figure:

8. Configure the resource types on the CPU andMemory properties.
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Open the Properties tab where the nCPU andmemory properties are defined on the Server
component. These properties should bemarked with appropriate resource type as shown in the
following figure. The resource type on the properties qualifies them to bemeasurable.

9. Configure the nCPU andMemory properties on to the Resource Binding.
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Click Resource Binding vCenter Compute on the Server component. Add the properties nCPU
andMemory onto theMeasurable Properties tab. The property values will be accounted during
provider and pool selection.

10. Configure the Resource Accounting internal actions onto the Resource Binding.

Add the Increase Resource Utilization internal action onto the Reserve state, and the Decrease
Resource Utilization internal action onto the Un-Reserve state. These internal actions will be
executed during the Reservation phase of the life cycle execution of the Server component.

11. Define property values on the components.

Property values have to be defined for component properties for both the Server Group and Server
components.

After executing these steps, the service is ready to be associated with a service offering, and published
to a catalog. After a user subscribes to this service, HP CSA creates a service instance whichmoves
through the HP CSA lifecycle phases.
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Resource utilization report
Administrators can view the resource capacity allocated and resources utilized for each resource pool
from the Cloud Service console. You canmanually increase the resource capacity allocated.
Automatic resource capacity allocation can be set using the Resource Sync option on the resource
pool.

Resource synchronization
Resource capacity on the resource pool is used during provider and pool selection. Administrators can
set the capacity manually or automatically. Available resource capacity units can be retrieved from a
provider single hypervisor, cluster or a datacenter and update the Total Available to CSA value using
the Utilization REST API. You can externalize the resource capacity update using HP OO flows
wrapped to retrieve allocated units and update the resource capacity on the pool. HP CSA provides an
OOTB vCenter Sync Resource Capacity HP OO flow to update the resource capacity retrieved from a
vCenter provider.

You can set the HP OO action flow using the Resource Synchronization Action option on the resource
pool. While configuring the Sync action, Known By Provider As should be a provider Cluster name or a
Datacenter name.

Resource synchronization can be scheduled by triggering the Synchronize Now button on the resource
pool. On success, the Last Synchronized field will display the latest timestampwhen the resource pool
was updated.
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REST APIs

Get resource pool details

This API is used to get the resource pool artifact details.

URI /artifact/<resourcePoolID>

Method GET

Parameters userIdentifier=<user_id>

Required; the user ID you want to use as credentials for this API call. This user should
be a consumer user who has the necessary permissions for the data you want to work
with.

scope=[base | baseplusone | subtree]

Optional; default is base. If value is base, then the object is returned. If value is
baseplusone, then the object and its first level children are returned. If value is subtree,
then the object and all of its descendants are returned.

detail=[required | basic | standard | template | full]

Optional; default is full. See the values for the detail parameter in the HP CSA
documentation. Some API calls do not support all possible values for this parameter.
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Returns 200 - Updated

404 - Not found

500 - Server exception

Update resource pool details

URI /artifact/<resourcePoolID>

Method PUT

Parameters userIdentifier=<user_id>

Required; the user ID you want to use as credentials for this API call. This user
should be a consumer user who has the necessary permissions for the data you want
to work with.

_action_=merge
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XML Input
without
Synchronize
action

<ResourcePool>
<name>${name}</name>
<displayName>${displayName}</displayName>
<poolReference>${poolReference}</poolReference>
<resourceProvider><id>${providerId}</id></resourceProvider>
<state>

<name>ACTIVE</name>
</state>
<artifactType>

<name>RESOURCE_POOL</name>
</artifactType>

<resourceCapacity>
<id>${capacityId}</id>

<resourceType>
<id>${resourceTypeId}</id>
<name>${resourceTypeName}</name>

</resourceType>
<unit>

<name>${unit}</name>
</unit>
<availabilityIndicator>

<name>${availabilityIndicator}</name>
</availabilityIndicator>
<availableToCsa>${availableValue}</availableToCsa>
<usedByCsa>${usedByCSA}</usedByCsa>

</resourceCapacity>
</ResourcePool>
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XML Input
with
Synchronize
action

<ResourcePool>
<name>${name}</name>
<displayName>${displayName}</displayName>
<poolReference>${poolReference}</poolReference>
<resourceProvider><id>${providerId}</id></resourceProvider>
<action>

<id>${actionId}</id>
<name>${actionName}</name>
<processDefinition>

<id>${processDefId}</id>
<name>${actionName}</name>

</processDefinition>
</action>
<state>

<name>ACTIVE</name>
</state>
<artifactType>

<name>RESOURCE_POOL</name>
</artifactType>
<resourceCapacity>

<id>${capacityId}</id>
<resourceType>

<id>${resourceTypeId}</id>
<name>${resourceTypeName}</name>

</resourceType>
<unit>

<name>${unit}</name>
</unit>
<availabilityIndicator>

<name>${availabilityIndicator}</name>
</availabilityIndicator>
<availableToCsa>${availableValue}</availableToCsa>
<usedByCsa>${usedByCSA}</usedByCsa>

</resourceCapacity>
</ResourcePool>

Use case: Custom Resource Provider and Pool
selection
HP CSA comes with out-of-the-box resource provider selection actions. These actions select a list of
resource providers and pools that are capable of providing a resource offering and select a provider and
pool from this list. This selection functionality can be further refined by filtering the list of providers
based on a desired condition, before the final resource provider and pool is selected.
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Prerequisites
Experience with HP Operations Orchestration (HP OO) flow authoring is also required. User must have
run the Process Definition tool for the out-of-the-box content.

For more information, see theHP Cloud Service Automation Configuration Guide at
http://h20230.www2.hp.com/selfsolve/manuals/.

Concept
HP CSA provides capability to configure demand and utilization of resource capacity across categories
of providers. Resource Pool is themodel to capture the demand and express the utilization consumed
on HP CSA per provider. Each pool can be configured with multiple capacities like CPU andMemory,
which will be consumed by HP CSA during subscription fulfillment. Capacity is consumed during the
Reservation phase and released during Un-Reservation phase of the lifecycle process.

Resource pools can be configured in HP CSA for the following two cases:

l Tomanage (increase or decrease) resource capacity and select the provider and pool that satisfy
the demand.

l Tomanage only the utilization of resource capacity, but externalize the selection of provider and
pool.

This use case explains how tomanage the utilization of resource capacity and externalize the selection
of provider and pool.

The following internal actions help with provider and pool selection:

l Build Resource Provider and Pool List

l Select Resource Provider and Pool

These actions are explained in the following sections.

Build Resource Provider and Pool List

This action performs the following:

l Builds a list of resource providers and pools.

l Filters the list belonging to at least one of the resource environments that are associated with the
corresponding service catalog ( a catalog used to publish the service offering related to the service
design that performs this action).

The following are the criteria to build a candidate list of resource providers and pools:
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l They must have the provider availability option set to Enabled.

l They must have the pool availability option set to Enabled.

The Build Resource Provider and Pool List action also sets the valid list of resource providers to the list
resulting from this action.

Select Resource Provider and Pool

Select Resource Provider and Pool action selects a resource provider and a pool from the valid list of
pools built by the Build Resource Provider and Pool List action. The resource provider is selected
randomly from the list of valid providers. The selected provider is then written to a property on the
associated service component. Users specify the name of this property through a well-known property
of this action.

Use case
Data store is an essential resource capacity that is consumed by various applications in a data center.
Consider a VMware vCenter provider having three data stores in a data center. Subscription request
fulfillment requires selecting a data store having enough disk space to provision the server instance.
Each data store can be configured as a provider pool on the vCenter resource provider. During provider
selection, appropriate data stores can be selected by comparing the disk size request from the
customer subscription against the provider’s data store disk space.

Since HP CSA contains out-of-the-box sample content for VMware vCenter, you will import it into the
Designs area of the Cloud ServiceManagement console and use it to illustrate the steps. Import the
vCenter Compute Custom Pool Selection content now.

Service design Provider

vCenter Compute Custom Pool Selection VMware vCenter
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Steps to configure provider selection

1. Add a vCenter resource provider.

2. Associate resource offerings to resource providers capable of offering the resource.

For this example, associate the VMware vCenter provider with the resource offering named
vCenter Compute, vCenter Compute Flex Service Resources, and vCenter Compue No
Operation.
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3. Create resource pools.

Create data store pools on HP CSA so that they have display names that are the same as the
name on the VMware vCenter provider. The following figure depicts the three data store pools for
the provider, and that they have been given the same display names in HP CSA.
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4. Add the resource capacity and availability for each resource pool.

Add storage capacity for the data store resource pool. Select the 'Unlimited' resource availability
option.

5. Add the providers to the resource environment.
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Note: This is an optional step during provider configuration.

Providers can be grouped together by resource environment. One or more resource environments
can be linked to a service catalog to restrict provider selection at subscription time. The steps to
do this are indicated in the following example:

a. Add two regions, East andWest, on the Environment tab under Providers.

b. Associate the necessary providers into each resource environment.

c. Add the resource environments onto the desired catalogs in the Catalog area of the CSA
interface.

In this example, add the ‘East’ resource environment into the ‘Global’ catalog, so
subscriptions requested from the ‘Global’ catalog will always choose providers from the ‘East’
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resource environment during the provider selection stage of subscription fulfillment.

6. Create a service design.

For this example, create a service design having the following components, with the hierarchy as
indicated in the following list and shown in the following figure:

n Service Composite

n Infrastructure Service

n Server Group

n Server
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7. Add the resource offerings to the components.

Resource offerings are associated with components using resource bindings.

In this example, add the vCenter Compute NoOperation binding to the Server Group component,
and the vCenter Compute and vCenter Compute Flex Server Resources binding to the Server
Component.
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8. Create Provider Selection actions for the resource bindings on the Server Group component.

Add the following actions to the Server Group component’s binding (vCenter Compute No
Operations) in the following order:

n Build Resource Provider and Pool List (Internal Process Engine)

n vCenter Provider Pool Selection for Data Store (HP OOFlow)

n Select Resource Provider and Pool (Internal Process Engine)

9. Specify the property of the Select Resource Provider and Pool internal action.

The Select Resource Provider and Pool action has a property called Pool Property Name. With
this property the user can specify the name of the property in which the selected resource provider
ID will be set as a property of the service component.

For example, if the user specifies VCENTER_POOL as the value for this property, then the
selected provider pool Id will be set as a property on the service component as follows:

Provider=ID of Selected Provider Pool
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10. Create Provider Selection actions for the resource bindings on the Server component.

Add the Select Resource Provider and Pool from Parent internal action on the Server component’s
binding (vCenter Compute and vCenter Compute Flex Server Resources).

11. Specify the property of the internal action.

The Select Resource Provider and Pool from Parent action has a property called Pool Property
Name. Set the value of this property as VCENTER_POOL. The action will retrieve the Provider
Pool Id populated on the property VCENTER_POOL from the parent Server Group component and
store it on the Server component.
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12. Create the following component properties on the Server Group component:

n An Integer property named ‘diskSize’

n A String property named ‘templateReference’

13. Source bind the Server component properties to the Server Group component, as follows:

a. Source bind the disk property on the Server component to the diskSize property on the Server
Group component.
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b. Source bind the templateReference property on the Server component to templateReference
property on the Server Group component.

14. Create the necessary subscriber options, as follows:
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a. Create an option set having options for various disk sizes (Small andMedium).

b. Create a DiskSize property of Integer type on each option having values corresponding to the
storage sizes.

c. Create a templateReference property of String type on each option, the value being a clone
template name residing on the vCenter provider. The clone template should provision the
instance for the requested disk size.

d. Create a target binding between the DiskSize property on eachOption to the diskSize
property on the Server Group.

e. Create target binding between the templateReference property on eachOption to the
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templateReference property on the Server Group.
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15. Publish the design.

After you have completed the above steps in this procedure, the service is ready to be associated
with a service offering and published to a catalog. After a user subscribes to the published service,
HP CSA creates a service instance that moves through the HP CSA lifecycle phases. When the
provider selection actions are executed during the Reserving – Pre-Transition lifecycle phase, the
following sequence of operations occurs:

n Build Resource Provider and Pool List, an internal action, gets the list of resource providers
associated with the resource offering corresponding to the resource binding, and HP CSA
stores the vCenter Provider and the list of pools associated with the provider. The list stored in
HP CSA for the binding is called the Candidate Provider and Pool list.

n vCenter Provider Pool Selection of Datastore, an HP OO flow, performs the following steps:

o Retrieves the storage requested by the consumer using the HP CSA Rest API.

See "REST APIs" section.

The value is stored in the ‘diskSize’ property on the Server Group component.
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o Retrieves the list of data store names and corresponding storage space from the VMware
vCenter provider.

o Retrieves the Candidate Provider and Pool List stored in the previous action using the HP
CSA Rest API.

For information, see "REST APIs" section.

o Retrieves the disk size property value defined on the Server Group component.

o Verifies the pool names for each of the above lists against the candidate pool list.

o Filters the candidate pool list which satisfies the storage space against the disk size.

o Updates the filtered candidate list as a valid pool list onto HP CSA using the HP CSA Rest
API.

n Select Resource Provider and Pool, an internal action, performs the following steps:

o Retrieves the list of valid provider and pools built by the previous action.

o Selects a random pool id and saves it on the VCENTER_POOL property on the Server
Group component.

REST APIs

Get the list of candidate providers and pools

To get the list of candidate providers and pools, use the GET artifact API.

URI:

https://localhost:8444/csa/rest/artifact/<RESOURCE_BINDING_ID>?userIdentifier=<USER_
ID>&scope=view&view=candidatepools

Method:GET

Response:

<ResourceBinding>
<id>90e72d893cd0fb1d013cd108d496004f</id>
<objectId>90e72d893cd0fb1d013cd108d496004f</objectId>
<isCriticalSystemObject>false</isCriticalSystemObject>
<description>binding_February 12, 2013 6:14:59 PM UTC</description>
<name>binding_February 12, 2013 6:14:59 PM UTC</name>
<displayName>binding_February 12, 2013 6:14:59 PM UTC</displayName>
<artifactType>
... ... ...
</artifactType>
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<disabled>false</disabled>
<candidateProvider>

<id>90e72d893ccf9a39013ccf9cf167001a</id>
<resourceProvider>

<id>90e72d893ccf9a39013ccf9cf167001a</id>
<objectId>90e72d893ccf9a39013ccf9cf167001a</objectId>
<isCriticalSystemObject>false</isCriticalSystemObject>
<name>Provider2_February 12, 2013 6:13:54 PM UTC</name>
<displayName>Provider2</displayName>
<disabled>false</disabled>

</resourceProvider>
<candidatePool>

<id>90e72d893ccf9a39013ccf9d5d630022</id>
<objectId>90e72d893ccf9a39013ccf9d5d630022</objectId>
<isCriticalSystemObject>false</isCriticalSystemObject>
<name>P2-Pool1_February 12, 2013 6:14:22 PM UTC</name>
<displayName>P2-Pool1</displayName>
<disabled>false</disabled>
<useProviderEnv>false</useProviderEnv>

</candidatePool>
<candidatePool>
... ... ...

</candidatePool>
</candidateProvider>

</ResourceBinding>

Update the list of valid providers

To update the list of valid providers use the PUT artifact API.

URI:

https://localhost:8444/csa/rest/artifact/<RESOURCE_BINDING_ID>?userIdentifier=<USER_
ID>&scope=view&view=validproviderspools

Method:PUT

Body: Include the refined list of valid providers. In this example, we have refined the list to remove
Provider3.

<ResourceBinding>
<id>90e72d893ccf9a39013ccfa0076a0099</id>
<validProvider>

<resourceBinding>
<id>90e72d893ccf9a39013ccfa0076a0099</id>

</resourceBinding>
<resourceProvider>

<id>90e72d893ccf9a39013ccf9cf167001a</id>
</resourceProvider>
<validPool>

<id>90e72d893ccf9a39013ccf9c6be60014</id>
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</validPool>
<validPool>

<id>90e72d893ccf9a39013ccf9c6be60016</id>
</validPool>

</validProvider>
<validProvider>
......
</validProvider>

</ResourceBinding>

HP Operations Orchestration flow
This section provides a brief overview of how custom pool selection is implemented in the vCenter
Provider Pool Selection for Datastore HP Operations Orchestration flow. This flow is provided as out-
of-the-box content with HP CSA.

For information about configure HP Operations Orchestration for getting the flows from HP CSA, see
theHP CSA Configuration Guide at http://h20230.www2.hp.com/selfsolve/manuals.
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The above figure shows the HP CSA action used in the vCenter design for performing custom provider
and pool selection. The Process Definition field shows the details of the corresponding HP OO flow.
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The following figure shows the HP Operations Orchestration flow invoked from HP CSA. The steps,
which implement the refinement logic are shown in the red box below. For this flow, the refinement
condition is based on the requesting disk size. A pool will be included in the list of valid pools only if
required disk size criteria are satisfied.
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Get Candidate Provider Pool

This step will retrieve all the candidate provider and pools from the HP CSA using the REST API call
shown in the red box in the following figure.
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Get Valid Provider Pool XML

This step will browse through the candidate providers and pools retrieved in last step and filter the pool
IDs based on storage. The subflow corresponding to this step is as shown in the following figure and
has followingmajor steps:

l Get Datastore Info - Retrieves the list of data store names and free space available from
VCENTER Provider.

l Get Resource Pool – Retrieves the Pool details like Pool Name.

l Valid Pool List Appender – Appends or creates the valid pool ids if the disk size requested is less
than the free space available for a data store.

l Valid Provider Pool List Appender – Appends the Provider ID to the valid pool id list created in the
previous step, Valid Pool List Appender.

Use case: Monitoring and configuration management
using vCenter Compute
This section describes how to integrate HP CSA with VMware vCenter Server, by creating VMware
vCenter provider and providing an offering to deploy Virtual Machine (VMs) from a given template. This
provisioned server is monitored using Sitescope. Configurationmanagement of the server is done by
HP UCMDB.
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This integration includes HP CSA service designs and HP Operations Orchestrations workflows,
which can be used to create a service offering for consumers to request andmanage server instance
from VMware vCenter Server environment.

Configuration requirements
The following configurations must be completed and tested before you set up this implementation:

l Configure VMware vCenter.

l Configure VMware vCenter provider in HP CSA.

Configuring service offerings
Resource categories that are referenced in a service design will be automatically created when the
service design archive is imported.

Service design provider

vCenter Compute-Monitoring and ConfigurationManagement SiteScope

UCMDB

VMware vCenter

Prerequisites

The following table lists the SiteScope template required for this integration.

Configuration
property Description

CSA
template.tmpl1

Import this file to the HP SiteScope server. See the README.txt file on the HP
CSA instance in the <CSA Install Path>\CSAKit-4.5\Lib\sitescope folder for
import details.

CSA templates
Silver.tmpl

Import this file to the HP SiteScope server. See the README.txt file on the HP
CSA instance in the <CSA Install Path>\CSAKit-4.5\Lib\sitescope folder for
import details.

CSA templates
Gold.tmpl

Import this file to the HP SiteScope server. See the README.txt file on the HP
CSA instance in the <CSA Install Path>\CSAKit-4.5\Lib\sitescope folder for
import details.

CSA templates
autoimport.tmpl

Import this file to the HP SiteScope server. See the README.txt file on the HP
CSA instance in the <CSA Install Path>\CSAKit-4.5\Lib\sitescope folder for
import details.

1This file should be importedmanually only when the CSA templates autoimport.tmpl fails to import on
HP SiteScope server.
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The following table lists the UCMDB templates required for this integration.

Configuration
property Description

CSAIntegration.zip Deploy the package on the HP Universal CMDB server. See the README.txt
file on the HP CSA instance in the <CSA Install Path>\CSAKit-4.5\Lib\ucmdb
folder.

Configuring subscriber options

Subscriber options are shown to the subscriber in the service offering. Youmay need to change options
to values that are appropriate for your environment. Youmay also add or remove images as needed.

Creating resource providers

Resource providers must be created in HP CSA. The following table lists the resource providers
required for this integration and the respective service access points. Youmay need to change them to
reflect your environment.

Provider name Service access point

VMware vCenter https://<vCenter-Server>:443

HP UCMDB http://<IP address>:8080

HP SiteScope http://<IP address>:9090

To create a resource provider, complete the steps in "Creating resource providers" on page 20.

Associating resource offerings with providers

New resource offerings that were imported with the service design archivemust be associated with
providers. Youmust associate the resource offerings and providers listed in the following table:

Resource offering Provider

vCenter Compute VMware vCenter

vCenter Compute Flex Server Resources VMware vCenter

vCenter Compute NoOperation VMware vCenter

HPCSA UCMDB ConfigurationManagement HP UCMDB

HPCSA SiteScope Server Monitoring HP SiteScope

To associate resource offerings with providers, see "Associating resource offerings with providers" on
page 27.
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Changing component properties

Youmust change the following properties for the vCenter Compute-Monitoring and Configuration
Management design components:

Component Property Name Description

Server customSpec VM Template Customization Specification

Server datacenterName Datacenter name in the vCenter

Server memory Memory in MB

Server nCPU Total number of CPUs

Server templateReference VM template as in the vCenter

Server
Group

serverCount Total number of servers

Server hostNamePrefix Host Name Prefix

Server vmFolder Folder name as in VMware vCenter (Optional)

If the folder name is not specified, then VMs will be deployed at
the root “/”.

Server osType Type of the OS

Server sitescopeTemplate Name of the HP SiteScope template on the HP SiteScope
server

The vCenter Compute-Monitoring and ConfigurationManagement service design demonstrate the
basic subscriber options for vCenter Compute.

To change component properties, complete the steps in "Changing component properties" on page 39.

Publishing service design

To publish the service design, complete the steps in "Publishing service design" on page 28.

Creating service offering

A service offeringmust be created in HP CSA before subscribers can request services based on this
service design.

To create service offerings, complete the steps in "Creating service offering" on page 23.
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Publishing service offering to Global Shared Catalog

To publish a service offering to the Global Shared Catalog, complete the steps in "Publishing service
offering to Global Shared Catalog" on page 23.

Subscribing service
To subscribe service, complete the steps in "Subscribing service" on page 24.

Canceling a subscription

To cancel a subscription, complete the steps in "Canceling a subscription" on page 24.

HP Operations Orchestration flows
The following table lists the flows used in this implementation and descriptions.

Flow
name Description

vCenter
Restart
Server

Restart the Virtual Machine

vCenter
Simple
Compute
- Deploy

Provision a Simple Vcenter Linux VM from a VM template

vCenter
Simple
Compute
-
Undeploy

Undeploy the cloned server from vCenter

vCenter
Start
Server

Start the Virtual Machine

vCenter
Stop
Server

Stop the Virtual Machine

vCenter
Suspend
Server

Suspend the Virtual Machine
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Flow
name Description

vCenter
Simple
Compute
- Validate
Input
Properties

Validates virtual machine deployment input properties. This can be attached pre
deployment state to check all the required information available to deploy.

vCenter
Simple
Compute
- Server
Group
Flexin
Server

Remove a Server from the Server Group. Random Server will be selected from the
Server Group.

vCenter
Simple
Compute
- Server
Group
Flexout
Server

Provision a Server and add to the Server Group

vCenter
Simple
Compute
- Server
Flex CPU

This flow will flex up or flex down the CPU configuration of a server. The user is
expected to enter the CPU in number that the servers should have. The flow will then
apply this input as the final state of the CPU for the server. If the CPU of the server is
less than the user input, then the server CPU will be flexed up to the input. If the CPU is
lesser, then the server CPU will be flexed down to the input. No changes will bemade if
the input and the current configuration are the same.

The flex up and flex down operations will execute whether the server is running,
suspended or in switched off state.

Themaximum number that can be given as input for a flex up operation depends on the
underlying configured vCenter.

vCenter
Simple
Compute
- Server
Flex
Memory

This flow will flex up or flex down thememory configuration of a server. The user is
expected to enter thememory in MB that the servers should have. The flow will then
apply this input as the final state of thememory for the server. If thememory of the
server is less than the user input, then the server memory will be flexed up to the input.
If thememory is lesser, then the server memory will be flexed down to the input. No
changes will bemade if the input and the current configuration are the same.

The flex up and flex down operations will execute whether the server is running,
suspended or in switched off state.

Themaximum number that can be given as input for a flex up operation depends on the
underlying configured vCenter.
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Flow
name Description

uCMDB
create

Creates andmanages component configuration details on HP Universal CMDB

uCMDB
delete

Deletes the component configuration details on HP Universal CMDB

Simple
Compute
Monitor -
Deploy

Monitors servers using HP SiteScope

Simple
Compute
Monitor -
UnDeploy

Removes server in HP SiteScope

Limitation
Subscription will fail if the specified vmFolder does not exist in VMware vCenter.

Use case: HP Server Automation software policies
deployment on vCenter Compute
This section describes how to integrate HP Cloud Service Automation (HP CSA) with VMware vCenter
Server, by creating VMware vCenter provider and providing an offering to deploy Virtual Machines
(VMs) from a given template. It installs SA agent to the server and deploys Software Policies to the
provisioned server.

This integration includes HP CSA service designs and HP Operations Orchestrations workflows,
which can be used to create a service offering for consumers to request andmanage server instance
from VMware vCenter Server environment.

Configuration requirements
The following configurations must be completed and tested before you set up this implementation:

l Install VMware vCenter.

l Configure VMware vCenter provider in HP CSA.
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Configuring service offerings
Resource categories that are referenced in a service design will be automatically created when the
service design archive is imported.

Service design Provider

SA Software Policies Deployment on vCenter HP Server Automation

VMware vCenter

Configuring subscriber options

Subscriber options are shown to the subscriber in the service offering. Youmay need to change options
to values that are appropriate for your environment. Youmay also add or remove images as needed.

Creating resource providers

Resource providers must be created in HP CSA. The following table lists the resource providers
required for this integration and the service access points. Youmay need to change them to reflect your
environment.

Provider name Service access point

VMware vCenter https://<vCenter-Server>:443

HP Server Automation https://<SA core>:443

To create resource providers, complete the steps in "Creating resource providers" on page 20.

Associating resource offerings with providers

New resource offerings that were imported with the design archivemust be associated with providers.
Youmust associate the resource offerings and providers listed in the following table:

Resource offering Provider

vCenter Compute VMware vCenter

vCenter Compute Flex Server Resources VMware vCenter

vCenter Compute NoOperation VMware vCenter

HP SA Deploy Software policies HP Server Automation

HP SA Install Agent HP Server Automation
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To associate resource offerings with providers, complete the steps in "Associating resource offerings
with providers" on page 27.

Changing component properties

Youmust change the following properties for the vCenter Compute service design components:

Component Property name Description

Server customSpec VM Template Customization Specification

Server datacenterName Datacenter name in the vCenter

Server memory Memory in MB

Server nCPU Total number of CPUs

Server templateReference VM template as in the vCenter

Server
Group

serverCount Total number of servers

Server hostNamePrefix Host Name Prefix

Server vmFolder Folder name as in VMware vCenter (optional).

If the folder name is not specified, then VMs will be deployed at
the root “/”.

Youmust change the following properties for the SA Software Policies Deployment on vCenter
Compute service design components.

Component Property name Description

Server hostName Host name of the Server

Server ipAddress IP address of the Server

Server osFamily OS of the Server

Server realmName Facility of SA

Server serverId Id of the server, assigned by SA after installing agent

Server serverPassword Password of the template

Server serverUsername Username of the template

Server swPolicyNames Software Policy Name to be deployed in the server

Server jobId Id of the job in SA

Server realmDetails Details of the facility in SA
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l Facility name provided inMarketplace Portal should be <Facility Name-agents>.

During subscription, to find the facility in SA core, log on to the instance SA client and click
Devices > SA Agent Installation > Servers. The facilities will be listed in theScan drop
down.

l If customspec is used, ensure that the super Username and super Password are appropriate
for the selected template.

To get the list of available software policies in SA, log on to the instance in SA client and click
Libraries > Software policies.

Software policies for each platform will be listed from where the policy suitable for the required
server can be chosen.

To change the component properties, complete the steps in "Changing component properties" on
page 39.

Click theHelp icon if you need help editing component properties.

Note: The values for nCPU, memory, ipAddress may change during the subscription lifecycle. If
subscriber options directly bind to them, themodified valuemay not be reflected in the
Marketplace Portal.

To overcome this limitation, new properties that end with Op have been introduced (CPUOp and
memoryOp). Subscriber options will be bound to these properties and the flow will copy the value
from the options to the actual properties.

Publishing service design

To publish the service design, complete the steps in "Publishing service design" on page 28.

Creating service offering

A service offeringmust be created in HP CSA before subscribers can request services based on this
service design.

To create a service offering, complete the steps in "Creating service offering" on page 23.

Publishing service offering to Global Shared Catalog

To publish a service offering to the Global Shared catalog, complete the steps in "Publishing service
offering to Global Shared Catalog" on page 23 .
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Subscribing service
To subscribe service, complete the steps in "Subscribing service" on page 24.

Canceling a subscription

To cancel a subscription, complete the steps in "Canceling a subscription" on page 24

HP Operations Orchestration flows
The following table lists the flows used in this implementation and descriptions.

Flow
name Description

vCenter
Restart
Server

Restart the Virtual Machine

vCenter
Simple
Compute
- Deploy

Provision a Simple Vcenter Linux VM from a VM template

vCenter
Simple
Compute
-
Undeploy

Undeploy the cloned server from vCenter

vCenter
Start
Server

Start the Virtual Machine

vCenter
Stop
Server

Stop the Virtual Machine

vCenter
Suspend
Server

Suspend the Virtual Machine
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Flow
name Description

vCenter
Simple
Compute
- Validate
Input
Properties

Validates virtual machine deployment input properties. This can be attached pre
deployment state to check all the required information available to deploy.

vCenter
Simple
Compute
- Server
Group
Flexin
Server

Remove a Server from the Server Group. Random Server will be selected from the
Server Group.

vCenter
Simple
Compute
- Server
Group
Flexout
Server

Provision a Server and add to the Server Group

vCenter
Simple
Compute
- Server
Flex CPU

This flow will flex up or flex down the CPU configuration of a server. The user is
expected to enter the CPU in number that the servers should have. The flow will then
apply this input as the final state of the CPU for the server. If the CPU of the server is
less than the user input, then the server CPU will be flexed up to the input. If the CPU is
lesser, then the server CPU will be flexed down to the input. No changes will bemade if
the input and the current configuration are the same.

The flex up and flex down operations will execute whether the server is running,
suspended or in switched off state.

Themaximum number that can be given as input for a flex up operation depends on the
underlying configured vCenter.

vCenter
Simple
Compute
- Server
Flex
Memory

This flow will flex up or flex down thememory configuration of a server. The user is
expected to enter thememory in MB that the servers should have. The flow will then
apply this input as the final state of thememory for the server. If thememory of the
server is less than the user input, then the server memory will be flexed up to the input.
If thememory is lesser, then the server memory will be flexed down to the input. No
changes will bemade if the input and the current configuration are the same.

The flex up and flex down operations will execute whether the server is running,
suspended or in switched off state.

Themaximum number that can be given as input for a flex up operation depends on the
underlying configured vCenter.
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Flow
name Description

Install
Agent on
Un
Managed
Server

Installs SA agent on an unmanaged Server

Deploy
Using
Software
Policies

Deploys Software Policies on amanaged Server

Undeploy
Using
Software
Policies

Undeploys Software Policies frommanaged server

Limitation
If the specified vmFolder does not exist in VMware vCenter, the subscription will fail.

Use case: HP vPV Integration
The goal of this implementation is to demonstrate HP CSA integration with HP Virtualization
Performance Viewer (HP vPV) to seek placement suggestions from HP vPV to place the VMs in the
right data center, cluster, and data store. The placement suggestion is received before the actual
provisioning of the VMs in the vCenter virtualized environments.

Compute Service powered by Cloud Optimizer
This use case enables HP CSA to use HP vPV to get insight into the provider capacity and
performance parameters to make intelligent selection of the data center, cluster, and data store where
VMs of standard configuration requirements (such as CPU, memory, and disk space) can be placed to
ensure optimum utilization.

Outcomes of this requirement are the following:

l Allow OOTB HP CSA content to use the placement suggestions received from HP vPV tomake
infrastructure decisions when provisioning VMs in a cluster.

l A hyperlink to HP vPV for each VM that is getting created to show the optimization and
performance view for that VM.

For information about defects and workarounds, see "Known issues" on page 239.
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Configuration requirements
The following configurations must be completed and tested before you set up this implementation.

l VMware vCenter must be installed.

l HP CSA Cloud ServiceManagement Console andMarketplace Portal must be configured. You
must be able to successfully deploy the simple vCenter compute service that ships with HP CSA.

l VMware vCenter provider must be configured in the HP CSA.

Configuring service offering
Resource categories that are referenced in a service design will be automatically created when the
service design archive is imported.

Adding vCenter provider configurations to HP vPV enable it to monitor and report the performance
statistics of vCenter.

Service design Provider

Compute Service powered by CloudOptimizer HP Virtualization Performance Viewer

VMware vCenter

Configuring subscriber options

Subscriber options are shown to the subscriber in the service offering. Youmay need to change options
to values that are appropriate for your environment.

To configure subscriber options:

1. Log on to the Cloud ServiceManagement Console as an administrator.

2. Click Designs > Sequenced > Designer.

3. Select the 'Compute Service powered by CloudOptimizer' service design.

4. Click Subscriber Options.

5. Click OS and then click the Show Properties icon to change the values for the options (VM
Template Name, VM Customization Specification, Hostname Prefix, and VM Folder) that are
appropriate as per your environment.

6. Click Save.
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Note: If multiple vCenters are configuredmake sure that option values are the same across all the
vCenters.

Creating resource providers

Resource providers must be created in HP CSA. The following table lists the resource providers
required for this integration and the typical service access point. youmay need to change them to
reflect your environment.

Provider name Service access point

VMware vCenter https://<vCenter-Server>:443

To create a resource provider, complete the steps in "Creating resource providers" on page 20.

Associating resource offerings with providers

New resource offerings that were imported with the design archivemust be associated with providers.
Youmust associate the resource offerings and providers listed in the following table:

Resource offering Provider

vCenter Compute VMware vCenter

vCenter Compute Flex Server Resources VMware vCenter

vCenter Compute NoOperation VMware vCenter

To associate resource offerings with providers, complete the steps in "Associating resource offerings
with providers" on page 27.

Creating service offering

To create a service offering, complete the steps in "Creating service offering" on page 23.

Configuring vCenter provider

Adding vCenter provider configurations to HP vPV enable it to monitor and report the performance
statistics of vCenter.

Add a new provider property 'vPVURL' to contain the URL of the HP vPV server that manages the
vCenter.

Setting up resource environments in HP CSA

Resource environments in HP CSA allows grouping of providers based on the organization and catalog
of the logged in user. This implementation uses the resource environments to provide the initial
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business level filtering of providers. The selected providers are then placed in context for provisioning
the requested VMs based on the resource capacity and availability.

Setting up resource environments is not amandatory step for this requirement and only allows logical
grouping of providers. If the resource environments are not set, then all the available vCenter providers
in the network will be taken for placement analysis.

To set up resource environments in HP CSA, complete the following steps:

1. Log on to the HP CSA Management Console, and then click theProvider tab.

2. Select By Environment from the drop down.

3. To create new resource environments, click the icon.

4. Add resource environments as needed. You can provide any name for resource environments.

5. Group the vCenter providers under the resource environments. To do that, complete the following
steps:

a. In the HP CSA Management Console, click Providers > VMware vCenter, and then select
each vCenter provider.

b. Click theEnvironments tab, and add the resource environment that you created. Repeat this
step for all vCenter providers.

c. Add providers to appropriate resource environments.

6. Based on the way resource environments are configured, appropriate providers will be selected for
placement.

7. Next, bind the resource environments to the catalog from where you wish to select it.

This implementation uses the General Catalog to publish the HP CSA - HP vPV integration
content. The ResourceEnvironment_DEV is bound to the General Catalog in the Consumer
Portal.

8. In the HP CSA Management Console, click theCatalogs tab.

9. Select the resource environment to add to the catalog.

Subscribing service
To subscribe service, complete the instructions in "Subscribing service" on page 24.

Canceling subscription

To cancel a subscription, complete the steps in "Canceling a subscription" on page 24.
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Observing VM performance on HP vPV
Optimization & Performance View URL on the subscriber portal enables the subscriber to observe the
performance and capacity parameters of the provisioned VM.

Known issues

Defect Reason Workaround

Displays an error
message 'No Suitable
Container Found Error'
when requesting
placement data from HP
vPV.

This error occurs
when the Run
Optimization
scheduler in HP
vPV fails to work.

Log on to the HP vPV console and go to Admin >
General > Optimization. Then click Run
Optimization tomanually run optimization. Ensure
that data is collected in HP vPV before starting the
tests each time.
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Application designs for HP Codar
This section describes the service designs and the components that will be shipped with HP Codar
1.50.

PetClinic Application on AWS
The CODAR_BP_AWS_PETCLINIC_APPLICATION_v1.50.00 service design will be installed if you
select the Install Sample content option while installing HP Codar.

Service design name: CODAR_BP_AWS_PETCLINIC_APPLICATION_v1.50.00.zip

Prerequisites
To use this design, you have to host the following files on aWeb Server ( Apache Server or aMaven
repository), which can be accessed using HTTP.

To host the service design:

1. Install_mysql.sh - download this from wherever it is hosted internally.

2. mysqldb_conf.sh - download this from wherever it is hosted internally.

3. install_tomcat.sh - download this from wherever it is hosted internally.

4. petclinic_jdbc_conf.sh - download this from wherever it is hosted internally.

Note: The above files can be found in <CSA_HOME>\CSAKit-4.5\Content
Archives\topology\vmware vcenter\petclinic\scripts.

5. petclinic.war - download this from Jenkins or wherever it is hosted internally

6. mysql-server_5.6.21-1ubuntu12.04_amd64.deb-bundle.tar - download this from
http://ftp.kaist.ac.kr/mysql/Downloads/MySQL-5.6/ or wherever it is hosted internally.

7. apache-tomcat-7.0.56.tar.gz - download this from http://tomcat.apache.org/download-
70.cgi or wherever it is hosted internally.

Youmust have an AWS template, which has the following tools installed:

l Template should have Ubuntu 12.04 or later

l JDK 1.7
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l libaio1

l unzip

l zip

l Port 8080 should be available (if it is in use, try disabling IPv6).

Service design components
The imported service design has 6 components: Amazon Server (number of servers: 2), MySQL
Database, Tomcat Application Server, PetClinicDB Conf, and PetClinic Application.

There is a 'dbDetails' relationship created between 'PetClinicDB' and 'PetClinic Application'.

PetClinic application that you deploy through this design performs the following steps:

1. Creates Amazon servers.

2. Deploys MySQL and Tomcat components on Amazon server.

3. Configures PetClinicDB Conf onMySQL.

4. Deploys PetClinic Application on Tomcat application server.

Service design customization
Amazon Server

Property Description

availabilityZone Enter the availabilityZone

amiId Enter the amiId (to be obtained from admin)

instanceNamePrefix Enter the instanceNamePrefix

keyName Enter the keyName (for example, Codar)

subnetId Enter the subnetId (to be obtained from admin)

instanceType Enter the instanceType (for example: small, medium)

securityGroupIds Enter the securityGroupIds (to be obtained from admin)

username Enter the username

password Enter the password

privateKey Enter the privateKey
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MySQL Database

Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUrl Enter the HTTP location whereMySQL database. That is where mysql-server_
5.6.21-1ubuntu12.04_amd64.deb-bundle.tar is located

artifactUsername Enter the user details for accessing HTTP location

configurationUrl Enter the HTTP location, where install_mysql.sh is located

installPath Enter installPath (could be blank)

privatekeyPath Enter privatekeyPath. For example,
C:\Users\Administrator\Downloads\CODAR.pem

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh install_mysql.sh

sshPort ssh Port. It can be 22

Tomcat Application Server

Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUrl Enter the HTTP location where apache-tomcat-7 is located. That is where
apache-tomcat-7.0.56.tar.gz is located

artifactUsername Enter the user details for accessing HTTP location

configurationUrl Enter the HTTP location, where install_tomcat.sh is located

installPath Enter the Tomcat install path including the Tomcat home directory name.For
example, /opt/tomcat7

privatekeyPath Enter privatekeyPath. For example,
C:\Users\Administrator\Downloads\CODAR.pem

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh install_tomcat.sh

sshPort ssh Port. It can be 22

PetClinic DB Conf
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Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUrl Enter the HTTP location where apache-tomcat-7is located. That is where
apache-tomcat-7.0.56.tar.gz is located

artifactUsername Enter the user details for accessing HTTP location

configurationUrl Enter the HTTP location, wheremysqldb_conf.sh is located

mysqlpassword Enter the password for MySQL database

mysqlusername Enter the user name for MySQL database

port It can be 22

privatekeyPath Enter the privatekeyPath. For example,
C:\Users\Administrator\Downloads\CODAR.pem

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh/tmp/mysqldb_conf.sh

PetClinic Application

Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUrl Enter the HTTP location where apache-tomcat-7is located. That is where
apache-tomcat-7.0.56.tar.gz is located

artifactUsername Enter the user details for accessing HTTP location

configurationUrl Enter the HTTP location, where mysqldb_conf.sh is located

localfilepath Enter the file name in local machine. It can be petclinic.war

port It can be 22

privatekeyPath Enter privatekeyPath. For example,
C:\Users\Administrator\Downloads\CODAR.pem

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh/tmp/mysqldb_conf.sh

Note: AWS template should not haveMySQL and Tomcat installed. If it is already installed, then
the design will fail because the port will be in use.

Content is validated only with IPv4.
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Formore information on content configuration, seeHP Codar Installation Guide (Software version 1.50)
 at http://h20230.www2.hp.com/selfsolve/manuals/.

PetClinic Application with Load Balancer
The CODAR_BP_PETCLINIC_APPLICATION_LOAD_BALANCER_v1.50.00 service design will be
installed if you select the Install Sample content option while installing HP Codar.

This service design demonstrates the topology scaling having Load Balancer with PetClinic Application
on vCenter servers. This application has a DB component installed onMySQL and an application
component installed on Tomcat server.

Service design name

CODAR_BP_PETCLINIC_APPLICATION_LOAD_BALANCER_v1.50.00.zip

Prerequisites
To use this design, you need to host the following files on aWeb Server ( Apache Server or aMaven
repository), which can be accessed using HTTP.

To host the files:

1. install_mysql.sh - This has to be downloaded from wherever it is hosted internally.

2. mysqldb_conf.sh - This has to be downloaded from wherever it is hosted internally.

3. install_tomcat.sh - This has to be downloaded from wherever it is hosted internally.

4. petclinic_jdbc_conf.sh - This has to be downloaded from wherever it is hosted internally.

5. loadbalancer_conf.sh - This has to be downloaded from wherever it is hosted internally.

Note: The above files can be found in <CSA_HOME>\CSAKit-4.5\Content
Archives\topology\vmware vcenter\petclinic\scripts.

6. petclinic.war - This has to be downloaded from Jenkins or wherever it is hosted internally.

7. mysql-server_5.6.21-1ubuntu12.04_amd64.deb-bundle.tar - This can be downloaded from
http://ftp.kaist.ac.kr/mysql/Downloads/MySQL-5.6/ or wherever it is hosted internally.

8. apache-tomcat-7.0.56.tar.gz - This can be downloaded from
http://tomcat.apache.org/download-70.cgi or wherever it is hosted internally.

9. httpd-2.4.12.tar.gz, pcre-8.35.tar.gz and tomcat-connectors-1.2.40-src.tar.gz
should be saved in the lb_artifact folder. Bundle it as a .tar.gz file (example: lb_
artifact.tar.gz) and this bundled file is internally hosted.
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httpd-2.4.12.tar.gz - This can be downloaded from
https://archive.apache.org/dist/httpd/.

pcre-8.35.tar.gz - This can be downloaded from
http://sourceforge.net/projects/pcre/files/pcre/8.35/.

tomcat-connectors-1.2.40-src.tar.gz - This can be downloaded from
https://archive.apache.org/dist/tomcat/tomcat-connectors/jk/.

Note: Downloaded <httpd-2.4.12.tar.gz> file should have the apr and apr-util folders
under the srclib folder.

If these folders aremissing, it can be downloaded from https://apr.apache.org/ and should be
bundled inside the srclib folder of httpd-2.4.12.tar.gz.

To use this partial design, you also need to fill in the followingmicro service designs:

l CODAR_BP_MYSQL_MICROSERVICE_v1.50.00.zip

l CODAR_BP_TOMCAT_STACK_MICROSERVICE_v1.50.00.zip

Create a vCenter template, which has the following tools installed:

l Template should have Ubuntu 12.04 or later

l JDK 1.7

l libaio1

l zip

l unzip

l Port 8080 should be available (if it is in use, try disabling IPv6).

Service design components
The imported service design has 6 components: Server, Application Server, Database Server which
requires composition, PetClinic DB Conf, PetClinic Application, and Apache Load Balancer.

There is a 'dbDetails' relationship created between PetClinic DB Conf and PetClinic Application.

There is a 'loadBalancer' relationship created between 'Apache Load Balancer' and 'PetClinic
Application'.

A scalable topology group called 'WebServerGroup' will be created and it will contain Petclinic
Application, Tomcat Server and its respective vCenter server. Instance Count can be set at
WebServerGroup.

PetClinic Application that you deploy through this design performs the following steps:
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1. Creates vCenter servers.

2. Deploys MySQL and Tomcat components on vCenter server.

3. Configures PetClinicDB onMySQL.

4. Deploys PetClinic Application on Tomcat Application Server.

5. Deploys Apache Load Balancer on vCenter server and Load Balancer manages the created
WebServerGroup.

Service design customization
The following components are part of the imported service design CODAR_BP_PETCLINIC_
APPLICATION_LOAD_BALANCER_v1.50.00

PetClinic DB Conf

Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUsername Fill in the user details for accessing HTTP location

configurationUrl Enter the HTTP location, where mysqldb_conf.sh is located

mysqlpassword Enter the password for MySQL database

mysqlusername Enter the user name for MySQL database

port It can be 22

privatekeyPath Enter privatekeyPath (could be blank)

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh/tmp/mysqldb_conf.sh

PetClinic Application

Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUrl Enter the HTTP location, where petclinic.war is located

configurationUrl Enter the HTTP location, where petclinic_jdbc_conf.sh is located

localfilepath Enter the file name in local machine. It can be petclinic.war
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Property Description

port It can be 22

privatekeyPath Enter privatekeyPath (could be blank)

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh/tmp/petclinic_jdbc_conf.sh

Apache Load Balancer

Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUrl Enter the HTTP location where lb_artifact.tar.gz is located

artifactUsername Enter the user details for accessing HTTP location

configurationUrl Enter the HTTP location, where loadbalancer_conf.sh is located

installPath This is optional property

port It can be 22

privatekeyPath Enter privatekeyPath (could be blank)

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be bash loadbalancer_conf.sh

Database Server

Application Server

Server

Note: vCenter template should not haveMySQL and Tomcat installed. If it is already installed,
then the design will fail because the port will be in use by running Tomcat server.

Remove the values in Privatekey and password (by default, the user name and password will be
he same as in the template).

Content is validated only with IPv4.

For more information on content configuration, seeHP Codar Installation Guide (software version 1.50)
 at http://h20230.www2.hp.com/selfsolve/manuals/.
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PetClinic Application on Existing Servers
The CODAR_BP_PETCLINIC_APPLICATION_ON_AN_EXISTING_INFRA_v1.50.00.zip service
design will be installed if you select the Install Sample content option while installing HP Codar.

This service design demonstrates how to deploy a two-tier PetClinic application using the Existing
Infrastructure components. This two-tier application has a DB component installed onMySQL and an
App component installed on Tomcat.

Service design name: CODAR_BP_PETCLINIC_APPLICATION_ON_AN_EXISTING_INFRA.zip

Prerequisites
To use this content archive, you need to host the following files on aWeb Server (Apache Server or a
Maven repository), which can be accessed using HTTP.

1. install_mysql.sh - this has to be downloaded from wherever it is hosted internally.

2. mysqldb_conf.sh - this has to be downloaded from wherever it is hosted internally.

3. install_tomcat.sh - this has to be downloaded from wherever it is hosted internally.

4. petclinic_jdbc_conf.sh - this has to be downloaded from wherever it is hosted internally.

Note: The above files can be found in <CSA_HOME>\CSAKit-4.5\Content
Archives\topology\vmware vcenter\petclinic\scripts.

5. petclinic.war - this has to be downloaded from Jenkins or wherever it is hosted internally.

6. mysql-server_5.6.21-1ubuntu12.04_amd64.deb-bundle.tar - this can be downloaded from
http://ftp.kaist.ac.kr/mysql/Downloads/MySQL-5.6/ or wherever it is hosted internally.

7. apache-tomcat-7.0.56.tar.gz - this can be downloaded from
http://tomcat.apache.org/download-70.cgi or wherever it is hosted internally.

Youmust have vCenter virtual machines, which have following tools installed:

l Ubuntu 12.04 or later

l JDK 1.7

l libaio1

l unzip

l zip
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Service design components
Service design imported has 6 components: Existing Infrastructure (number of existing Infrastructure:
2), MySQLDatabase, Tomcat, PetClinicDB Conf, and PetClinic Application.

There is a 'databaseConnection' relationship created between 'PetClinicDB' and 'PetClinic
Application'.

PetClinic application that you deploy through this design performs the following steps:

1. Accesses IP Address of the existing servers.

2. Deploys MySQL and Tomcat components on Existing server.

3. Configures PetClinicDB onMySQL.

4. Deploys PetClinic Application on Tomcat Application Server.

Service design customization
Existing Infrastructure

Property Description

IPADDRESS Enter the IP address of amachine which has JDK 1.7, libaio1, unzip and zip

password/privateKey Either one can be used. Enter the password of the server or the private key
for secure SSH access.

username Enter the user name for SSH access to the server deployed

MySQL Database

Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUrl Enter the HTTP location where apache-tomcat-7 is located. That is where
apache-tomcat-7.0.56.tar.gz is located

artifactUsername Enter the user details for accessing HTTP location

configurationUrl Enter the HTTP location, where install_tomcat.sh is located

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh install_tomcat.sh

sshPort ssh Port. It can be 22
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PetClinic DB Conf

Property Description

configurationUrl Enter the HTTP location where mysqldb_conf.sh is located

mysqlpassword Enter the password for MySQL database

mysqlusername Enter the user name for MySQL database

port It can be 22

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh/tmp/mysqldb_conf.sh

PetClinic Application

Property Description

artifactUrl artifactUrl

configurationUrl Enter the HTTP location, where petclinic_jdbc_conf.sh is located

localfilepath Enter the file name in local machine. It can be petclinic.war

port It can be 22

remoteFilePath Enter the path on the server. For example, it can be /tmp/

Note: The existing server should not haveMySQL and Tomcat installed. If it is already installed,
then the design will fail because the port will be in use.

Content is validated only with IPv4.

For more information on content configuration, seeHP Codar Installation Guide (software version 1.50)
 at http://h20230.www2.hp.com/selfsolve/manuals/.

PetClinic Application on vCenter
The CODAR_BP_VCENTER_PETCLINIC_APPLICATION_v1.50.00 service design will be installed
if you select the Install Sample content option while installing HP Codar.

Service design name: CODAR_BP_VCENTER_PETCLINIC_APPLICATION_v1.50.00.zip

Content Pack User Guide
Application designs for HP Codar

HP Cloud Service Automation (4.50) Page 250 of 277

http://h20230.www2.hp.com/selfsolve/manuals/


Prerequisite
To use this design, youmust host the following files on aWeb Server ( Apache Server or aMaven
repository), which can be accessed using HTTP.

To host the files:

1. install_mysql.sh - this has to be downloaded from wherever it is hosted internally.

2. mysqldb_conf.sh - this has to be downloaded from wherever it is hosted internally.

3. install_tomcat.sh - this has to be downloaded from wherever it is hosted internally.

4. petclinic_jdbc_conf.sh - this has to be downloaded from wherever it is hosted internally.

Note: The above files can be found in <CSA_HOME>\CSAKit-4.5\Content
Archives\topology\vmware vcenter\petclinic\scripts.

5. petclinic.war - this has to be downloaded from Jenkins or wherever it is hosted internally.

6. mysql-server_5.6.21-1ubuntu12.04_amd64.deb-bundle.tar - this can be downloaded from
http://ftp.kaist.ac.kr/mysql/Downloads/MySQL-5.6/ or wherever it is hosted internally.

7. apache-tomcat-7.0.56.tar.gz - this can be downloaded from
http://tomcat.apache.org/download-70.cgi or wherever it is hosted internally.

Youmust have a vCenter template, which has the following tools installed:

l Template should have Ubuntu 12.04 or higher

l JDK 1.7

l libaio1

l unzip

l zip

l Port 8080 should be available (if it is in use, try disabling IPv6).

Service design components
Service design imported has 6 components: vCenter Server (number of servers: 2), MySQLDatabase,
Tomcat Application Server, PetClinicDB Conf, and PetClinic Application.

There is a 'databaseConnection' relationship created between 'PetClinicDB' and 'PetClinic
Application'.
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PetClinic Application that you deploy through this design performs the following steps:

1. Creates vCenter servers.

2. Deploys MySQL and Tomcat components on vCenter Server.

3. Configures PetClinicDB onMySQL.

4. Deploys PetClinic Application on Tomcat Application Server.

Service design customization
vCenter Server

Property Description

CustomizationSpec Enter the customization specification (to be obtained from admin)

memorySize Enter thememory size

password Enter the password (to be obtained from admin)

privateKey Enter the private key (not required generally, could be blank)

username Enter the username (to be obtained from admin)

vmFolder Enter the vmFolder

vmNamePrefix Enter the vm name prefix (for example, db and app)

vmTemplateReference Enter vmTemplateReference (to be obtained from admin)

cpuCount Enter CPU count

MySQL Database

Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUrl Enter the HTTP location whereMySQL database is located. That is where
mysql-server_5.6.21-1ubuntu12.04_amd64.deb-bundle.tar is located

artifactUsername Enter the user details for accessing HTTP location

configurationUrl Enter the HTTP location, where install_mysql.sh is located

installPath Enter installPath (could be blank)

privatekeyPath Enter privatekeyPath (could be blank)
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Property Description

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh install_mysql.sh

sshPort ssh Port. It can be 22

Tomcat Application Server

Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUrl Enter the HTTP location, where apache-tomcat-7 is located. That is where
apache-tomcat-7.0.56.tar.gz is located.

artifactUsername Enter the user details for accessing HTTP location

configurationUrl Enter the HTTP location, where install_tomcat.sh is located

installPath Enter the tomcat install path including the tomcat home directory name. For
example, /opt/tomcat7

privatekeyPath Enter privatekeyPath (could be blank)

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh install_tomcat.sh

sshPort ssh Port. It can be 22

PetClinic DB

Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUrl Enter the HTTP location where apache-tomcat-7 is located. That is where
apache-tomcat-7.0.56.tar.gz is located

artifactUsername Enter the user details for accessing HTTP location

configurationUrl Enter the HTTP location, where mysqldb_conf.sh is located

mysqlpassword Enter the password for MySQL database

mysqlusername Enter the user name for MySQL database

port It can be 22
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Property Description

privatekeyPath Enter privatekeyPath (could be blank)

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh/tmp/mysqldb_conf.sh

PetClinic Application

Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUrl Enter the HTTP location, where petclinic.war is located

artifactUsername Enter the user details for accessing HTTP location

configurationUrl Enter the HTTP location, where petclinic_jdbc_conf.sh is located

localfilepath Enter the file name in local machine. It can be petclinic.war

port It can be 22

privatekeyPath Enter privatekeyPath (could be blank)

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh/tmp/petclinic_jdbc_conf.sh

The PetClinic Application component has modify action for Redeploy feature.

Redeploy content creation
This section explains how to enable theModify action for a component.

Flows

The individual flows are placed under the version folder. The name of a flow is used automatically as an
operation name in the new component. The flow name is important for recognition of the lifecycle phase
related to the operation.

EachOO flow should have an input property defined as a constant called LIFECYCLE_PHASE. The
property does not relate to the flow logic. It is used as meta-informationmarking the flow’s purpose
related to the component lifecycle.

As you can see, there is a duplicate indicator of the operation lifecycle phase. Both the flow name
(beginning of the name in fact) and LIFECYCLE_PHASE input property need to be set appropriately.
This duplication will be removed in a future release. Currently, the flow name and the value of the
constant property should be set as follows:
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Flow Purpose
Flow Name
Prefix

LIFECYCLE_
PHASE

Deployment Deploy or Create deploying

Undeployment Undeploy or
Delete

undeploying

Modification Modify modifying

Undo a successful modification Unmodify unmodifying

Handle a failure during deployment deploying_failure

Handle a failure during undeployment deploying_failure

Handle a failure duringmodification Modify Failure deploying_failure

Custom public action executable on a deployed
instance

deployed

Input and Output Properties

OO server automatically decorates all flows with aResult output property. However, it is suggested to
define flow outputs explicitly as output properties.

l response –Mandatory property. EachOO flow used in a component operation should have a
response output property. HP Codar relies on the response property to determine the state of the
execution.

n For deployment, undeployment flows and flows related to public actions, the value should be
either success or failure based on flow execution response.

n ForModify flow, the value should be success, noop or failure.

success indicates that the attemptedmodification was successful.

noop indicates that no action was taken that would affect the component state or properties.

failure indicates that the attemptedmodification unsuccessful.

ForUnmodify, flow should overwrite the response property to failure if the unmodify failed and to
noop if Unmodify succeeded to indicate that from an overall component point of view the
component state and property values are unaffected due tomodify transition.Modify Failure flow
should set the response property to always failure indicate the failure tomodify this component.

n If you include the deploy failure handler and/or undeploy failure handler, make sure that the
response is being set correctly. The fact that these actions are called should result in the failure
response.

l result –Optional property. EachOO flow used in a component operation should have a result output
property. It can hold any contextual message, like detailed info about failure.

Content Pack User Guide
Application designs for HP Codar

HP Cloud Service Automation (4.50) Page 255 of 277



HP Codar 1.50 supports themodification of properties on an active subscription. HP Codar will pass
previous property values tomodification OO flows if the flows explicitly express interest in knowing
these values - by defining additional flow inputs with a prev_ prefix. As an example, if themodification
OO flow defines an input of memorySize and is interested in knowing its previous value, it must also
define an input of prev_memorySize.

Illustrated in the picture below are the artifacturl and configurationurl properties that the flow has
expressed interest in knowing previous values. This is denoted by an icon next to the property
name in the HP Codar Topology Components view.

Note that the prev_OO flow inputs do not show up as properties on the component; only their un-
prefixed counterparts show up and are appropriately marked. However, the prev_OO flow inputs do
show up onOperations’ Input Parameter Mapping. Thesemappings are used by themodification
operation andmust not be edited from the Component Editor.
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A component’s Modify flow may communicate the status of themodification, an error code or any other
useful information toModify Failure flow by placing such information in an output field called
modifyReturnValue. This valuemay be received by theModify Failure flow in an input field called
modifyFailureValue and allows theModify Failure flow to do cleanup the effect of failure inModify flow
intelligently, especially for a complex multi-step flows when failuremight have occurred at any step
which can be indicated by returning specific error code from theModify flow viaModifyReturnValue. If
these fields are set on the OO flows, themapping between them is automatically handled within
HP Codar andmust not bemodified from the Component Editor.

Note: vCenter template should not haveMySQL and Tomcat installed. If it is already installed,
then the design will fail because port will be in use by the already existing Tomcat server.

Remove the values in Privatekey and password (by default, the user name and password will be
the same as in template).

Content is validated only with IPv4.

For more information on content configuration, seeHP Codar Installation Guide at
http://h20230.www2.hp.com/selfsolve/manuals/.

PetClinic Application
This service design demonstrates how to deploy a two-tier partial PetClinic Application using vCenter.
This two-tier application has Database Server and Application Server requirement. Another service
design provides the infrastructure for the partial PetClinic application, this infrastructure design has
MySQL component, which serves as Database Server and Tomcat component which serves as the
Application Server both hosted on vCenter servers.
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Folder contents

l Service design content archive

CSA_BP_PETCLINIC_TWO_TIER_INFRASTRUCTURE_v1.50.00.zip

CSA_BP_PETCLINIC_APPLICATION_v1.50.00.zip

l Scripts

Scripts path: <CSA_HOME>\CSAKit-4.5\Content Archives\topology\vmware
vcenter\petclinic\scripts

install_mysql.sh

install_tomcat.sh

mysqldb_conf.sh

petclinic_jdbc_conf.sh

Prerequisites
To use this design, you have to host the following files on aWeb Server ( Apache Server or aMaven
repository), which can be accessed using HTTP.

To host the service design:

1. install_mysql.sh - this has to be downloaded from wherever it is hosted internally.

2. mysqldb_conf.sh - this has to be downloaded from wherever it is hosted internally.

3. install_tomcat.sh - this has to be downloaded from wherever it is hosted internally.

4. petclinic_jdbc_conf.sh - this has to be downloaded from wherever it is hosted internally.

5. petclinic.war - this has to be downloaded from Jenkins or wherever it is hosted internally.

6. mysql-server_5.6.21-1ubuntu12.04_amd64.deb-bundle.tar - this can be downloaded from
http://ftp.kaist.ac.kr/mysql/Downloads/MySQL-5.6/ or wherever it is hosted internally.

7. apache-tomcat-7.0.56.tar.gz - this can be downloaded from
http://tomcat.apache.org/download-70.cgi or wherever it is hosted internally.

Youmust have an Ubuntu 12.04 vCenter template, which has following packages installed:

l JDK 1.7

l libaio1

Content Pack User Guide
Application designs for HP Codar

HP Cloud Service Automation (4.50) Page 258 of 277



l unzip

l zip

Youmust configure the following:

1. For users other than 'root' should have home directory. This is required for logging into the target
system and expects home directory to be present.

2. For sudo users the password prompt should be disabled for running the shell commands. This is
required because the system will try to perform silent installation of packages and does not expect
any prompts. If there is any prompts thenOO flow execution will be halted and will fail.

Service design components
The imported PetClinic Application service design as 4 components: PetClinic Application, PetClinic
DB Conf, Database Server, and Application Server. Database Server is the capability components
with MySQL 5.6 requirement, and Application Server is the capability components with Tomcat 7
requirement.

Two Tier Infrastructure with MySQL and Tomcat service design imported has 4 components: MySQL,
Tomcat, and vCenter Server (number of servers: 2).

PetClinic Application needs the infrastructure design for deployment. The test run wizard will list the
matching infrastructure design and will have the PetClinic Two Tier Infrastructure service design listed.

PetClinic Two Tier Infrastructure performs the following actions:

1. Deploys the vCenter servers.

2. Deploys MySQL and Tomcat components on vCenter Server.

3. Configures PetClinic Database onMySQL.

4. Deploys PetClinic Application on Tomcat Application Server.

Service design customization
PetClinic Application

Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUrl Enter the HTTP location, where petclinic.war is located

artifactUsername Enter the user details for accessing HTTP location
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Property Description

configurationUrl Enter the HTTP location, where petclinic_jdbc_conf.sh is located

localfilepath Enter the file name in local machine. It can be petclinic.war

port SSH Port. Default is 22

privatekeyPath Leave it blank

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh/tmp/petclinic_jdbc_conf.sh

PetClinic DB Conf

Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUsername Enter the user details for accessing HTTP location

configurationUrl Enter the HTTP location, where mysqldb_conf.sh is located

mysqlpassword Enter the password for MySQL database

mysqlusername Enter the user name for MySQL database

port SSH Port. Default is 22

privatekeyPath Leave it blank

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh/tmp/mysqldb_conf.sh

MySQL Database

Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUrl Enter the HTTP location, whereMySQL database is located. That is where
mysql-server_5.6.21-1ubuntu12.04_amd64.deb-bundle.tar is located

artifactUsername Enter the user details for accessing HTTP location

configurationUrl Enter the HTTP location, where install_mysql.sh is located

installPath Leave it blank
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Property Description

privatekeyPath Leave it blank

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh install_mysql.sh

sshPort SSH Port. Default is 22

Tomcat Application Server

Property Description

artifactPassword Enter the password for accessing HTTP location

artifactUrl Enter the HTTP location, where apache-tomcat-7. That is where apache-
tomcat-7.0.56.tar.gz is located

artifactUsername Enter the user details for accessing HTTP location

configurationUrl Enter the HTTP location, where install_tomcat.sh is located

installPath Enter the tomcat install path including the tomcat home directory name.For
example, /opt/tomcat7

privatekeyPath Leave it blank

remoteFilePath Enter the path on the server. For example, it can be /tmp/

serviceCommand It should be sh install_tomcat.sh

sshPort SSH Port. Default is 22

vCenter Server

Property Description

customizationSpec Enter the customization spec value for the vCenter template

vmTemplateReference Enter the Ubuntu VM Template name

vmNamePrefix Enter the VM name prefix

password/privateKey Either one can be used. Enter the password of the server or the private key
for secure SSH access.

username Enter the user name for SSH access to the server deployed

Note: vCenter server should not haveMySQL and Tomcat installed. If it is already installed then
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the designmight fail because port will be in use.

Remove the values in privatekey and password (by default the user name and password is the
same as in template).

Content is validated only with IPv4.

For more information on content configuration, seeHP Codar Installation Guide (Software version 1.50)
 at http://h20230.www2.hp.com/selfsolve/manuals/.
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Appendix A: Troubleshooting

Manual cleanup in HP OneView if automatic cleanup
fails
l Remove the server profile.

l Remove all labels on the server except organization-specific labels.

l Restore the hpcsaUNASSIGNED label on the server.

Build plan deployment fails
l Validate build plans before importing them as components to HP CSA. Ensure that the network
used by HP ICsp for deployment is specified in the server profile. Additional networks may be
included but, this network must be present in the server profile to allow the server to register itself
with HP ICsp.

l For non-blade servers, ensure that the network connectivity of the server to the HP ICsp network
including vLAN configuration and physical cabling.

l RHEL6.x server deployments with boot and data disks require the “ignoredisk” setting in the
HP ICsp kickstart file.

For example, ignoredisk --only-use=sda

l Windows deployments fail with multipath configuration. Boot disk must have single path to SAN.

For information about potential solutions, visit http://support.microsoft.com/kb/2826787.

l Failed HP ICspOS build plans can take up to 3 hours for the HP ICsp job to timeout. HP CSA
returns a failure status before the workflow fails. Canceling the OS build plan jobmanually in
HP ICsp will allow service to clean up without having to wait for HP ICsp timeout.

Server profile copy fails
Using special characters in server profile names can cause the profile copy to fail. Rename the server
profiles using only alphanumeric, dash and underscore. Reimport your profile after renaming the server.
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Deployments fail due to HP CSA timeout
The default timeout for a topology design is 7200minutes (2 hours). This value is set in the
csa.properties file on the HP CSA server as TopologyDesignProvisioning.TIMEOUT=7200. If you
modify this file, youmust restart the csa service.

Missing HP Operations Orchestration content packs
If the HP OneView and HP ICsp content are not installed automatically by the installer, verify that OOS_
URL, OOS_USERNAME, and OOS_PASSWORD parameters are not commented out and they are properly set in
the csa.properties file.

For more information about missing HP Operations Orchestration content packs, seeHP Cloud
Service Automation Installation guide at HP Software Support.
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Appendix B: Disabling virtual WWNs in
HP OneView
To disable virtual WWN allocation in HP OneView, complete the following steps:

1. Go to the OneView User Interface, and then click the OneView menu.

2. Click Settings, and then click Edit to the right side of Addresses and Identifiers.

3. Clear theEnable Virtual check box underWorldWide Names as shown in the following figure.
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Appendix C: Creating temporary server profiles
to discover WWPN of HBAs
Onemethod to capture the physical WWPN is to create a server profile for each blade you wish to
make available to HP CSA for provisioning. This server profile is temporary and is only used to
determine theWWPN to use when creating and presenting the storage with your storagemanagement
tool.

There aremore direct means of obtaining theWWPN of each of your servers; however, this technique
can be used to quickly create and apply profiles to servers (in bulk) without the need of catching the
adapter bios during boot or other similar methods that make it difficult to perform for more than one or
two servers.

The following steps explain how to create server profiles and capture theWWPN:

1. Select the firmware appropriate for your environment.

2. Assign the server profile to a specific server.

3. In the Add Connection dialog box, enter the following information:

n Name

n Device type

n Network

n Port

n In the Boot drop down list, select Primary or Secondary

n Select the Use Adapter BIOS option
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4. Click Add to add the connection.

5. Leave Local Storage andSAN Storage unchecked. Make the selection as appropriate.

6. TheAdvanced option will show that WWN addresses are set to Physical.
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Once the server profile has been applied to the blade, theWWPN is visible. Use your storage
management tool to present a LUN to theWWPN shown for each Fibre Channel port in the
Connections section as shown in the following figure.

7. Note theWWPN value and use that to present storage to the server from your externally managed
storage device. After you have provisioned the storage, delete the server profile in HP OneView.

Note: It is important to be sure that you delete the temporary profiles to prevent these useless
profiles from appearing in the list of profiles that can be imported into HP CSA as
components.
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Appendix D: Prepare ICsp OS Build Plan to work
with Chef
In HP CSA 4.20, Chef cookbooks could be installed on topology components that fulfilled the Server
Capability such as vCenter Server, Amazon Server, or other VM type servers through the use of VM
templates as discussed in the HP CSA Topology Components Guide. With the addition of the HP
Insight Control server provisioning (HP ICsp) integration in HP CSA 4.50, a similar approach can be
employed for physical servers provisioned by HP ICspOS Build Plan (OSBP) components.

This section covers the process of creating and configuring aOSBP for use in a Chef environment.
Typical examples of additional configuration necessary to prepare aOSBP to work with Chef include:

l proxy settings

l yum/apt-get installation and configuration

l wget installation and configuration

Currently, only Linux OS build plans are supported for use together with Chef components. Most of the
Chef cookbooks are written to work with apt-get or yum, so it is recommended to use Ubuntu and
RHELOS distributions. Theoretically, any Linux OS build should work as long as it provides required
tools and satisfies cookbook requirements.

Note: The HP ICsp appliance comes pre-packaged with OSBPs that perform scripted installations
of Red Hat Linux and SUSE Linux. Currently, it does not haveOSBPs that allow the capture of
Linux system images and the deployment of those images back to target servers. If you wish to
create an Image basedOSBP or CentOS OSBP to work with Chef, see the following documents
at http://hp.com/go/insightcontrol/docs for your respective version of HP ICsp for details:

l HP Insight Control Server Provisioning Administrator Guide

l HP Insight Control Server Provisioning Build Plans Reference

l HP Insight Control server provisioning Capturing and Installing Red Hat Enterprise Linux 7
System Images

l HP Insight Control server provisioning Capturing and Installing Red Hat Enterprise Linux 6
System Images

l HP Insight Control server provisioning Capturing and Installing SUSE Enterprise Linux 11
System Images

l HP Insight Control server provisioning How to Create anOS Build Plan for Installing CentOS

Steps to customize a scripted OS build Plan are the following:
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1. First, copy the HP providedOS Build Plan and possibly the related configuration file (for example,
the kickstart file for RHEL installs) associated with the build plan you would like to customize. HP
provided build plans and configuration files are read-only so youmust use the 'Save As' action to
obtain an editable copy.

2. Add postinstall steps to perform the same types of customizations discussed for VM Templates in
theHP CSA Topology Components Guide. Use the instructions in that guide, but instead of
performing the steps manually and snapshotting a VM Template, youmust script the steps in your
copied build plan as (new) build plan steps or can leave the steps as-is andmodify the copied
configuration file (for example, in a%post section in the kickstart file).

For example, to configure the proxy, instead of adding a line like this into the .bashrc file in the
root home directory of a system that already has anOS installed:

export ftp_proxy=http://your.proxy:8080/

You would instead add a line like this to a script or to the kickstart file:

echo “export ftp_proxy=http://your.proxy:8080/” >> /root/.bashrc

3. If you choose to create an image basedOS build plan, you can follow the instructions in theHP
CSA Topology Components Guide related to customizing VM Templates. The steps for creating
an image is similar to the process of creating the VM template.
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Appendix E: Deprecated contents
The following service designs and HP Operations Orchestration content packs have been deprecated.
HP CSA 4.50 and HP Codar 1.50 are the last releases that will support this content. The content will
not be included in future releases. The equivalent content that is available from the HP Cloud Content
Capsule Installer should be used instead. You can access the HP Cloud Content Capsule Installer
from the Tools/CSLContentInstaller directory after installing HP CSA or HP Codar.

Content Location

CSA_BP_MOE_COMPUTE_ADM_SITESCOPE_
UCMDB_v3.20.00.zip

CSAKit-4.5/Content
Archives/sequenced/matrix operating
environment/

CSA_BP_MOE_COMPUTE_ADM_v3.20.00.zip

CSA_BP_MOE_COMPUTE_CUSTOM_PROVIDER_
SELECTION_v3.20.00.zip

CSA_BP_MOE_COMPUTE_DMA_JBOSS_
SITESCOPE_UCMDB_v3.20.00.zip

CSA_BP_MOE_COMPUTE_DMA_JBOSS_
v3.20.00.zip

CSA_BP_MOE_COMPUTE_MT_v3.20.00.zip

CSA_BP_MOE_COMPUTE_SITESCOPE_UCMDB_
v3.20.00.zip

CSA_BP_MOE_COMPUTE_SOAPV4_v3.20.00.zip

CSA_BP_MOE_COMPUTE_STANDALONE_DMA_
JBOSS_v3.20.00.zip

CSA_BP_MOE_COMPUTE_v3.20.00.zip

CSA_BP_NA_VIRTUAL_NETWORK_v3.20.00.zip CSAKit-4.5/Content
Archives/sequenced/network automation/

CSA_BP_OPENSTACK_HPCS_COMPUTE_
v3.20.00.zip

CSAKit-4.5/Content
Archives/sequenced/openstack/
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Content Location

CSA_BP_VCENTER_COMPUTE_ADM_SITESCOPE_
UCMDB_v3.20.00.zip

CSAKit-4.5/Content
Archives/sequenced/vmware vcenter/

CSA_BP_VCENTER_COMPUTE_ADM_
v3.20.00.zip

CSA_BP_VCENTER_COMPUTE_CASCADED_
OPTIONS_v3.20.00.zip

CSA_BP_VCENTER_COMPUTE_CUSTOM_POOL_
SELECTION_v3.20.00.zip

CSA_BP_VCENTER_COMPUTE_DEPENDENT_
OPTIONS_v3.20.00.zip

CSA_BP_VCENTER_COMPUTE_DMA_JBOSS_
SITESCOPE_UCMDB_v3.20.00.zip

CSA_BP_VCENTER_COMPUTE_DMA_JBOSS_
v3.20.00.zip

CSA_BP_VCENTER_COMPUTE_DYNAMIC_
OPTIONS_v3.20.00.zip

CSA_BP_VCENTER_COMPUTE_FAILURE_
HANDLING_v3.20.00.zip

CSA_BP_VCENTER_COMPUTE_MODIFY_
v3.20.00.zip

CSA_BP_VCENTER_COMPUTE_SA_SOFTWARE_
POLICIES_v3.20.00.zip

CSA_BP_VCENTER_COMPUTE_SITESCOPE_
MODIFY_v3.20.00.zip

CSA_BP_VCENTER_COMPUTE_SITESCOPE_
UCMDB_v3.20.00.zip

CSA_BP_VCENTER_COMPUTE_STANDALONE_DMA_
JBOSS_v3.20.00.zip

CSA_BP_VCENTER_COMPUTE_v3.20.00.zip

CSA_BP_AMAZON_EC2_INFRA_v4.10.00.zip CSAKit-4.5/Content
Archives/topology/amazon ec2

CSA_BP_VCENTER_COMPUTE_v4.10.00.zip CSAKit-4.5/Content
Archives/topology/vmware vcenter/

CSA_BP_VCENTER_HPSA_LAMP_STACK_
v4.10.00.zip
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Content Location

oo10-csa-cp-4.50.0000.jar CSAKit-4.5/OO Flow Content/10X/

CSA-4_10-ContentInstaller.jar CSAKit-4.5/OO Flow Content/9X
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Additional resources
l HP CSA, HP Server Automation, HP Network Automation, Database andMiddleware Automation,
Operations Orchestration, Universal CMDB, ServiceManager, SieScope, HP vPV, HP Codar

http://h20230.www2.hp.com/selfsolve/manuals

You need to log on to HP Software Support using your HP Passport credentials. On the Home
page, select Dashboard >Manuals. Select the product and in theSearch for Answers field, enter
the search criteria, and then click theSearch icon. Matching results will be displayed.

l HP Live Network Portal

hpln.hp.com/solutions

l VMware vCenter documentation

http://www.vmware.com/support/pubs/

l RedHat Enterprise Linux documentation

https://access.redhat.com/knowledge/docs/

l HP Developer Resource Center for CloudSystem (for accessing other toolkits to design and extend
cloud services running on HP CloudSystem)

http://www.hp.com/go/csdevelopers

Content Pack User Guide
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on Content Pack User Guide (Cloud Service Automation 4.50)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to cse.docs@hp.com.

We appreciate your feedback!

HP Cloud Service Automation (4.50) Page 276 of 277

mailto:cse.docs@hp.com?subject=Feedback on Content Pack User Guide (Cloud Service Automation 4.50)



	Introduction
	Steps to import content packs to HP CSA
	User credentials
	Documentation

	Amazon AWS
	Configuring Amazon Web Services
	Use case: Amazon EC2 (Topology)
	Configuration requirements
	Configuring service offerings
	Creating resource providers
	Publishing topology design
	Creating service offering
	Publishing service offering to Global Shared Catalog

	Subscribing  service
	Canceling a subscription


	Use case: Amazon AWS Integration (Sequenced)
	Configuration requirements
	Configuring service offerings
	Creating resource providers
	Configuring subscriber options
	Adding resource pool
	Associating resource offerings with providers
	Creating credentials and system variables
	Publishing service design
	Creating service offering
	Publishing service offering to Global Shared Catalog

	Subscribing service
	Canceling a subscription

	HP Operations Orchestration flows
	Limitations


	HP Database and Middleware Automation
	Installing HP Database and Middleware Automation
	Configuring HP Database and Middleware Automation
	Use case: Provision JBoss on vCenter Compute (Sequenced)
	Configuration requirements
	HP DMA solution packs
	Downloading solution packs

	Configuring HP DMA for provisioning JBoss
	Copying workflows
	Creating policies
	Creating deployments

	Importing binary archives into HP Server Automation library
	Configuring service offerings
	Configuring resource offerings for HP DMA 10.30
	Configuring subscriber options
	Creating resource providers
	Associating resource offerings with providers
	Changing component properties
	Publish service design
	Creating service offering
	Configuring consumer organization
	Publishing service offering to Global Shared Catalog

	Subscribing service
	Accessing JBoss Console
	Canceling a subscription

	Limitation


	HP Matrix Operating Environment
	Installing HP Matrix Operating Environment
	Configuring HP Matrix Operating Environment
	Use case: HP Matrix Operating Environment Integration (Sequenced)
	About HP MOE
	Configuration requirements
	Configuring service offerings
	Configuring subscriber options
	Creating resource providers
	Associating resource offerings with providers
	Publishing service design
	Creating service offering
	Publishing service offering to Global Shared Catalog

	Subscribing service
	Canceling a subscription

	HP Operations Orchestration flows
	Limitations


	HP Network Automation
	Installing HP Network Automation
	Configuring HP Network Automation
	Use case: Provision VLAN using Network Automation (Sequenced)
	Configuration requirements
	Configuring vSphere Distributed Switch in vCenter
	Adding hosts to a vSphere Distributed Switch
	Adding a distributed port group
	Downloading and configuring a virtual service router
	Configuring user access via SSH
	Configuring IPs
	Configuring ACLs
	Adding a distributed port group to a virtual service router
	Adding device groups
	Adding devices
	Importing command scripts
	Enabling custom field option in HP NA

	Downloading distribution files
	Configuring service offerings
	Creating resource providers
	Associating resource offerings with providers
	Changing component properties
	Publishing service design
	Creating service offering
	Publishing service offering to Global Shared Catalog

	Subscribing service
	Canceling a subscription



	HP OneView and HP Insight Control server provisioning
	Use case: OneView and ICsp Topology Integration
	Prerequisites
	HP Insight Control server provisioning setup
	Limitations of HP ICsp

	HP OneView setup
	Create a server profile template
	Managing local storage with HP OneView
	HP OneView externally managed SAN storage configuration for blade servers
	HP OneView local and externally managed SAN storage configuration for rack mo...
	HP OneView Managed SAN storage configuration


	Solution installation
	Out-of-the-box-installation
	Manual installation

	Solution configuration
	Managing server availability
	HP OneView label usage
	Creating HP OneView labels
	Manual label process
	Additional labels used by provisioning process

	Setting properties in Operations Orchestration Central
	Creating providers
	Managing Appliance Certificates

	Creating service designs and offerings
	Importing components
	Creating simple IaaS service design
	Testing designs

	Creating service designs with HP ICsp custom attributes
	Creating service design including Chef component
	Creating service offerings

	Deploying a service
	Ordering and managing the service from the CSA Marketplace Portal

	Known issues

	OpenStack
	Use case: OpenStack content (Sequenced)
	Configuration requirements
	Configuring service offerings
	Creating resource providers
	Configuring property file
	Service designs
	Associating resource offerings with providers
	Publishing service design
	Creating service offering
	Publishing service offering to Global Shared Catalog

	Subscribing service
	Canceling a subscription

	HP Operations Orchestration flows
	Set up an attached volume
	Use SSH to connect to your server
	Format the volume
	Mount the volume

	Multi-tenancy support
	Verify secondary authentication

	Limitations
	Troubleshooting

	Use case: OpenStack Topology
	Supported OpenStack API versions
	Configuration requirements

	Configuring service offerings
	Configuring organization and catalog
	Creating resource providers
	Service designs
	Publishing service design
	Creating service offering
	Publishing service offering to Global Shared Catalog

	Subscribing service
	Modifying subscription
	Canceling subscription

	Multi-tenancy support
	Verifying secondary authentication

	Setting up attached volume
	OpenStack topology components
	OpenStack External Network
	OpenStack Private Network
	OpenStack Router
	OpenStack Floating IP
	OpenStack Security Group
	OpenStack Network Interface
	OpenStack Server
	OpenStack Load Balancer
	OpenStack Volume
	OpenStack Swift container

	Limitations
	Known issues
	Troubleshooting


	Provider Go Active
	Use case: Verify provider communication (CSA Provider Go Active)
	Service design
	Creating service offering
	Publishing service offering to Admin only catalog
	Subscribing service
	Canceling a subscription



	HP Server Automation
	Installing HP Server

	HP Service Manager
	Use case: HP Service Manager as an external approval system (Sequenced)
	Installing HP Service Manager
	HP Service Manager account prerequisites
	Configuring HP Service Manager
	Configuring SM OO system properties
	Configuring external approval
	Configuring HP SM LDAP (Active Directory) integration
	HP SM execution order
	Limitation


	HP SiteScope and HP Universal CMDB
	Installing HP SiteScope
	Configuring HP SiteScope
	Installing HP Universal CMDB
	Configuring HP Universal CMDB

	HP Virtualization Performance Viewer
	Configuring HP vPV
	Enabling Statistics Level 2 configurations in VMware vCenter

	VMware vCenter
	Installing and configuring VMware vCenter
	Use case: VMware vCenter Compute (Sequenced)
	Configuration requirements
	Configuring service offerings
	Configuring subscriber options
	Creating resource providers
	Associating resource offerings with providers
	Changing component properties
	Publishing the service design
	Creating service offering
	Publishing service offering to Global Shared Catalog

	Subscribing service
	Canceling a subscription

	HP Operations Orchestration flows
	Limitation

	Use case: VMware vCenter Topology
	Configuration requirements
	Configuring service offerings
	Creating resource providers
	Creating credentials and system variables
	Changing component properties
	Publishing a topology design
	Publishing service design
	Creating service offering
	Publishing service offering to Global Shared Catalog

	Subscribing service
	Canceling a subscription


	Use case: Configuring intelligent resource management
	Prerequisites
	Concept of resource pools
	Provider and pool selection internal actions
	Resource accounting internal actions

	Resource management
	Resource supply management
	Resource demand management

	Use case: Resource pool use case
	Configuring resource pool

	Resource utilization report
	Resource synchronization
	REST APIs
	Get resource pool details
	Update resource pool details


	Use case: Custom Resource Provider and Pool selection
	Prerequisites
	Concept
	Build Resource Provider and Pool List
	Select Resource Provider and Pool

	Use case
	Steps to configure provider selection

	REST APIs
	Get the list of candidate providers and pools
	Update the list of valid providers

	HP Operations Orchestration flow
	Get Candidate Provider Pool
	Get Valid Provider Pool XML


	Use case: Monitoring and configuration management using vCenter Compute
	Configuration requirements
	Configuring service offerings
	Configuring subscriber options
	Creating resource providers
	Associating resource offerings with providers
	Changing component properties
	Publishing service design
	Creating service offering
	Publishing service offering to Global Shared Catalog

	Subscribing service
	Canceling a subscription

	HP Operations Orchestration flows
	Limitation

	Use case: HP Server Automation software policies deployment on vCenter Compute
	Configuration requirements
	Configuring service offerings
	Configuring subscriber options
	Creating resource providers
	Associating resource offerings with providers
	Changing component properties
	Publishing service design
	Creating service offering
	Publishing service offering to Global Shared Catalog

	Subscribing service
	Canceling a subscription

	HP Operations Orchestration flows
	Limitation

	Use case: HP vPV Integration
	Compute Service powered by Cloud Optimizer
	Configuration requirements
	Configuring service offering
	Configuring subscriber options
	Creating resource providers
	Associating resource offerings with providers
	Creating service offering
	Configuring vCenter provider
	Setting up resource environments in HP CSA

	Subscribing service
	Canceling subscription

	Observing VM performance on HP vPV
	Known issues


	Application designs for HP Codar
	PetClinic Application on AWS
	PetClinic Application with Load Balancer
	PetClinic Application on Existing Servers
	PetClinic Application on vCenter
	Redeploy content creation

	PetClinic Application

	Appendix A: Troubleshooting
	Manual cleanup in HP OneView if automatic cleanup fails
	Build plan deployment fails
	Server profile copy fails
	Deployments fail due to HP CSA timeout
	Missing HP Operations Orchestration content packs

	Appendix B: Disabling virtual WWNs in HP OneView
	Appendix C: Creating temporary server profiles to discover WWPN of HBAs
	Appendix D: Prepare ICsp OS Build Plan to work with Chef
	Appendix E: Deprecated contents
	Additional resources
	Send Documentation Feedback

